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Preface
Information Paragraphs

• Note paragraphs provide information that provides a deeper understanding of 
the situation, but is not essential to the proper completion of the instructions.

• Important paragraphs provide information that emphasizes instructions that 
are essential to proper setup of the equipment. Failure to follow these 
instructions carefully may cause unreliable performance.

• Caution! paragraphs provide information that alerts the operator to a hazardous 
situation that can cause damage to property or equipment.

• Warning! paragraphs provide information that alerts the operator to a 
hazardous situation that can cause injury to personnel. Cautionary information 
is also included, when applicable.

Safety Issues

WARNING! It is the responsibility of the user to make sure all local, county, 
state and national codes, regulations, rules and laws related to 
safety and safe operating conditions are met for each 
installation.
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Preface
Auxiliary Equipment

Local Safety Standards

The user must make sure that he operates all auxiliary equipment in accordance 
with local codes, standards, regulations, or laws applicable to safety.

Working Area

WARNING! Auxiliary equipment may have both manual and automatic 
modes of operation. As equipment can move suddenly and 
without warning, do not enter the work cell of this equipment 
during automatic operation, and do not enter the work 
envelope of this equipment during manual operation. If you do, 
serious injury can result.

WARNING! Make sure that power to the auxiliary equipment is turned OFF 
and locked out before you perform maintenance procedures on 
the equipment.

Qualification of Personnel

Make sure that all personnel have manufacturer-approved training applicable to the 
auxiliary equipment.

Personal Safety Equipment

Make sure that operators and maintenance personnel have all safety equipment 
applicable to the auxiliary equipment. Examples include safety glasses, protective 
headgear, safety shoes, etc.

Unauthorized Operation

Make sure that unauthorized personnel cannot gain access to the operation of the 
equipment.
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Preface
Environmental Compliance

Waste Electrical and Electronic Equipment (WEEE) Directive

GE Sensing & Inspection Technologies is an active participant in Europe’s 
Waste Electrical and Electronic Equipment (WEEE) take-back initiative, 
directive 2002/96/EC.

The equipment that you bought has required the extraction and use of 
natural resources for its production. It may contain hazardous substances 
that could impact health and the environment.

In order to avoid the dissemination of those substances in our environment 
and to diminish the pressure on the natural resources, we encourage you to 
use the appropriate take-back systems. Those systems will reuse or recycle 
most of the materials of your end life equipment in a sound way.

The crossed-out wheeled bin symbol invites you to use those systems.

If you need more information on the collection, reuse and recycling 
systems, please contact your local or regional waste administration.

Visit http://www.gesensing.com/environment/weee.htm for take-back 
instructions and more information about this initiative.
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Chapter 1. Features and Capabilities
Chapter 1. Features and Capabilities

The TransPort® Model PT878 is a transit-time flowmeter which combines 
all the features of a full-size flowmeter with the advantages of a portable 
instrument.

This section describes the TransPort features and general system, and 
explains the theory of operation.

1.1 Overview

The PT878 measures the flow rate of acoustically conductive single-phase 
fluids. This includes most clean liquids, sewage, some slurries, some 
oil/water mixtures, and liquids with a small percentage of entrained gas 
bubbles. The flowmeter provides one linear (0/4-20 mA) analog output of 
flow velocities or volumetric flow rate of these fluids, measuring velocities 
from ±0.03 to ±12 m/sec (±0.1 to ±40 ft/sec), along with one selectable 
frequency output or pulsed totalizer output.

The PT878 also provides two 4 to 20-mA analog inputs in order to connect 
temperature transmitters to measure energy flow rate of liquids. Energy 
flow rate may be calculated for water, glycol, and water/glycol mixtures. 

The PT878 has the ability to store site data in files which can be accessed at 
a later time. Within the Main Menu, a set of forms (windows) asks you all 
the necessary setup information for a particular site. Once the necessary 
questions are answered, you simply save the information to a file.

The PT878 stores these files and other data in non-volatile memory, which 
retains the information even if power is off. The flowmeter itself runs on 
rechargeable or alkaline batteries for up to 10 hours.

This small lightweight flowmeter displays measurements in both numeric 
and graphical form on a EL-backlit, 240 x 200 pixel LCD graphic screen. 
The PT878 also has the capability of logging over 100,000 flow data points 
internally.

Using an infrared communications port, the PT878 can transmit or print 
logged data, as well as real time data and other stored data. It is also 
computer-programmable via GE’s PanaView™ software. 
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Chapter 1. Features and Capabilities
1.1 Overview (cont.)

To assist you, the PT878 is fully equipped with context-sensitive on-line 
help which is accessible at any time by simply pressing the “?” (Help) key. 
Internal diagnostic and troubleshooting features help isolate and remedy 
common flowcell and transducer problems.

The PT878 operates with all standard GE transducers - wetted, clamp-on, 
hybrids (Pan-Adapta® plug), and buffered styles.

A built-in ultrasonic thickness gauge capability measures the pipe wall 
thickness when used with the optional thickness transducer.

1.2 System Description

The PT878 is one part of the flowmeter system. The flowmeter system 
consists of two essential subsystems: the flowcell and the electronics 
package (the PT878). 

1.2.1 The Flowcell

The flowcell is that part of the system that uses ultrasonic pulses to 
interrogate the flow. It consists of the flowcell pipe and the transducers.

A. FLOWCELL PIPE - The flowcell can either be created in the existing 
piping (for example, by inserting wetted transducers into the pipe, or 
clamping non-wetted transducers onto the pipe), or inserted as a 
substitute pipe section (spoolpiece). The flowcell must provide 
mechanical support for the transducers and assure stable fluid conditions 
for accurate flow measurement.

B. TRANSDUCERS - The transducers convert electrical energy into 
ultrasonic pulses when in a transmit cycle, and convert the ultrasonic 
pulses back to electrical energy when in a receive cycle. In other words, 
they act like loudspeakers when transmitting the signal and microphones 
when receiving it. In the PT878 system, each transducer acts as both a 
receiver and transmitter, since a series of ultrasonic pulses are alternately 
sent upstream and then downstream through the flowcell.
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Chapter 1. Features and Capabilities
1.2.2 Electronics Package

The PT878 consists of circuits that generate, receive, and measure the travel 
time of the ultrasonic pulses. It also contains a microcomputer that controls 
operation and calculates flow measurement parameters. Specific circuits 
function as follows:

•  TRANSMIT SIGNAL GENERATOR - The transmit signal generator, 
under control of the microcomputer and timing circuit, synthesizes the 
signal that drives the transmitter.

•  TRANSMITTER - The transmitter amplifies the signals from the 
transmit signal generator to a signal that drives the transmit transducer.

•  RECEIVER - The receiver amplifies the received signals to a level 
suitable for the data acquisition circuitry.

•  DATA ACQUISITION - The data acquisition circuitry digitizes the 
received signal and stores it in a buffer for processing by the 
microcomputer.

•  TIMING CIRCUIT - The timing circuit generates the transmitter 
frequency, receive window, controls the data acquisition circuit and the 
direction of the transmission.

•  MICROCOMPUTER - The microcomputer controls the PT878 
flowmeter’s operation and calculates flow measurements derived from 
the transmitted and digitized received signals. Also, the microcomputer 
continually checks for faults and allows the use of built-in diagnostics for 
troubleshooting.

•  INPUT/OUTPUT - The input/output circuitry allows the flowmeter to 
indicate the measured flow with the 0/4-20 mA current loop, and to 
output to a printer or other remote device. The digital output supports 
frequency or pulse output, as well as use as a gate input; it can also act as 
a test point for triggering an oscilloscope from the transmit or receive 
window.
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1.3 Theory of Operation

The PT878 is a transit-time ultrasonic flowmeter. When ultrasonic pulses 
are transmitted through a moving liquid, the pulses that travel in the same 
direction as the fluid flow (downstream) travel slightly faster than the pulses 
that travel against the flow (upstream). The PT878 uses various digital 
signal processing techniques, including cross-correlation, to determine 
transit times and then uses the transit times to calculate flow velocity.

During operation, two transducers serve as both ultrasonic signal generators 
and receivers. When mounted on a pipe, they are in acoustic communication 
with each other, so that each transducer can receive ultrasonic signals 
transmitted by the other transducer. Each transducer thus functions as a 
transmitter generating a certain number of acoustic pulses, and as a receiver 
for an identical number of pulses.

The flowmeter measures the time interval between transmission and 
reception of the ultrasonic signals in both directions. When the liquid in the 
pipe is not flowing, the transit-time downstream equals the transit-time 
upstream. When the liquid is flowing, the transit-time downstream is less 
than the transit-time upstream. The difference between the downstream and 
upstream transit-times is proportional to the velocity of the flowing liquid, 
and its sign indicates the direction of flow. 
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Chapter 2. Initial Setup

Before making measurements, you must prepare the PT878 for operation. 
This includes the following procedures:

• Making Electrical Connections

• Charging and/or Replacing Batteries

• Powering On and Off

• Using the Screen and Keypad

• Obtaining On-Line Help

Figure 1 below shows the PT878 in its standard soft case (a) and in the 
optional solid case (b). In the solid case, the interior is structured for optimal 
protection of the PT878 and its accessories.

Figure 1: The PT878 and Accessories

(a) (b)
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Chapter 2. Initial Setup
2.1 Making Electrical Connections

Before making measurements with the PT878, you must make all the 
necessary connections to the unit. This section describes how to connect the 
following:

• Power

• Transducers

• Input/Output

• Infrared Interface

Make all connections to the top of the PT878 unit as shown in Figure 2 
below. Please note that you need to make the proper power and transducer 
connections only. The other connections are required for particular 
functions, but are not necessary for basic operation.

Note: For a listing of Input/Output connections, see Table 1 on page 8.

Figure 2: Connection Locations

Power

Infrared Transceiver

DownstreamUpstream
Transducer

Input/Output
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Chapter 2. Initial Setup
2.1.1 Power Connections

The PT878 is powered by either a 100-120/200-260 VAC wall mount 
plug-in module, or by 5 internal Cs-size NiCad high-energy rechargeable 
batteries or by a pack of 3.0 Ahr NiMH batteries. (An optional power 
supplement, part #703-1283, uses 6 AA alkaline batteries.) When you 
receive the PT878, the batteries are not charged; therefore, to make remote 
measurements using the batteries, follow the instructions on page 9 to 
charge the batteries. In either case, you must connect the power cord to the 
appropriate terminal as shown in Figure 2 on page 6.

WARNING!  To ensure the safe operation of the PT878, you must 
install and operate it as described in this manual. In 
addition, be sure to follow all applicable safety codes and 
regulations for installing electrical equipment in your 
area. The PT878 and its transducers are designed for use 
only in general-purpose locations.

2.1.2 Transducer Connections

The transducer cables connect to the PT878 with LEMO® coaxial type 
connectors. Each color-coded cable should have a collar labeled 
UPSTREAM or DOWNSTREAM. Make transducer cable connections to 
the top of the flowmeter as shown in Figure 2 on page 6. Because there are 
various types of transducers and installations, transducer installation is 
discussed separately in the Liquid Transducer Installation Guide (916-055).

2.1.3 Input/Output Connections

The PT878 provides one 0/4-20 mA current output and two 4 to 20-mA 
analog inputs with switchable 16-V supply for loop- powered temperature 
transmitters. It also supports digital, frequency, and totalizer outputs. 
Connect the inputs/outputs using a LEMO® multi-pin connector as in 
Figure 2 on page 6. The pin numbers for the connector and the color code 
for the standard input/output cable are shown in Table 1 on page 8.
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2.1.3 Input/Output Connections (cont.)

2.1.4 The Infrared Wireless Interface

The PT878 comes equipped with an internal infrared transceiver (shown in 
Figure 2 on page 6) that enables communication between the meter and 
other IR devices, particularly the IR ports or dongles (IR to RS232 adapters) 
of Windows®-based PCs. Users can send and receive site and log data. 
They can also program the meter using the optional PanaView software 
interface. The PT878 was designed for use with products that comply to the 
IrDA protocol. For more information on establishing IR communications 
between the PT878 and your PC, refer to Appendix F. 

Note: The dongle connection is RS232. The configuration options are either 
RS232 or IRDa. Selecting the RS232 does not link the meter to the 
dongle. IrDa must be selected for the link to work.

• To transfer files between the PT878 and PC, see Managing Files — the 
Drive Manager on page 102.

• To transfer a log from the PT878 to a PC, see page 144.

Table 1: Cable Assembly for Analog Inputs/Outputs

Pin 
Number

Wire 
Color Description

1  Black Analog Out 1
2  Red 16 V (switched)
3 White Supply or Return Temperature (Input A)
4 Yellow Supply or Return Temperature (Input B)
5 Green Analog Ground
6 Orange Digital Output (frequency output, pulse totalizer, 

diagnostic output or calibration gate)
7 Blue Digital Ground 
8 Violet Receive Monitor
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Chapter 2. Initial Setup
2.2 Caring for the PT878 Batteries

The PT878 comes with self-contained, built-in rechargeable batteries to 
support portable operation. For optimum performance, these batteries 
require a minimum of maintenance.

CAUTION! Use only GE-approved batteries and desktop chargers. 
These chargers are designed to maximize battery life. 
Using other batteries or chargers voids the warranty and 
may cause damage.

IMPORTANT: For CE compliance, the PT878 is classified as a 
battery-powered device, not to be used with the AC 
adaptor.

2.2.1 Charging and Storing the Batteries

When you receive the PT878, you will need to initially charge the batteries. 
Also, the battery may need recharging if it has not been used for a long 
period of time. The batteries must be charged up to 8 hours to receive the 
maximum charge. When fully charged, the batteries provide 8 to 10 hours 
of continuous operation. An internal battery gauge indicates the remaining 
power in the batteries.

To charge the batteries, simply plug the AC power module cord into the 
power jack (shown in Figure 2 on page 6) and be sure the battery pack is 
installed. When the PT878 is plugged into line voltage, the internal battery 
charger automatically charges the batteries, whether the PT878 is on or off. 
If the PT878 is on, the Battery icon in the upper right corner of the screen 
indicates battery status (as shown in Table 2 on page 10).

Note:  For version 1B of the PT878 software, you must also press the red 
power key in the upper right corner of the keypad. (See page 110 to 
determine your software version.)

For optimal run time, charge the batteries only in temperatures from 50°F to 
104°F (10°C to 40°C). Otherwise, the batteries will not be properly charged 
and will have a significantly reduced run time. 
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2.2.1 Charging and Storing the Batteries (cont.)

Store the batteries at temperatures from –4°F to 131°F (–20°C to 55°C) for 
periods of less than one month, or from 32°F to 104°F (0°C to 40°C) for 
longer periods. (If you are transporting them for two days or less, the 
batteries can withstand temperatures from –40°F to 158°F (–40°C to 70°C). 

2.2.2 Replacing the Batteries

CAUTION!  Replace batteries only with the specified rechargeable 
batteries. The battery charges when the unit is off. Do not 
attempt to recharge non-rechargeable batteries. 

If you need to replace the rechargeable batteries, use the recommended 3.0 
Ahr NiMH batteries (part number 200-081). While the batteries can be 
recharged up to 600 times, it is best to replace them when they no longer 
provide acceptable performance. To replace the batteries, remove the rubber 
boot, open the panel located on the back of the PT878 unit, disconnect the 
batteries, and replace with new ones (see Figure 3 on page 11). 

Table 2: Battery Status Icons

Icon Battery Status
Full battery
Partially full battery
Empty battery
Fully charged battery, connected to AC power

Charging battery
Discharging battery

Failure/missing battery
Notification to check battery form (see page 114)
10 Transport® Model PT878 Portable Liquid Flowmeter User’s Manual



Chapter 2. Initial Setup
2.2.2 Replacing the Batteries (cont.)

Figure 3: Battery Location

To further extend the battery power on the PT878, the GE Part #705-1283 
option uses 6 AA alkaline batteries.

2.2.3 Disposing of Batteries

CAUTION! Never dispose of the batteries by incineration. Do not 
attempt to disassemble or short-circuit the batteries. For 
safety. do not handle a damaged or leaking battery.

IMPORTANT: Be sure to dispose of your battery properly. In some areas, 
battery disposal in business or household trash may be 
prohibited. For safe disposal options, contact your nearest 
GE-authorized service center.

Battery Location
(behind panel)
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2.3 Powering ON and OFF

To operate the PT878, the power cord must be plugged into line voltage or 
the battery must be charged as described previously.

IMPORTANT: For CE compliance, the PT878 is classified as a 
battery-powered device, not to be used with the AC adapter. 
To comply with CE certification, do not operate the meter 
with the charger plugged in.

To turn the PT878 on, press the red button in the upper-right-hand corner of 
the keypad. Immediately upon power up the PT878 emits a short beep and 
displays a “PCI Loader” message. It then validates the instrument 
programming, and then displays the GE logo and the software version and 
emits a long beep. If the meter fails any of these tests, contact the factory. 

WARNING! If the meter fails the backup battery test, you must send 
the unit back to the factory for a battery replacement. 
Make sure you keep the batteries charged until you are 
ready to ship the unit back to the factory. Before shipping, 
print out all the log and site data, or transfer it to your PC. 
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2.3  Powering ON and OFF (cont.)

After the meter conducts all the self checks, the screen then appears similar 
to the one shown in Figure 4 below. 

Figure 4: Screen After Powering ON

2000/11/30    09:53 AM
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2.3  Powering ON and OFF (cont.)

To turn the PT878 off, press the red key for 3 seconds. The screen now 
appears similar to Figure 5 below. 

Figure 5: Shutdown Menu

Three options are available:

• Press [F1] to shut down the PT878, turning it completely off.

• Press [F2] to send the PT878 into sleep mode. In this mode, some of the 
power supplies shut down, but the PT878 remains in a standby mode. 
Users can resume taking measurements immediately by pressing the 
power button.

• Press [F3] to cancel the command and return the PT878 to normal 
operation.

If the PT878 locks up, you can reset it by holding the power key (the red key 
in the upper right corner) for 15 seconds.

Velocity, ft/s Signal, dB

Delta-T, ns Volume, l/s

Resume

SHUTDOWN: Meter OFF
SLEEP: Meter Idle
CANCEL: Resume Operations 

Shutdown Sleep
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2.4 Using the Screen and Keypad

The essential features for operating the PT878 are the screen and keypad. 
Although these features are common on portable instruments, the PT878 
design offers particular features to simplify and speed operation.

2.4.1 Screen

The primary function of the screen is to display information in order for you 
to accurately and easily take measurements. The PT878 screen consists of 
seven parts (see Figure 6 below).

Figure 6: PT878 Screen in Operate Mode

The top line of the screen is the status bar, which normally displays the 
time and date. However, when you press [MENU] (the menu key), the Menu 
Bar replaces the status line. 

2000/11/30    09:53 AM
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Status Bar
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Measurements

Error Messages Function Keys

DEFAULT

Current Site
Battery
Status

System Tray
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2.4.1 Screen (cont).

The middle of the screen shown in Figure 6 on page 15 is the work area, 
which displays the measured parameters, numeric measurements, and both 
bar and line graphs. (When you enter a selection on the Menu Bar discussed 
in Chapter 3, Programming Site Data, this area displays menu prompts.) A 
line at the bottom of the area also displays error code messages, which are 
described in more detail in Chapter 9, Diagnostics and Troubleshooting.

The system tray displays icons that indicate meter operations not otherwise 
shown. Table 3 below lists the icons and their meanings.

The bottom of the screen displays the three function key options: F1, F2 
and F3. These keys have different functions, depending on the task you are 
performing. 

Table 3: Icons in the System Tray

Icon Function Meaning
IR Transfer IR data transfer in progress.

Alert Indicates the meter encountered an 
error in operation.

Log Indicates a log is pending (no marks) 
or running (marks).

Heating/
cooling

Indicates heating or cooling energy 
mode.

Stopwatch Calibration Gate Operation: Watch is 
stopped when the gate is closed, or 
runs when it is open.

Snapshot
(To file)

Indicates that the Snapshot function 
has been activated, so users can take 
screen captures (see page 130).(To Printer)
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Chapter 2. Initial Setup
2.4.2 Keypad

The PT878 keypad has 25 keys. The functions for each key are as follows 
(see Figure 7 on page 18):

• 3 function keys ([F1], [F2], [F3]) — enable you to select the special 
functions which appear at the bottom of the screen.

• 12 numeric keys (including – and .) — enable you to enter numeric data.

• 4 arrow keys ([ ], [ ], [ ], [ ]) — enable you to move through the 
menu options.

•  [?] Help key— enables you to access on-line help (discussed on 
page 19).

• [MENU] Menu key — enables you to access the Main Menu.

• [ENTER] — enables you to enter a particular menu, and enters selected 
values into the PT878 memory.

• [SEL] — enables you to move between data measurements on the screen.

• [ESC] — enables you to exit menus or menu options at any time; cancels 
a numeric entry.

• Red key [ ] — turns the power on or off, and toggles the backlight on 
or off.
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Chapter 2. Initial Setup
2.4.2 Keypad (cont.)

Figure 7: PT878 Keypad

F1 F2 F3

?
1 2 3

4 5 6

7 8 9

0• –

ESC SEL

ENTERMENU

PT878
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Chapter 2. Initial Setup
2.5 Obtaining On-Line Help

The PT878 offers context-sensitive on-line help screens that describe 
various features. You can access on-line help at any time by pressing the [?] 
key. The screen appears similar to Figure 8 below.

Figure 8: Main Help Menu

Use the three function keys and the [ ] and [ ] arrow keys to navigate to 
the desired menu, and press [ENTER]. Repeat this procedure to access the 
desired topic within the menu. When you have finished using the Help 
menu:

• Press [F1], Back, to move back one level.

• Press [F2], TOC, to return to the Table of Contents.

• Press [F3], Close, to return to the previous screen.

Velocity, ft/s Signal, dB
Help

Table of Contents

Back TOC Close

Site Menu 

Meter Menu
Log Menu
Service Menu
Miscellaneous
About

Program Menu

Use the arrows and the enter key to
select from the links below. Press [F2]
to return to the TOC.
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Chapter 2. Initial Setup
[no content intended for this page - proceed to next page]
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Chapter 3. Programming Site Data
Chapter 3. Programming Site Data

On the PT878, a Program Menu (part of the Main Menu) enables you to 
enter information that is specific to each site: 

• Transducer types and paths

• Pipe materials and linings

• Fluid types

• Heating or cooling energy flow rate

• Analog input and output parameters

• Digital output parameters

• User functions

• Correction factors

For immediate operation, the PT878 requires only transducer, pipe and fluid 
data. However, additional information allows you to tailor measurements as 
specifically as possible to your particular application. Once you have 
entered this data, you can save it in files and recall these files for later use. 
The PT878 can store up to 1 MB (or 32 site files) of data in the meter at any 
one time. But through the infrared link, users can store an unlimited number 
of sites in a PC, and then upload the sites they will actually use.

This chapter covers entering:

• Transducer, pipe, and fluid parameters

• Input/output and other setup parameters

• User functions.
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Chapter 3. Programming Site Data
3.1 Entering the Program Menu

To enter the Program Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Menu Bar replaces the Status Bar at the top of the 
screen. Press the [ ] arrow key once to scroll from the Site Menu to the 
Program Menu. At the Program Menu, press [ENTER]. The screen appears 
similar to Figure 9 below. While following the programming instructions, 
see Figure 139 on page 222 of Appendix A, Menu Maps.

Figure 9: Program Menu

To scroll to a particular option, press the [ ]or [ ] arrow keys until you 
reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time and 
return to Operate Mode without changing the parameters.

Note: If you enter an incorrect numeric value, press the [ ] key to erase 
the last digit entered.

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Pipe
Lining

Path
Fluid

Energy

Analog Input
Analog Output
Digital Output
User Functions

Site   Program   Meter Logging   Service

Transducer

CoCorrection Factors
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Chapter 3. Programming Site Data
3.2 Entering Transducer Parameters

To enter the Transducer option, scroll to the Transducer entry on the 
Program Menu and press [ENTER]. The screen appears similar to Figure 10 
below. To step through each parameter, press the [ ] key. Refer to 
Figure 143 on page 227 of Appendix A.

Note: Refer to the Liquid Transducer Installation Guide (916-055) for 
additional information about transducers and configurations.

.

Figure 10: Transducer Option Window

1. The first prompt asks you to select whether you are using a wetted or a 
clamp-on transducer.

a. Use the [ ] and [ ] keys to scroll between the two types.

b. Press [ENTER] to confirm the choice.

Transducer Pipe Lining Path

Transducer/Pipe

OKCancel

Fluid

Type:         Wetted Clamp-on

Transducer Special

Frequency 2.00 Tw 14MHz

Wedge Ang 50 °

Wedge Tmp 25 °C
Wedge SS 1219.2 m/s

µs
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Chapter 3. Programming Site Data
3.2  Entering Transducer Parameters (cont.)

Note: The choices made early in the Transducer and Pipe options 
determine the prompts available later. If the PT878 does not scroll to 
a particular parameter, it is not necessary for that transducer or pipe 
type. For example, the Lining window is not available if you select a 
wetted transducer.

2. The next prompt asks you to enter the transducer number (printed on 
the transducer itself), or to specify that you are using a special 
application transducer.

a. From the Type prompt, press the [ ] key to reach the Transducer 
prompt, and press [ENTER].

b. A drop-down list of transducer numbers opens as in Figure 11 on 
page 25. (The list varies, depending on whether you have selected 
wetted or clamp-on in the previous prompt. See Table 4 on page 25.) 
Press the [ ] or [ ] keys to scroll to the appropriate number, or 
scroll to “Special” for a special application transducer. To speed 
scrolling, you can press the [ ] key to scroll down by a page, or the 
[ ] key to scroll up by a page.

c. Press [ENTER] to confirm your selection.

The program now varies, depending on whether you have selected standard 
or special transducers.

• If you have selected a standard wetted or clamp-on transducer, the 
PT878 comes programmed with the needed parameters. Proceed to 
Confirming Entries on page 30.

• However, if you have selected a special application transducer, go to 
page 26.
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Chapter 3. Programming Site Data
Figure 11: Transducer Numbers Drop-Down List

Table 4: Transducer Numbers Available
WETTED CLAMP-ON

SPECIAL 64 SPECIAL 23 (Shear) 113 (Shear) 307 (Shear)
40 52 65 1 (Rayleigh) 24 (Shear) 114 (Shear) 308 (Shear)
41 53 66 2 (Rayleigh) 25 (Shear) 115 (Shear) 309 (Shear)
42 54 67 3 (Rayleigh) 26 (Shear) 116 (Shear) 310 (Shear)
43 55 68 10 (Shear) 27 (Shear) 117 (Shear) 311 (Shear)
44 56 69 10 (Shear) 28 (Shear) 125 (Shear) 312 (Shear)
45 57 70 11 (Shear) 29 (Shear) 126 (Shear) 313 (Shear)
46 58 71 12 (Shear) 30 (Shear) 127 (Shear) 314 (Shear)
47 59 72 13 (Shear) 31 (Shear) 133 (Shear) 315 (Shear)
48 60 73 14 (Shear) 32 (Shear) 136 (Shear) 401 (Shear)
49 61 74 15 (Shear) 33 (Shear) 137 (Shear) 402 (Shear)
50 62 75 16 (Shear) 34 (Shear) 139 (Shear) 403 (Shear)
51 63 76 17 (Shear) 35 (Shear) 301 (Shear) 407 (Shear)

18 (Shear) 36 (Shear) 302 (Shear) 408 (Shear)
19 (Shear) 37 (Shear) 303 (Shear) 409 (Shear)
20 (Shear) 38 (Shear) 304 (Shear) 410 (Shear)
21 (Shear) 39 (Shear) 305 (Shear)
22 (Shear) 112 (Shear) 306 (Shear)

Transducer Pipe Lining Path

Transducer/Pipe

OKCancel

Fluid

Type:         Wetted Clamp-on

Transducer Special

Frequency 2.00 Tw 14MHz

Wedge Ang 50 °

Wedge Tmp 25 °C
Wedge SS 1219.2 m/s

µs

SPECIAL
#40
#41
#42
#43
#44
#45
#46
#47
#48
#49
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 25



Chapter 3. Programming Site Data
3.2.1 Parameters for Special Transducers

Note: The factory will supply the information required below with the 
transducers.

3. The prompt asks for the transducer frequency, to transmit a signal at a 
frequency to which the transducer can respond. 

a. From the Transducer prompt, press the [ ] key to reach the 
Frequency prompt, and press [ENTER].

b. A drop-down list of five frequencies opens, ranging from 0.50 to 
4.00 MHz. Scroll to the desired frequency, and press [ENTER].

4. The next prompt asks for Tw, the time delay. This parameter is actually 
the time the transducer signal spends travelling through the transducer 
and cable. The PT878 calculates the flow rate from the upstream and 
downstream transit times in the fluid, so the Tw (time delay) must be 
subtracted out for an accurate measurement. The factory supplies the 
time delay on a sheet of paper inside the transducer case.

a. From the Frequency prompt, press the [ ] key to reach the Tw 
prompt, and press [ENTER].

b. Use the numeric keys to enter the GE-supplied time delay and press 
[ENTER].

The program now varies, depending on whether you have selected a wetted 
or a clamp-on transducer.

• If you have selected a special wetted transducer, proceed to 
Confirming Entries on page 30. 

• Special clamp-on transducers require three more inputs: wedge 
angle, wedge temperature, and wedge soundspeed.

5. When calculating the flow rate, the PT878 must take into account the 
wedge angle, the angle of the ultrasonic transmission. 

a. From the Tw prompt, press the [ ] key to reach the Wedge Angle 
prompt, and press [ENTER].

b. Use the numeric keys to enter the factory-supplied wedge angle (in 
degrees) and press [ENTER].
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Chapter 3. Programming Site Data
3.2.1 Parameters for Special Transducers (cont.)

Note: If the error message in Figure 12 below, or one similar to Figure 13 
on page 28 appears, the Pipe Soundspeed, Wedge Soundspeed, 
and/or the Wedge Angle may be in error. Review the pipe and wedge 
parameters currently entered and change one or more as necessary.

Note: To change pipe information, see Entering Pipe Parameters on 
page 30.

Figure 12: High Angle Error Message Window

Transducer/Pipe

Cancel OK

* * * WARNING * * *

Critical Angle Exceeded!

Check Angles, Soundspeed!!!!!!!!
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Chapter 3. Programming Site Data
3.2.1 Parameters for Special Transducers (cont.)

Figure 13: Low Angle Error Message Window

Note: When the corrected information is entered, a message similar to 
Figure 14 appears. Press [F3] (OK).

Transducer/Pipe

Cancel OK

Invalid Value - Too Low

15 is Too Low.

The valid range is from:
 25.000 to 90.000 °
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Chapter 3. Programming Site Data
3.2.1 Parameters for Special Transducers (cont.)

Figure 14: Transducer Spacing Change Window

6. The PT878 must also take into account the wedge temperature.

a. From the Wedge Angle prompt, press the [ ] key to reach the 
Wedge Temperature prompt, and press [ENTER].

b. Use the numeric keys to enter the wedge temperature (in degrees F 
or C) and press [ENTER].

7. Finally, the PT878 requires the wedge soundspeed.

a. From the Wedge Temp prompt, press the [ ] key to reach the 
Wedge SS prompt, and press [ENTER].

b. Use the numeric keys to enter the factory-supplied wedge 
soundspeed (in ft/sec or m/sec) and press [ENTER].

Pressing the [ ] key returns the meter to the Transducer tab at the top. 

Transducer/Pipe

Cancel OK

* * * WARNING * * *

Transducer Spacing has changed!

New Spacing:

  0.964 inches ( 24.493 mm)
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Chapter 3. Programming Site Data
3.2.2 Confirming Entries

• To confirm the entries and return to Operate mode, press [F3] (OK). 

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key.

In either case, the PT878 returns to Operate Mode.

3.3 Entering Pipe Parameters

To enter the Pipe option, scroll to the Pipe entry on the Program Menu and 
press [ENTER]. (From the Transducer window, you can scroll back up to the 
Transducer tab and press the [ ] arrow key to reach the Pipe window, and 
press [ENTER].) The screen appears similar to Figure 15 below. To step 
through each parameter, press the [ ] key. Refer to Figure 139 on page 222 
of Appendix A, Menu Maps.

Note: Refer to the brochure Soundspeeds and Pipe Size Data (914-004) for 
additional information about pipe sizes and soundspeeds.

Figure 15: Pipe Option Window

Transducer Lining Path

Transducer/Pipe

Pipe Fluid

Cancel OK

Material Other

Sound Speed 600.3 m/s

5

ANSI

OD, mm Wall, mm
2

Nominal      Schedule

OD x PI, mm
15.708

Measure Wall with TGauge
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Chapter 3. Programming Site Data
3.3  Entering Pipe Parameters (cont.)

1. The first prompt asks you to select the pipe material.

a. Press [ENTER] to enter the material prompt.

b. A drop-down list of materials opens. Table 5 below lists the 
available preprogrammed materials on the list. Press the [ ] or [ ] 
keys to scroll to the appropriate material, or scroll to “Other” for a 
material not on the list. You can press the [ ] key to scroll down by 
a page, or the [ ] key to scroll up by a page.

c. Press [ENTER] to confirm the choice.

Table 5: Preprogrammed Pipe Materials

Pipe Material 
Category Specific Material

Al - Aluminum Rolled
Brass None

Cu - Copper Annealed or Rolled
CuNi - Copper/Nickel 70% Cu 30% Ni or 90% Cu 10% Ni

Glass Pyrex, Flint, or Crown
Gold Hard-drawn

Inconel None
Iron Armco, Ductile, Cast, Electrolytic

Monel None
Nickel None

Plastic
Nylon, Polyethylene, Polypropylene, PVC 
(CPVC), or Acrylic

Steel Carbon Steel or Stainless Steel
Tin Rolled

Titanium None
Tungsten Annealed, Carbide, Drawn

Zinc Rolled
Other* Any material
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Chapter 3. Programming Site Data
3.3  Entering Pipe Parameters (cont.)

d. If you have selected “Other,” the meter prompts you to enter the 
soundspeed. Use the numeric keys to type the desired soundspeed in 
the text box, and press [ENTER] to confirm the choice.

Note: If the “Other” Pipe soundspeed entered is too large, given the 
previously entered Wedge soundspeed and angles, an error message 
similar to Figure 16 below will appear. Press [F3] (OK) (the error 
message disappears), and enter another soundspeed within the range 
specified.

Figure 16: Soundspeed Error Message Window

Note: When the corrected soundspeed is entered, a message similar to 
Figure 17 on page 33 appears. Press [F3] (OK).to return to the Site 
Menu.

Transducer/Pipe

Cancel OK

Invalid Value - Too High

100000 is Too High

The valid range is from:
3330.052 to 24000.000 ft/s
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Chapter 3. Programming Site Data
3.3  Entering Pipe Parameters (cont.)

Figure 17: Transducer Spacing Change Window

2. The next prompt asks if you wish to measure the pipe wall with the 
internal thickness gauge. If you press [ENTER], the program moves to 
the T-Gauge Display option (as covered on page 159). When you have 
completed setting up and using the thickness gauge (as discussed in 
Chapter 8), press [F2] or [F3] to return to the Pipe tab. 

3. For pipe diameter, two alternatives are available. At the Diameter 
prompt, the meter asks for the pipe outside diameter and thickness. But 
if you have selected certain pipe materials (carbon or stainless steel, 
cast iron, PVC and CPVC), you have the option of entering the pipe 
dimensions by a standardized schedule. Once you enter the nominal 
pipe size and identification, the PT878 determines the OD and wall 
thickness from an internal table.

Transducer/Pipe

Cancel OK

* * * WARNING * * *

Transducer Spacing has changed!

New Spacing:

  0.964 inches ( 24.493 mm)
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Chapter 3. Programming Site Data
3.3  Entering Pipe Parameters (cont.)

If you select a material that uses the Diameter alternative: 

a. You must select from two choices, outside diameter or 
circumference.

• The prompt moves to the OD (outside diameter) text box. Type the 
thickness (in mm or in.) into the text box, and press [ENTER] to 
confirm the choice, or

• Move the prompt to the OD X PI (circumference) text box. Type 
the OD (in mm or in.) into the box, and press [ENTER] to confirm 
your choice. 

b. In either case, the next prompt asks for the wall thickness. Type the 
value (in mm or in.) into the box, and press [ENTER] to confirm your 
choice.

Note: The measurement units shown depend on the choices you have made 
in the English/Metric window or the Meter Settings menu.

If you select a material that has the Schedule option:

a. The prompt asks if you wish to apply ANSI (the ANSI schedule). 
Press [ENTER] to select (or deselect) the ANSI box. (If you do not 
select the ANSI option, the prompt moves to the OD text box, and 
you enter the parameters for the Diameter alternative as discussed 
above.)

b. Press the [ ] key twice to move the prompt to the Nominal pipe 
size drop-down menu. Press [ENTER] to open the menu. Scroll to 
the desired pipe size, and press [ENTER] to confirm your choice.

c. Press the [ ] key to move the prompt to the Schedule drop-down 
menu. Press [ENTER] to open the menu. Scroll to the desired 
schedule, and press [ENTER] to confirm the choice.

After entering either diameter or schedule settings, pressing the [ ] key 
returns the meter to the Pipe Material prompt. 
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Chapter 3. Programming Site Data
3.3  Entering Pipe Parameters (cont.)

• To confirm the entries and return to Operate Mode, press [F3] (OK). 

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key.

In either case, the PT878 returns to Operate Mode.

• To return to the Pipe tab and scroll to other windows, press the [ ] key.

3.4 Entering Pipe Lining Parameters

To enter the Lining option, scroll to the Lining entry on the Program Menu 
and press [ENTER]. (From the Pipe window, you can scroll back up to the 
Pipe tab and press the [ ] arrow key to reach the Lining window, and press 
[ENTER].) The screen appears similar to Figure 18 below. To step through 
each parameter, press the [ ] key. While programming, refer to Figure 144 
on page 228 of Appendix A, Menu Maps.

Note: The Lining option is only available for clamp-on transducers.

Figure 18: Pipe Lining Window

Transducer Pipe Path

Transducer/Pipe

Cancel OK

Lining

Material Tar/Epoxy

Sound Speed 2000

mmThickness

m/s

0

Fluid
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Chapter 3. Programming Site Data
3.4  Entering Pipe Lining Parameters (cont.)

1. The PT878 first prompts you to select the pipe lining material.

a. Press [ENTER] to open the drop-down list of lining materials.

b. Scroll to the appropriate material. If you do not see your lining 
material on the list, select “Other.”

c. Press [ENTER] to confirm your choice.

Note: If your pipe lining is not on the drop-down list, consult the factory for 
further information.

2. The menu now follows one of two paths:

• If you have selected a preprogrammed material, the PT878 
automatically supplies the correct soundspeed, and you can proceed 
to step 3. 

• If you have selected “Other,” the meter prompts you to enter the 
soundspeed. Use the numeric keys to type the desired soundspeed in 
the text box, and press [ENTER] to confirm the choice.

3. The meter now asks for the lining thickness. Use the numeric keys to 
enter the desired value in the text box, and press [ENTER] to confirm 
your entry.

Pressing the [ ] key returns the meter to the Lining tab.

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

• To scroll to other windows, press the [ ] or [ ] key. Your changes will 
remain until you select OK or Cancel from one of the tabbed windows in 
the Transducer/Pipe form.
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3.5 Entering Fluid Types and Speeds

To access the Fluid option, scroll to the Fluid entry on the Program Menu 
and press [ENTER]. (If you are already in the Transducer/Pipe form, press 
the [ ] arrow key to reach the Fluid window, and press [ENTER].)The 
screen appears similar to Figure 19 below. To step through each parameter, 
press the [ ] key. Refer to Figure 145 on page 229 of Appendix A, Menu 
Maps.

Figure 19: Fluid Type Window

1. The first prompt asks you to select whether or not you want Tracking 
Windows. These windows are used to detect the receive signal when 
you are unsure of the fluid soundspeed. (Default operation is “No.”)

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

          Fluid

Cancel OK

Transducer/Pipe

Transducer Pipe PathFluidLining

Tracking Windows? No Yes

Fluid 

Sound Speed

Speed Min

Speed Max

Glycol

Water (2C)

1496

1350

1650

10

m/s

m/s

m/s

%Temp °F77
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3.5  Entering Fluid Types and Speeds (cont.)

2. Next, you must select the fluid type.

a. Press [ENTER] to open the drop-down menu. Table 6 below lists the 
available choices, which vary with your selection of Tracking 
Windows or the Energy option.

b. Scroll to the appropriate fluid. If you do not see your fluid on the 
list, select “Other.”

Note: Depending on your selection, additional prompts may appear, as 
specified in Table 6 above.

c. Press [ENTER] to confirm your selection.

At the end of any sequence, pressing the [ ] key returns you to the 
Tracking Windows prompt.

Table 6: Fluid Type Selection
Tracking Windows Off Tracking Windows On

Energy Off

Other Water (0-260°C)
Water (0-260°C) Oil
Sea Water Other
Oil (22°C)
Crude Oil
Lube Oil (X200)
Methanol
Ethanol
LN2 (-199°C)
Freon (R-12)

Energy On

Water/0-260°C Water/0-260°C
Water/Glycol (with glycol 
percentage)

Water/Glycol (with glycol 
percentage)

Other (with single 
soundspeed)

Other (with minimum and 
maximum soundspeeds)
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• To confirm the entries and return to Operate Mode, press [F3] (OK).The 
PT878 returns to Operate Mode. 

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

• To scroll to other windows, press the [ ] or [ ] key.

3.6 Entering the Signal Path Parameters

To enter the Path option, scroll to the Path entry on the Program Menu and 
press [ENTER]. (From the Lining window, you can scroll back up to the 
Lining tab and press the [ ] arrow key to reach the Path window, and press 
[ENTER].) The screen appears similar to Figure 20 below. To step through 
each parameter, press the [ ] key. Refer to Figure 146 on page 230 of 
Appendix A, Menu Maps.

Figure 20: Signal Path Window

The prompts available for the Path option depend on whether you have 
selected clamp-on or wetted transducers in the Transducer menu. (If the 
PT878 does not scroll to a particular parameter, it is not necessary for that 
transducer type.)

Transducer Pipe Lining Path

Transducer/Pipe

Cancel OK

Fluid

Path Length

Axial Length

Traverses 1

Spacing

248.92

203.2

90

mm

mm

mm
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Chapter 3. Programming Site Data
3.6.1 Path Parameters for Clamp-On Transducers

Note: For wetted transducers, go to page 41.

If you are using clamp-on transducers, the PT878 path menu includes two 
parameters:

• Traverses

• Spacing

1. The PT878 first prompts for traverses, the number of times the 
ultrasonic signal crosses the pipe (see the Liquid Transducer 
Installation Guide (916-055) for more details). 

a. Press [ENTER] to open the drop-down list of traverse numbers.

b. Scroll to the appropriate number. 

c. Press [ENTER] to confirm the entry.

2. The next prompt displays the spacing of the transducers, as calculated 
from the information entered.

a. Record this number and use it to space the transducers. (Use the 
Liquid Transducer Installation Guide (916-055) to assist in 
installing transducers on the pipe.) Press the [ ] key to scroll to the 
next parameter.

b. If necessary, you can overwrite the spacing to match the actual 
physical spacing of the transducers. (Do not change the spacing by 
more than ±10% from that calculated by the meter.) Use the numeric 
keys to enter the desired value, and press [ENTER] to confirm the 
entry. If you have entered an invalid entry, the PT878 rejects the 
entry and displays an error message.

Note: It is not recommended that you use a spacing other than the one 
calculated by the PT878.

After you enter the spacing, pressing the [ ] key returns the prompt to the 
Traverses box, and then to the Path tab at the top of the screen.
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3.6.2 Path Parameters for Wetted Transducers

If you are using wetted transducers, the PT878 path menu includes the 
following set of parameters:

• Path Length

• Axial Length

1. The meter first prompts for the path length (P) of the ultrasonic signal. 
GE has calculated the path length based on the transducer configuration 
for your particular application. Find the path length on the flowcell or 
on other supplied documentation.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the appropriate number. 

c. Press [ENTER] to confirm the entry.

Note: If the documentation does not supply the path or axial lengths, refer 
to Appendix B, Measuring P and L Dimensions, to measure these 
lengths.

2. The next prompt asks for the axial dimension (L) of the ultrasonic 
signal. Again, GE has calculated the axial dimension based on the 
transducer configuration for your particular application. Find the axial 
dimension on the flowcell or from other supplied documentation.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the appropriate number. 

c. Press [ENTER] to confirm the entry.

After you enter the axial length, press the [ ] key to return to the main Path 
tab at the top of the screen.

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

• To scroll to other windows, press the [ ] or [ ] key.
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3.7 Entering the Energy Option Parameters

The Energy Option enables you to calculate the energy of a system based on 
the temperature at a supply point, the temperature at a return point, and the 
flow of fluid through the system. To enter the Energy Option, scroll to the 
Energy entry on the Program Menu and press [ENTER]. The screen appears 
similar to Figure 21 below. To step through each parameter, press the [ ] 
key. While programming, refer to Figure 147 on page 231 of Appendix A, 
Menu Maps.

Figure 21: Energy Option Window

1. The first prompt asks if you want to disable or enable the Energy 
Option.

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

Note: If you select “Disabled,” you cannot select any other prompt in this 
window.

Energy Option Inputs

Energy Options

OKCancel

                 l

Energy    
Disabled Enabled

System
Heating

Flow Measurement at
Supply Return

Cooling

Calculation Method
Standard Custom Cp

Custom Cp
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3.7  Entering the Energy Option Parameters (cont.)

2. The next prompt asks if you are using a heating or cooling system. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

3. The program now asks if you are measuring flow at the point of supply 
or return.

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

4. The final prompt asks if you wish to use the standard or Custom Cp 
method for energy calculations. If you choose Custom Cp, you must 
enter tables for fluid enthalpy and density in the Custom Cp tab (see 
page 46).

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

Pressing the [ ] key returns the meter to the Energy prompt, and then to 
the Energy Option tab. 

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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3.7.1 Entering Inputs in the Energy Option

To enter input parameters in the Energy Option, return to the Energy Option 
tab at the top of the Energy Option window. Press the [ ] arrow key to 
reach the Inputs window, and press [ENTER]. The screen appears similar to 
Figure 22 below. To step through each parameter, press the [ ] key.

IMPORTANT: The supply and return must be on separate inputs.

Figure 22: Inputs Tab in the Energy Option

1. The first prompt asks if the temperature supply is fixed or active. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

Energy Options

Cancel OK

Energy Option Inputs
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3.7.1 Entering Inputs in the Energy Option (cont.)

2. The next prompt depends on whether you have selected a fixed or an 
active supply.

• If you have selected a fixed supply, the PT878 asks for the desired 
temperature. Use the numeric keys to enter the desired temperature (in 
degrees C), and press [ENTER] to confirm the entry.

• If you have selected an active supply, the PT878 asks for the desired 
input. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to Input A or B.

c. Press [ENTER] to confirm the entry.

3. The next prompt asks if the temperature return is fixed or active. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

4. The next prompt depends on whether you have selected a fixed or an 
active return.

• If you have selected a fixed return, the PT878 asks for the desired 
temperature. Use the numeric keys to enter the desired temperature (in 
degrees C), and press [ENTER] to confirm the entry.

• If you have selected an active return, the PT878 asks for the desired 
input. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to Input A or B.

c. Press [ENTER] to confirm the entry.

Note: If either input is fixed, the analog input(s) not used by the Energy 
Option can act as general-purpose inputs.

Pressing the [ ] key returns the meter to the Inputs tab. 
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3.7.1 Entering Inputs in the Energy Option (cont.)

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

To enter data for Custom Cp calculations, proceed to the Custom Cp tab, 
discussed on page 46.

3.7.2 Entering Custom Cp Data in the Energy Option

To program Custom Cp tables in the Energy Option, return to the tabs at the 
top of the Energy Option window. Press the [ ] arrow key until you have 
highlighted the Custom Cp tab, and press [ENTER]. The screen appears 
similar to Figure 23 below. To step through each parameter, press the [ ] 
key.

Figure 23: Custom Cp Tab in the Energy Option
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3.7.2 Entering Custom Cp Data in the Energy Option (cont.)

1. The first prompt asks if you wish to enter or edit data in the Custom Cp 
(enthalpy) table. 

a. Press [ENTER] to open the Custom Cp table, shown in Figure 24 on 
page 47. 

b. Use the numeric keys to enter the desired temperature in degrees 
Kelvin, and press [ENTER] to confirm the entry.

c. Press the [ ] key to move to the kJ/kg/°K column (enthalpy in 
KiloJoules/Kilogram/°Kelvin). Use the numeric keys to enter the 
desired value, and press [ENTER].

Figure 24: Custom Cp (temperature vs. enthalpy) Table

d. Repeat steps b and c for the remainder of the table.

e. When you have completed entering values, press [F3] (OK) to 
confirm the table and return to the Custom Cp window.
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3.7.2 Entering Custom Cp Data in the Energy Option (cont.)

2. The next prompt asks from which source — a fixed value or table — 
the PT878 will use for fluid density values. Use the [ ] and [ ] keys 
to scroll to the appropriate radio button, and press [ENTER].

3. The menu now varies, depending on your selection in step 2.

• If you selected “Fixed,” the PT878 asks for the fixed fluid density. 
Use the numeric keys to enter the desired value, and press [ENTER].

• If you selected “Table,” the meter highlights the “Edit Table” button. 

Figure 25: Fluid Density Table

a. Press [ENTER] to open the Edit Density table, shown in Figure 25 
above.

b. Use the numeric keys to enter the desired temperature in degrees 
Kelvin, and press [ENTER].

c. Press the [ ] key to move to the kg/m^3 column (density in 
Kilogram/cubic meters). Use the numeric keys to enter the desired 
value, and press [ENTER].

 Edit Density

Cancel OK
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5
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d. Repeat steps b and c for the remainder of the table.

e. When you have completed entering up to 20 values, press [F3] (OK) 
to confirm the table and return to the Custom Cp window. 

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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3.8 Entering Analog Inputs

The Analog Input option enables you to specify parameters for general 
purpose or energy inputs. To enter the Inputs option, scroll to the Analog 
Input entry on the Program Menu and press [ENTER]. If you have not 
enabled the Energy Option (see page 42), the screen appears similar to 
Figure 26 below. To step through each parameter, press the [ ] key. Refer 
to Figure 148 on page 232 of Appendix A, Menu Maps.

3.8.1 Entering General-Purpose Analog Inputs

Figure 26: Analog Inputs Option Window

1. The first prompt asks you to select whether the desired function is off or 
general purpose.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired response.

c. Press [ENTER] to confirm your selection.
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3.8.1 Entering General-Purpose Analog Inputs (cont.)

2. The next prompt asks if you want to label the input.

a. Press [ENTER] to enter the text box. The text creation window 
appears, as shown in Figure 27 below.

Figure 27: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or symbol, and 
press [ENTER] to add the letter to the name.

Note:  Pressing [SEL] causes the screen to show successively a set of 
upper-case (capital) letters, a set of lower-case letters, and a set of 
symbols. Use all three screens to create a desired label.

c. Repeat this procedure for each letter or symbol you wish to add to 
the name. If you wish to delete a letter, press [F1] (Delete) to erase 
each letter or symbol, from right to left on the label.

d. When you have completed the label, press [F3] (OK) to confirm the 
label, or [F2] (Cancel) to leave the window without adding the label.

A        B      C      D      E      F      G      H       I        J

K        L      M      N      O      P      Q      R      S       T

U      V       W     X      Y       Z      0       1       2      3
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=      <       >       
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3.8.1 Entering General-Purpose Analog Inputs (cont.)

3. The next prompt asks you to create a label for the units, if desired. (This 
label will appear to the right of the zero and span value boxes.) Press 
[ENTER] to reopen the text creation window, and follow the same steps 
covered in Step 2 on page 51. 

4. The next prompt asks for the zero input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

5. The final prompt asks for the span input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

You have completed entering data for general-purpose inputs.

3.8.2 Entering Analog Inputs in the Energy Option

If you have enabled the Energy Option, the screen displays fewer options, 
as shown in Figure 28 below.

Figure 28: Analog Inputs Option Window - Energy Option Activated

          Analog Input

Cancel OK

Function

Units

Span

Label

Zero 

100

Supply Temp

°C

Supply Temp

°C

0

°C

Input A Input B
52 Transport® Model PT878 Portable Liquid Flowmeter User’s Manual



Chapter 3. Programming Site Data
3.8.2 Entering Analog Inputs in the Energy Option (cont.)

The screen displays the function (supply or return temperature), label 
(supply or return temperature) and units selected in the Inputs form of the 
Energy Option (see page 44). You cannot change these parameters in this 
form. Press the [ ] key to step through these parameters.

1. The first prompt asks for the zero input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

2. The final prompt asks for the span input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

You have completed entering parameters in the Analog Inputs option.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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3.9 Entering the Analog Output

The Analog Output option enables you to enter information to set up output 
parameters. To enter the option, scroll to the Analog Output entry on the 
Program Menu and press [ENTER]. The screen appears similar to Figure 29 
below. To step through each parameter, press the [ ] key. Refer to 
Figure 149 on page 233 of Appendix A, Menu Maps.

Figure 29: Analog Output Window

1. The first prompt enables you to select a range to send a current signal to 
a recording device. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired output from three choices: Off, 0-20 mA, and 
4-20 mA.

c. Press [ENTER] to confirm your selection.

Note: If you select “Off,” you will not be able to access any other 
parameters in this option.
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3.9  Entering the Analog Output (cont.)

2. The next prompt asks you to select the analog output type from a list of 
choices, as shown in Figure 30 below.

Figure 30: Data Source Selection Window

a. Press [ENTER] to open the window.

b. Scroll to the desired output type.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The available units 
depend on the selection made at the Data Source prompt.) Scroll to 
the desired output unit.

e. Press [F3] (OK) to confirm your selection.
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3.9  Entering the Analog Output (cont.)

3. The next prompt asks you to enter the zero (base) value for the analog 
output. This value represents the 0/4 mA output (in flow units).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

4. The next prompt asks you to enter the span (full scale) value for the 
analog output. This value represents the 20 mA output (in flow units).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

5. The last prompt, On Error, asks you to select how the PT878 will handle 
the analog outputs in the event of a fault condition. The meter offers 
three alternatives:

• Hold Last Value (hold the last good reading)

• Force Low (force the reading to 0 or 4 mA)

• Force High (force the reading to 20 mA).

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired selection.

c. Press [ENTER] to confirm your selection.

You have completed entering data in the Analog Output option.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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3.10 Entering the Digital Output

While resembling the Analog Output option, the Digital Output option 
enables you to set up parameters necessary for a digital output. To enter the 
option, scroll to the Digital Output entry on the Program Menu and press 
[ENTER]. The screen appears similar to Figure 31 below. To step through 
each parameter, press the [ ] key. While programming, refer to Figure 150 
on page 234 of Appendix A, Menu Maps.

Figure 31: Digital Output Window

1. The first prompt enables you to select the output function from five 
choices:

• Off

• Pulse Totalizer

• Frequency

• Test Points

• Gate Input
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3.10  Entering the Digital Output (cont.)

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function.

c. Press [ENTER] to confirm your selection.

Note: If you select Off, you will not be able to access any other parameters 
in this option. If you select Test Points or Gate Input, the program 
goes at once to Step 4. 

2. The next prompt asks you to select the data source for the digital output. 
The choices vary with the function. For Pulse Totalizer (shown in 
Figure 31 on page 57, the available choices include:

• Forward Totalizer

• Reverse Totalizer

• Forward Energy

• Reverse Energy

a. Press [ENTER] to open the data source selection window, shown in 
Figure 30 on page 55.

b. Scroll to the desired source.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The available units 
depend on the selection made at the Data Source prompt.) Scroll to 
the desired output unit.

e. Press [F3] (OK) to confirm your selection.

3. The last set of parameters that appears depends on the selection you 
made at the Function prompt.

If you selected Pulse Totalizer:

The prompt asks for the units/pulse, the pulse width (in microseconds), and 
the polarity. (Figure 31 on page 57 illustrates a Digital Output window 
configured for the Pulse Totalizer function.) For the Units/Pulse and Pulse 
Width parameters:
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3.10  Entering the Digital Output (cont.)

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

For Polarity:

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired polarity, either Low to High or High to Low.

c. Press [ENTER] to confirm your selection.

If you selected Frequency:

The prompt asks for the minimum and maximum frequencies and the duty 
cycle percentage. For each parameter:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

If you entered Test Points:

The prompt asks for the window (trigger) type from two choices, transmit 
and receive. These two windows can be used to trigger an oscilloscope to 
look at the receive signal output on another channel.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired signal.

c. Press [ENTER] to confirm your selection.
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3.10  Entering the Digital Output (cont.)

If you entered Gate Input:

Note: Gate Input is used to synchronize the totalizer with the meter 
calibration system (discussed on page 67). The gate stops and starts 
the meter totalizer, so that you can compare the totalizer figure with 
the measured volume of water in the weight tank.

1. The prompt asks for the gate active.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired gate active, whether Contact Open or Contact 
Closed.

c. Press [ENTER] to confirm your selection.

2. The second prompt asks for the mode.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired mode, either Automatic or Manual.

c. Press [ENTER] to confirm your selection.

Stopwatch Totalizer

Through the Gate Input option, you can implement the Stopwatch Totalizer 
function to measure totals manually. To set up the Totalizer function:
1. At the Gate Active prompt, select Contact Open.

2. At the Mode prompt, select Manual, and press [ENTER]. (Selecting 
Automatic causes the totalizer to run continuously.)

The stopwatch icon (see page 16) appears in the system tray. To start or stop 
the function, press the minus (–) key on the keypad.

You have completed entering parameters in the Digital Output option.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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3.11 Entering User Functions

User functions enable you to program mathematical equations on each 
measurement. You can also use any parameter in the meter to calculate a 
different parameter. To enter the User Functions option, scroll to the User 
Functions entry on the Program Menu and press [ENTER]. The screen 
appears similar to Figure 32 below. To step through each parameter, press 
the [ ] key. Refer to Figure 151 on page 235 of Appendix A, Menu Maps.

Figure 32: User Functions Window

1. The first prompt asks you to select the function number, 1 through 8.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function number (User F1, User F2, etc.).

c. Press [ENTER] to confirm the entry.

Set User Function

Function User F1

Label

Units Sym

Dec. 0

Delete Check Done
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3.11  Entering User Functions (cont.)

2. The next prompt asks you to create a label for the function. The label 
corresponds to the measurement type (i.e., velocity or temperature), 
while the units symbol corresponds to the measurement units (i.e., 
feet/sec or degrees F).

a. Press [ENTER] to open the text creation window, which appears 
similar to Figure 33 below.

Figure 33: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or symbol, and 
press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a set of 
upper-case (capital) letters, a set of lower-case letters, and a set of 
symbols. Use all three screens to create a desired label.

c. Repeat this procedure for each letter or symbol you wish to add to 
the label. If you wish to delete a letter, press [F1] (Delete) to erase 
each letter or symbol, from right to left on the label.
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3.11  Entering User Functions (cont.)

d. When you have completed the label, press [F3] (OK) to confirm the 
label, or [F2] (Cancel) to leave the window without adding the label.

3. The next prompt asks for the Units Symbol. 

a. Press [ENTER] to reopen the text creation window. 

b. Repeat the procedure used for the Label (on page 62) to create the 
Units Symbol.

c. When you have completed the label, press [F3] (OK) to confirm the 
symbol, or [F2] (Cancel) to leave the window without adding the 
symbol.

4. The next prompt asks you to select the number of decimal places.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired number of decimal places, ranging from 0 to 4.

c. Press [ENTER] to confirm the entry.

5. The final prompt asks for the function itself.

a. Press [ENTER] to open the function creation window, which appears 
similar to Figure 34 on page 64.

b. Use the four arrow keys to scroll to the desired function or table, and 
press [ENTER] to confirm each entry. Use the numeric keys to enter 
numeric values. Press [F1] (Delete) to remove any mistaken or 
unwanted symbols or numbers.

Note: Pressing [SEL] causes the screen to alternate between a set of 
symbols and functions and a list of user functions. Use both screens 
to create the desired function.
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3.11  Entering User Functions (cont.)

Figure 34: Function Creation Window

c. To enter a particular measured parameter into the equation, click on 
the MODE symbol in the middle of the third row. The Data Source 
Selection window (shown in Figure 30 on page 55) opens. Select the 
desired data source and unit as discussed on page 55, and press [F3] 
(OK) to confirm the entry.

d. When you have completed entering the function, press [F3] (OK) to 
confirm the entry and return to the User Function window.

6. GE recommends pressing [F2] (Check) to test the validity of the 
function. The PT878 displays either “OK” or a message such as “Syntax 
Error.”

• Press [F1] to delete the entire function, or

• Press [F3] (Done) to confirm the function and return to Operate 
Mode.
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3.11.1 Entering Correction Factors

The final option in the Program Menu, Correction Factors, allows you to 
enter and modify three correction factors: Reynolds Correction, Kinematic 
Viscosity and Calibration Factor. To enter the Correction Factors option, 
scroll to the Correction Factors entry on the Program Menu and press 
[ENTER]. The screen appears similar to Figure 35 below. To step through 
each parameter, press the [ ] key. Refer to Figure 152 on page 236 of 
Appendix A, Menu Maps.

Figure 35: Reynolds Correction Window

3.11.2 Entering Reynolds Correction

The default for Reynolds Correction is “On.” This correction factor should 
be on in most applications, including all those that utilize clamp-on 
transducers. It makes a small adjustment to the flow rate reported by the 
PT878, based on the Kinematic Viscosity. Reynolds Correction is necessary, 
as the velocity of the fluid measured along a diametrical path must be 
related to the total area average velocity over the entire pipe cross-section.
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3.11.2 Entering Reynolds Correction (cont.)

1. The first prompt asks if you want to enable the Reynolds Correction 
factor, a number based on the Kinematic Viscosity and flow rate of the 
fluid.

Note: If you are using clamp-on transducers, you should enable Reynolds 
Correction. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

Note: If you disable Reynolds Correction, you will not be able to enter any 
other values in this window.

2. If you enable Reynolds Correction, you will also need to enter the 
Kinematic Viscosity of the fluid (available in the brochure Soundspeeds 
and Pipe Size Data, 914-004). The prompt asks for a kinematic 
viscosity value.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value (from Soundspeeds 
and Pipe Size Data).

c. Press [ENTER] to confirm your selection.

You have completed entering data for a single Kinematic Viscosity factor. 
Proceed to Entering a Calibration Factor on page 67.

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key.
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Chapter 3. Programming Site Data
3.11.3 Entering a Calibration Factor

The Calibration Factor is used to calibrate or adjust the readings of the 
PT878 to another flow reference. To enter a Calibration Factor, return to the 
Reynolds Correction tab at the top of the Correction Factors option. Press 
the [ ] arrow key to reach the Calibration Factor window. The window 
appears similar to Figure 36 below. To step through each parameter, press 
the [ ] key.

Figure 36: The Calibration Factor Window

1. The first prompt asks if you wish to enable the calibration factor. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

2. The next prompt asks if you want a single K factor or a table of K 
factors.

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

Reynolds Correctio Inputs

Correction Factors

Calibration Factor

Edit Table

Calibration Factor On Off

Meter K-Factor

Data Source

K Factor   Single Table

10

Edit Table

Cancel OK
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Chapter 3. Programming Site Data
3.11.3 Entering a Calibration Factor (cont.)

3. The following steps depend on whether you select a single value or a 
table. 

If you entered Single:

The prompt asks for a value. This feature enables a single multiplier to be 
applied to the flow rate reported by the PT878.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value. Generally, if you 
have enabled the Reynolds Correction factor, the correction factor 
should be set to 1.00. Otherwise, the typical factor is between 0.5 
and 2.00.

c. Press [ENTER] to confirm your selection.

You have completed entering data for a single Calibration Factor. 

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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Chapter 3. Programming Site Data
3.11.3 Entering a Calibration Factor (cont.)

If you entered Table:

The menu asks, first for the data source, and then for the entry of values into 
the Correction Factor table. This feature allows the user to “curve fit” 
velocity calibration multiple data points (from several different data sources 
or flow variables) to the flow rate reported by the PT878.

a. Press [ENTER] to open the Data Source window. 

b. Press [F3] (OK) to confirm your selection. (Velocity is the only 
choice available.)

4. The prompt then asks if you wish to edit the K factor table.

a. Press [ENTER] to open the table, which appears similar to Figure 37 
below.

Figure 37: KFactor Table
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Chapter 3. Programming Site Data
3.11.3 Entering a Calibration Factor (cont.)

b. Use the numeric keys to enter the desired value for the data source, 
and press [ENTER] to confirm the entry.

c. Press the [ ] key to move to the KFactor column. Use the numeric 
keys to enter the desired value, and press [ENTER] to confirm the 
entry.

d. Repeat steps b and c for the remainder of the table.

e. When you have completed entering values, press [F3] (OK) to 
confirm the table and return to the Correction Factors window.

You have completed entering data for correction factors.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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Chapter 4. Creating and Managing Sites

As mentioned in Chapter 1, the PT878 can store site data in files for current 
and future access. (To learn how to program setup data, refer to Chapter 3, 
Programming Site Data.) After you answer the necessary questions, simply 
save the information to a site file. The Site Manager option then enables you 
to recall, rename, revert to, print, transfer or delete site files as needed. 

To open the Site Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Menu Bar replaces the Status Bar at the top of the 
screen. Then press [ENTER]. The screen now appears similar to Figure 38 
below. While following the programming instructions, refer to Figure 137 
on page 219 and Figure 138 on page 221 of Appendix A, Menu Maps.

Figure 38: Site Menu
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Chapter 4. Creating and Managing Sites
4.1 The Site Manager

From the Site Menu, press [ENTER] to open the Site Manager. The screen 
appears similar to Figure 39 below.

Figure 39: Site Manager Window

Note: Each PT878 comes preprogrammed with a basic site, Default, which 
serves as a basis for saving data and creating other sites.

The right section of the screen supplies information for the site highlighted 
in the list on the left: its date, time and size, as well as the remaining amount 
of free memory. You can use the [ ] and [ ] arrow keys to scroll to a 
particular site and display information pertaining to that site.

To open the Site Manager menu, press [MENU] and then [ENTER]. The 
screen now appears similar to Figure 40 on page 73.

Site Manager
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DEFAULT
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File
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Chapter 4. Creating and Managing Sites
4.1  The Site Manager (cont.)

Figure 40: Site Manager Menu

Depending on the choice made above, proceed as follows:

• To create a new site, go to page 74.

• To open an existing site (thus replacing the current site), go to page 76.

• To save a current site, go to page 77.

• To refresh site information, go to page 79.

• To rename a site, go to page 78.

• To delete a site, go to page 80.

You can access five additional functions from the Site submenu (shown in 
Figure 48 on page 81).

• To add a site message, go to page 81.

• To print out a site, go to page 83.

• To transfer a site to a PC, go to page 83.

• To transfer a site in text format, go to page 84.

• To transfer a site from a PC to the PT878, go to page 85.

Site Manager
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Save
Save As
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Delete
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Chapter 4. Creating and Managing Sites
4.1  The Site Manager (cont.)

You can arrange files from the Sort submenu (shown in Figure 55 on 
page 88)

• To sort files by name, go to page 88.

• To sort files by date, go to page 88.

4.1.1 Creating a New Site

Note: Be sure you have entered the necessary setup data discussed in 
Chapter 3, Programming Site Data, before creating and saving a new 
site.

To create a new site within the Site Manager, press [MENU] to open the File 
Menu. Be sure the option New is highlighted, and then press [ENTER]. The 
screen appears similar to Figure 41 below.

Figure 41: Name Entry Window for a New Site

1. Use the four arrow keys to scroll to the desired letter or number, and 
press [ENTER]. 
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Chapter 4. Creating and Managing Sites
4.1.1 Creating a New Site (cont.)

2. Repeat this procedure until you have created the desired site name of up 
to eight characters. (Press [F1], Delete, to remove any unwanted letters 
or numbers.) 

3. When you have finished, press [F3] (OK) to confirm the entry, or [F2], 
Cancel, to leave the window without creating a site. 

A second screen appears (as shown in Figure 42 below) asking if you want 
to use the currently highlighted site as a template, with the current display 
windows, measurements and programmed data. (To modify the display and 
measurements, refer to Chapter 5, Displaying and Configuring Data. To 
alter programming data, see Chapter 3, Programming Site Data.)

• Press [F2] (No) if you do not want to use it, or

• Press [F3] (Yes) if you do want to use it as a template.

Figure 42: Template Confirmation Window

The meter returns to Operate Mode, with the new site name displayed in the 
upper left corner of the screen.
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Chapter 4. Creating and Managing Sites
4.1.2 Opening an Existing Site

If you want to return to a site you have previously saved, first highlight the 
replacement site in the left window of the Site Manager. Then press [MENU] 
to open the File Menu. Scroll to the Open option, and press [ENTER]. The 
screen appears similar to Figure 43 below.

Figure 43: Open Site Confirmation Window

• Press [F2] (No) to cancel opening the site and return to the current site, 
or

• Press [F3] (Yes) to open the site. 

If you have changed the current site, the PT878 asks if you want to save the 
changes to the previously opened site. 

• Press [F2] (No) to cancel the changes, or

• Press [F3] (Yes) to confirm and save the changes.

The PT878 returns to Operate Mode, with the selected site displayed in the 
upper left corner of the screen.

1 View

Programming

Site Manager

 No Yes

Info:DEFAULT
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File
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ResReOpen File DEFAULT 
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Chapter 4. Creating and Managing Sites
4.1.3 Saving a Site

You can save the current site in one of two ways:

• From the Site Menu, you can scroll down to the Save Now option and 
press [ENTER], or

• From within the Site Manager, press [MENU] to open the File Menu, 
scroll to the Save option, and press [ENTER].

In either case, the screen appears similar to Figure 44 below.

Figure 44: Save Current Site Window

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.

The PT878 remains in the current window (Operate Mode or Site Manager), 
with the current site saved.

         

   No Yes

Save the current site
(DEFAULT.SIT)?

         Save Site
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Chapter 4. Creating and Managing Sites
4.1.4 Saving a Site with a Different Name

If you want to save the current site with a different name, open the Site 
Manager, press [MENU] to open the File Menu, scroll to the Save As option, 
and press [ENTER]. The screen appears similar to Figure 45 below.

Figure 45: Save As (Another Name) Window

Use the four arrow keys to scroll to the desired letter or number, and press 
[ENTER]. Repeat this procedure until you have created the desired site 
name. (Press [F1], Delete, to remove any unwanted letters or numbers.) 
When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3] (OK) to confirm the entry. 

The Save Site window then appears. 

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.

The PT878 remains in Site Manager, with the current site saved under both 
the old and new names.
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Chapter 4. Creating and Managing Sites
4.1.5 Refreshing a Site

You can refresh a site (updating the display with the most current 
information) in one of two ways:

• Press [F2], Refresh, to refresh the highlighted file.

• From the File Menu, scroll to the Refresh option and press [ENTER].

The updated information on the highlighted file appears in the window on 
the right. However, to save the file, you must use the Save option.

4.1.6 Renaming a Site

If you want to rename a site, first be sure the site has been highlighted in the 
left window of the Site Manager. Then press [MENU] to enter the File Menu, 
scroll to the Rename option, and press [ENTER]. The screen appears similar 
to Figure 46 below.

Figure 46: Rename Site Window

Use the four arrow keys to scroll to the desired letter or number, and press 
[ENTER]. Repeat this procedure until you have created the desired site 
name. (Press [F1], Delete, to remove any unwanted letters or numbers.) 
When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3] (OK) to confirm the entry.

PT878 remains in Site Manager, with the site listed under the new name.
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Chapter 4. Creating and Managing Sites
4.1.7 Deleting a Site

To delete a site in the Site Manager, first be sure you have highlighted that 
site in the left window of the Site Manager. Then press [MENU] to open the 
File Menu, scroll to the Delete option, and press [ENTER]. The screen 
appears similar to Figure 47 below.

Figure 47: Delete Confirmation Window

• Press [F2], No, to cancel the deletion and return to the Site Manager, or

• Press [F3], Yes, to delete the site.

The Site Manager appears, with the highlighted site now deleted.
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Chapter 4. Creating and Managing Sites
4.1.8 Creating a Site Message

The Site Message option allows you to add an explanatory message (with 
up to 30 characters or spaces) for any given site. To create a site message:

1. Press [MENU] to enter the File Menu. Then press the [ ] arrow key 
once to scroll from the File Menu to the Site Menu. Press [ENTER]. The 
screen appears similar to Figure 48 below. 

Figure 48: Site Menu in the Site Manager

2. Press [ENTER] to select “Message,” which opens the text creation 
window, shown in Figure 49 on page 82.
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Chapter 4. Creating and Managing Sites
4.1.8 Creating a Site Message (cont.)

Figure 49: Text Creation Window

3. Use the four arrow keys to scroll to the desired letter or symbol, and 
press [ENTER] to add the letter to the message.

Note:  Pressing [SEL] causes the screen to alternate between a set of 
upper-case (capital) letters, a set of lower-case letters, and a set of 
symbols. Use all three screens to create a desired message.

4. Repeat this procedure for each letter or symbol you wish to add to the 
message. If you wish to delete a letter, press [F1] (Delete) to erase each 
letter or symbol, from right to left on the label.

When you have completed the message, press [F3] (OK) to confirm the 
message, or [F2] (Cancel) to leave the window without adding the message.
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Chapter 4. Creating and Managing Sites
4.1.9 Printing a Current Site

To print the current site from within the Site Manager, press [MENU] to open 
the File Menu. Then press the [ ] arrow key once to scroll from the File 
Menu to the Site Menu. Scroll to the Print option, and press [ENTER]. The 
PT878 shows a message indicating that its infrared sensor is looking for a 
receiving printer. (If the sensor spots no printer, a window appears 
indicating that it cannot find a device. If it spots more than one compatible 
infrared device within its range, it asks you to select the desired device.) If 
successful, the Site Manager window appears.

• Press [F2] (No) to cancel printing, or

• Press [F3] (Yes) to print the current site.

The PT878 returns to Operate Mode, while the printer prints out the current 
site. 

4.1.10 Transferring a Site File to a PC

To upload a site file to a PC, you must have an infrared sensor connected to 
the PC that can receive data from the PT878 IR beam.

1. Check that the Communications option on the PT878 (see page 123) 
has been set to the IrDA protocol, and that the IR beam on the PT878 
has clear access to the IR sensor connected to the PC port.

Note: For Windows NT 4.0, check that the QuickBeam® software (available 
through the path C:\Program Files\QuickBeam Suite) is running. 

2. Highlight the desired site in the left window of the Site Manager.

3. Press [MENU] to open the File Menu. Then press the [ ] arrow key 
once to scroll from the File Menu to the Site Menu. Scroll to the 
Transfer option, and press [ENTER]. 
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Chapter 4. Creating and Managing Sites
4.1.10 Transferring a Site to a PC (cont.)

The screen shows a message indicating that the PT878 is searching for an 
infrared device. (If the PT878 cannot detect an infrared device, a window 
appears indicating this problem, and asks if you want to try again.) If it 
finds a device, it sends another message indicating that it is uploading the 
site. (The meter also displays a message if the upload fails.) When the 
upload is complete, the meter returns to the Site Manager. The PC holds the 
transferred file in the QuickBeam Inbox folder (for Windows NT 4.0), as 
shown in Figure 50 below. If you are using other Windows operating 
systems, the transferred file appears in C:\My Received Files. You can open 
the file on the PC using any text editor.

Figure 50: IR_Inbox Folder - Transferred Site File

4.1.11 Transferring a Site File in Text Format to a PC

To transfer a site file in text format from the PT878 to a PC, be sure the PC 
is equipped with an infrared sensor as discussed on page 83.

1. Highlight the desired site in the left window of the Site Manager.

2. Press [MENU] to open the File Menu. Then press the [ ] arrow key 
once to scroll from the File Menu to the Site Menu. Scroll to the 
Transfer as Text option, and press [ENTER]. 

The PT878 uploads the file in the same manner as a site file, but with a .prt 
suffix. You can then open the file on the PC using any text editor.
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Chapter 4. Creating and Managing Sites
4.1.12 Transferring a File from a PC to the PT878

Once you have stored site or meter files to a PC, you can then transfer them 
back to the PT878 over an IR sensor (connected to the PC) through the 
PT878 IR interface. The PT878 only accepts files with a .sit (site) or .met 
(meter) extension. If you rename another type of file with one of these 
extensions and transfer it, it will be transferred, but will not function if you 
open it. Also, if you are transferring a file and the meter already has a file 
with the identical name, the meter will overwrite its current file with the 
transferred file. If the transferred file has a name longer than eight 
characters, the meter will shorten the name to eight characters, and replace 
any spaces in the name with underbars.

To download a site or meter file from a PC to a PT878:

1. Check that the Communications option on the PT878 (see page 123) 
has been set to the IrDA protocol, and that the IR beam on the PT878 
has clear access to the IR sensor connected to the PC port.

Note: For Windows NT 4.0, check that the QuickBeam® software (available 
through the path C:\Program Files\QuickBeam Suite) is running.

2. You can send the file in one of two ways.
For Windows NT 4.0:

• Click on the desired file, and drag it onto the rocket button in the 
QuickBeam window, as shown in Figure 51 below, or:

Figure 51: QuickBeam Window

• Open the Send menu in the QuickBeam window, enter the Files or 
Files on Clipboard option, scroll to the desired file, and click Send. 
QuickBeam opens a window indicating that it is downloading the file. 
If you close and reopen the Site Manager, the file appears as one of 
the listed sites.
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Chapter 4. Creating and Managing Sites
4.1.12 Transferring a File from a PC to the PT878 (cont.)

      For Windows 95/98/2000:

• Click on the Infrared icon in the System Tray of your PC, as shown 
in Figure 52 below.

 

Figure 52: Infrared Icon in System Tray

The Wireless Link window (for Windows 2000, shown in Figure 53 below) 
or the Infrared Transfer Application (for Windows 95/98) appears. Select 
the desired file, and click Send, or

Figure 53: Wireless Link Window
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Chapter 4. Creating and Managing Sites
4.1.12 Transferring a File from a PC to the PT878 (cont.)

• From Windows Explorer, right-click on the selected file. Select Send 
To  Infrared Recipient or Nearby Computer. For Windows 2000, 
you can also drag the selected file to the Wireless Link icon, shown in 
Figure 54 below.

Figure 54: Wireless Link Icon

Note: While sending or receiving files, the PT878 continues to perform 
measurements, but at a slower rate than normal.
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Chapter 4. Creating and Managing Sites
4.1.13 Listing Files by Name

If you want to list your files alphabetically by site name within the Site 
Manager, press [MENU] to open the File Menu. Then press the [ ] arrow 
key twice to scroll from the File Menu to the Sort Menu, shown in 
Figure 55 below. Press [ENTER]. The Site Manager screen refreshes, with 
the sites listed in alphabetical order.

Figure 55: Sort Submenu

4.1.14 Listing Files in Chronological Order

If you prefer to list your files chronologically by time of creation within the 
Site Manager, press [MENU] to open the File Menu. Then press the [ ] 
arrow key twice to scroll from the File Menu to the Sort Menu, and scroll to 
the By Date option. Press [ENTER]. The Site Manager screen refreshes, 
with the sites listed in chronological order, from the most recent to the 
earliest.
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Chapter 5. Displaying and Configuring Data
Chapter 5. Displaying and Configuring Data

The PT878 allows you to view from one to four different measurement 
parameters simultaneously. The screen can show these parameters not only 
in numeric format, but as line or bar graphs as well. 

You can configure any given measurement for your particular requirements. 
To configure an individual measurement, press [SEL] from the Operate 
Mode window shown in Figure 4 on page 13. A cursor appears next to the 
parameter closest to the upper left corner. Continuing to press [SEL] enables 
the cursor to scroll through the other displayed measurements. Once you 
have reached a particular window, pressing the [ENTER] button opens the 
menu for that window, as shown in Figure 56 below. To learn how to use the 
display window menu, see page 90 to page 94.

] 

Figure 56: Display Screen After Pressing [SEL]
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Chapter 5. Displaying and Configuring Data
5.1 The Format Option

The first option on the menu, Format, allows you to specify the type of 
notation and the number of decimal places for the measurement in that 
window. Press [ENTER] and the submenu shows two options, Decimal 
Place and Notation. Press the [ ] or [ ] arrow keys to select either entry, 
and press [ENTER]. The screen appears similar to Figure 57 below. To scroll 
to a particular parameter or menu entry, press the [ ] or [ ] key.

Note: If the window displays a line or bar graph, the Limits option appears 
instead of Format in the menu.

Figure 57: Number Format Window

1. The first entry, Format, asks you to select the numeric format from three 
choices: default, fixed decimal and scientific. Default provides the 
default resolution, while Fixed Decimal allows users to override the 
standard resolution. Scientific format displays the value in mantissa and 
exponent format.

a. Press [ENTER] to open the drop-down list of format choices.

b. Scroll to the appropriate selection.

c. Press [ENTER] to confirm your choice.

Programming

Number Format

Cancel OK

Format Fixed Decimal

 Decimal Places 2
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Chapter 5. Displaying and Configuring Data
5.1  The Format Option (cont.)

2. The second step asks you to choose the number of decimal places to be 
displayed. Available choices range from 0 to 4 places.

a. Press [ENTER] to open the drop-down list.

b. Scroll to the appropriate number. 

c. Press [ENTER] to confirm your choice.

• To confirm the entries and return to Operate mode, press [F3] (OK). 

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key.
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Chapter 5. Displaying and Configuring Data
5.2 The View Option

The second option, View, allows you to select the presentation of a 
parameter in one of three formats: numeric, line graph or bar graph. 

1. From the Display Menu, press the [ ] key once to reach the View 
option, and then press [ENTER].

2. A drop-down menu shows the three formats. Scroll to the appropriate 
selection.

3. Press [ENTER] to confirm your selection.

The screen immediately displays any changes. For example, if you have 
changed the first parameter to a line graph, the screen appears similar to 
Figure 58 below.

Figure 58: Screen After Format Change
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Chapter 5. Displaying and Configuring Data
5.3 The Limits Option

Once you have configured a parameter as a line or bar graph, you might 
need to change its presentation or values. The Limits option (replacing the 
Format option for line and bar graphs) enables you to program the minimum 
or maximum values displayed, the time interval and the display of the 
average value. 

To enter the Limits option:

1. Press [SEL] from the Operate Mode window until you have reached the 
desired measurement. 

2. Press [ENTER] to open the Display Menu.

3. Be sure the Limits option is highlighted, and press [ENTER]. 

4. A drop-down menu entry, Change, appears. Press [ENTER] again. 

The screen appears similar to Figure 59 below.

Figure 59: Line (or Bar) Graph Parameters Window
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Chapter 5. Displaying and Configuring Data
5.3  The Limits Option (cont.)

5. The first prompt asks for the minimum value shown in the graph.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the value.

6. Repeat the procedure in step 5 to enter the maximum value.

A line graph involves two more prompts.

7. The next prompt asks for the display interval.

a. Press [ENTER] to open the text box. Use the numeric keys to enter 
the desired number. Press [ENTER] to confirm the value.

b. The second box asks for the interval in terms of seconds, minutes, 
hours, or days. Press [ENTER] to open the drop-down menu, and 
then press the [ ] or [ ] keys to move to the desired parameter. 
Press [ENTER] to confirm the entry.

8. The final three prompts ask for details of the graph configuration: if you 
want to use lines, plot the average value, or show the minimum and 
maximum values. Press the [ ] key to step through each value, and 
press [ENTER] to add a given detail as part of the graph.

9. When you have configured the graph, press [F3] (OK) to confirm the 
graph settings.

The screen returns to Operate Mode, and displays any changes.
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Chapter 5. Displaying and Configuring Data
5.4 The Measurement Option

On occasion, you might need to change the actual parameter measured in a 
given window.The Measurement option enables you to reconfigure the 
window with one of five categories of data source (velocity, volume, 
forward or reverse totalizer, power, energy or diagnostics) and appropriate 
English or metric measurement units.

To enter the Measurement option:

1. Press [SEL] from the Operate Mode window until you have reached the 
desired measurement. 

2. Press [ENTER] to open the Display Menu.

3. Be sure the Measurement option is highlighted, and press [ENTER]. 

4. A drop-down menu entry, Change, appears. Press [ENTER] again. 

The screen appears similar to Figure 60 on page 96. The left column 
displays the five measurement data sources, while the right column displays 
English and metric measurement units (or, with the Diagnostics source 
shown, a list of diagnostics parameters).

5. Use the [ ] and [ ] arrow keys to reach the desired data source, and 
press [SEL]. 

6. Then use the [ ] or [ ] arrow keys to select the desired measurement 
unit (or diagnostic parameter). Press [F3] (OK) to confirm the entry.

7. The screen returns to Operate Mode, and displays any changes.
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5.4  The Measurement Option (cont.)

Figure 60: Measurement Menu Window
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Chapter 5. Displaying and Configuring Data
5.5 Customizing the Display Screen

You might wish to display one or two parameters, or customize the soft keys 
to quickly access particular menus. The Site Menu enables you to make 
more comprehensive changes in your display screen.

To enter the Site Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Menu Bar replaces the Status Bar at the top of the 
screen. The Site Menu will be highlighted in the upper left corner. Press 
[ENTER] or the [ ] arrow key. The screen now appears similar to 
Figure 61 below. While following the programming instructions, refer to 
Figure 138 on page 221 of Appendix A, Menu Maps.

Figure 61: Site Menu

• To specify the number of parameters displayed, go to page 98.

• To customize or clear softkeys (FKeys), go to page 99.
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Chapter 5. Displaying and Configuring Data
5.5.1 Specifying the Number of Displayed Parameters

As mentioned earlier, the PT878 can display one to four different 
measurement parameters simultaneously. However, sometimes you might 
wish to display only one or two parameters. To change the number of open 
display windows from within the Site Menu (shown in Figure 61 on 
page 97), use the [ ]or [ ] arrow keys to move to the desired number of 
views (1 View, 2 Views, etc.) Press [ENTER].

The screen displays the designated number of windows. For example, 
Figure 62 below shows the screen displayed in Figure 58 on page 92, 
reconfigured for a single view. 

Figure 62: Display Screen Configured for Single View

Note: The PT878 opens display windows clockwise from the upper left; that 
is, if you press “1 View,” the parameter displayed in the upper left 
window appears. If you press “2 Views,” the parameters shown in 
the two top windows appear. The view for “3 Views” adds the 
window in the lower left, and that for “4 Views” adds the window in 
the lower right.
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Chapter 5. Displaying and Configuring Data
5.5.2 Customizing Softkeys

When the screen is in Operate Mode, you might wish to access a particular 
submenu frequently without the trouble of scrolling through menus. 
Customizing the softkeys ([F1], [F2] and [F3]) allows you to access up to 
three submenus by pressing the associated softkey. You can customize a 
softkey from the Site Menu or from within a particular menu.

• To customize a softkey from within the Site Menu:

1. From the Site Menu (shown in Figure 61 on page 97), use the [ ] or 
[ ] arrow keys to move to the FKeys entry on the menu. Press 
[ENTER]. The screen now appears similar to Figure 63 below.

Figure 63: FKeys Menu

2. Use the [ ] or [ ] arrow keys to move to the desired FKey (1, 2 or 3) 
entry on the menu. Press [ENTER]. The Configure FKey window opens, 
as shown in Figure 64 on page 100.
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Chapter 5. Displaying and Configuring Data
5.5.2 Customizing Softkeys (cont.)

Figure 64: Configure FKey Window

3. Press [ENTER] to open the menu drop-down list. Then use the [ ] or 
[ ] arrow keys to scroll to the desired submenu (for example, 
Contrast).

4.  Press [ENTER] to confirm the entry, and press [F3] (OK) to confirm the 
entry and close the window. (Press [F2] (Cancel) to close the window 
without changing the key.)

The screen now appears similar to Figure 65 on page 101, with the [F1] 
window displaying “Contrast.” Pressing [F1] opens the Contrast window.

• To customize a softkey from a particular menu:

1. Open the desired menu on the Menu Bar (see Chapters 3, 4, 6, 7 and 8 
for details on particular menus) and scroll to the desired option.

2. Press the desired softkey. A window appears with the question, “Assign 
current menu command to FKeyX?”

3. Press [F3] (Yes) to confirm the assignment and close the window. (Press 
[F2] (No) to close the window without changing the key.)

Configure FKey

Cancel OK

Select a menu item

(Clear)
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Chapter 5. Displaying and Configuring Data
5.5.2 Customizing Softkeys (cont.)

Figure 65: Display Screen with Modified Softkey

• To clear a softkey:

1. From the Site Menu (shown in Figure 61 on page 97), use the [ ] or 
[ ] arrow keys to move to the FKeys entry on the menu. Press 
[ENTER]. The screen now appears similar to Figure 63 on page 99.

2. Use the [ ] or [ ] arrow keys to move to the desired Clear FKey (1, 2 
or 3) entry on the menu. Press [ENTER].

The softkey window clears. You can also clear the softkey through the 
Configure FKey window, by selecting (Clear) as an entry, pressing [ENTER] 
and then [F3] (OK).

Note: Since the customized softkeys are saved globally, they will remain, 
even if you change site files.
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Chapter 5. Displaying and Configuring Data
5.6 Managing Files — The Drive Manager

On occasion, you might want to review, print or transfer some or all of the 
files in the PT878. The Drive Manager allows you to view all the files 
stored in the meter. While following the programming instructions, refer to 
Figure 138 on page 221 of Appendix A, Menu Maps. To open the Drive 
Manager:

1. Press [MENU].

2. From the Site Menu (shown in Figure 61 on page 97), use the [ ] or 
[ ] arrow keys to move to the Drive Manager entry on the menu. Press 
[ENTER]. The screen now appears similar to Figure 66 below. 

Figure 66: Drive Manager Window

The window on the left lists all the meter, site and log files in the PT878, 
while the window on the right displays information on the file highlighted 
in the left window. 
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Chapter 5. Displaying and Configuring Data
5.6  Managing Files — The Drive Manager (cont.)

Figure 67: File Manager Menu

To transfer, refresh or delete a file, first be sure the file is highlighted in the 
window on the left. Then press [MENU] to open the File Menu, and scroll to 
the appropriate option, as shown in Figure 67 above. Press [ENTER]. The 
PT878 then performs the desired action with the file.
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Chapter 5. Displaying and Configuring Data
5.6.1 Transferring a File to a PC

To upload a log, meter, bitmap or site file to a PC:

1. Check that the Communications option on the PT878 (see page 123) 
has been set to the IrDA protocol, and that the IR beam on the PT878 
has clear access to the IR sensor connected to the PC port.

Note: For Windows NT4.0, check that the QuickBeam software (available 
through the path C:\Program Files\QuickBeam Suite) is running.

2. Highlight the desired site in the left window of the Drive Manager.

3. Press [MENU], scroll to the Transfer option, and press [ENTER]. 

The screen shows a message indicating that the PT878 is searching for an 
infrared device. (If the scanner spots no device, a window appears with this 
message, and asks if you want to try again.) If it finds a device, it sends 
another message indicating that it is uploading the site. (The meter also 
displays a message if the upload fails.) When the upload is complete, the 
meter returns to the Drive Manager. The PC holds the transferred file in the 
C:\IR_Inbox folder (C:\My Received Files for Windows 98, or Desktop for 
Windows 2000), as shown in Figure 68 below. You can open the file on the 
PC using any text editor.

Figure 68: IR_Inbox Folder - Transferred File
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Chapter 5. Displaying and Configuring Data
5.6.2 Transferring a File from a PC to the PT878

Once you have stored site or meter files to a PC, you can then transfer them 
back to the PT878 over the IR interface. The PT878 only accepts files with a 
.sit (site) or .met (meter) extension. If you try renaming another type of file 
with a .sit or .met extension and transfer it, it will be transferred, but it will 
not function if you open it. Also, if you are transferring a file and the meter 
already has a file with the identical name, the meter will overwrite its 
current file with the transferred file. If the transferred file has a name longer 
than eight characters, the meter will shorten the name to eight characters, 
and replace any spaces in the name with underbars.

Note: It is not possible to download log files back to the PT878.

To download a site or meter file from a PC to a PT878:

1. Check that the Communications option on the PT878 (see page 123) 
has been set to the IrDA protocol, and that the IR beam on the PT878 
has clear access to the IR sensor connected to the PC port.

Note: For Windows NT4.0, check that the QuickBeam software (available 
through the path C:\Program Files\QuickBeam Suite) is running.

2. You can send the file in one of two ways.
For Windows NT 4.0:

• Click on the desired file, and drag it onto the rocket button in the 
QuickBeam window, as shown in Figure 69 below, or

Figure 69: QuickBeam Window

• Open the Send menu in the QuickBeam window, enter the Files or 
Files on Clipboard option, scroll to the desired file, and click Send.
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Chapter 5. Displaying and Configuring Data
5.6.2 Transferring a File from a PC to the PT878 (cont.)

QuickBeam opens a window indicating that it is downloading the file. 
When the download is complete, the meter returns to the Drive Manager. If 
you close and reopen the Drive Manager, the file appears as one of the listed 
sites.

For Windows 95/98/2000:

• Click on the Infrared icon in the System Tray of your PC, as shown 
in Figure 70 below.

 

Figure 70: Infrared Icon in System Tray

The Wireless Link window (for Windows 2000, shown in Figure 71 below) 
or the Infrared Transfer Application (for Windows 95/98) appears. Select 
the desired file, and click Send, or

Figure 71: Wireless Link Window
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Chapter 5. Displaying and Configuring Data
5.6.2 Transferring a File from a PC to the PT878 (cont.)

• From Windows Explorer, right-click on the selected file. Select Send 
To  Infrared Recipient or Nearby Computer. In Windows 2000, you 
can also drag the selected file to the Wireless Link icon, shown in 
Figure 72 below.

Figure 72: Wireless Link Icon

Note: While sending or receiving files, the PT878 continues to perform 
measurements, but at a slower rate than normal.

5.6.3 Refreshing a File

To refresh a file so that the PT878 displays the most recent information, you 
have two options:

• Press [MENU], scroll to the Refresh option, and press [ENTER].

• Press [F2] (Refresh).

In either case, the window on the right of the File Manager displays the 
most recent file information. 
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5.6.4 Deleting a File

To delete a file in the File Manager, first be sure you have highlighted that 
file in the left window of the File Manager. Then press [MENU], scroll to the 
Delete option, and press [ENTER]. The screen appears similar to Figure 73 
below.

Figure 73: Delete Confirmation Window

• Press [F2], No, to cancel the deletion and return to the File Manager, or

• Press [F3], Yes, to delete the site.

The File Manager appears, with the highlighted site now deleted.
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Chapter 5. Displaying and Configuring Data
5.6.5 Listing Files by Name

If you want to list your files alphabetically by site name within the File 
Manager, press [MENU] to open the File Menu. Then press the [ ] arrow 
key to scroll from the File Menu to the Sort Menu, shown in Figure 74 
below. Press [ENTER]. The File Manager screen refreshes, with the sites 
listed in alphabetical order.

Figure 74: Sort Submenu

5.6.6 Listing Files in Chronological Order

If you prefer to list your files chronologically by time of creation within the 
File Manager, press [MENU] to open the File Menu. Then press the [ ] 
arrow key to scroll from the File Menu to the Sort Menu, and scroll to the 
By Date option. Press [ENTER]. The Site Manager screen refreshes, with 
the sites listed in chronological order, from the most recent to the earliest.
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Chapter 5. Displaying and Configuring Data
5.7 Accessing Meter Data —The About Option

The About option displays useful information concerning the model number 
and software version of any given PT878. While the window normally 
appears briefly at startup, users might want to access the information for a 
longer period. To open the About window, scroll to the About option on the 
Site Menu and press [ENTER]. The screen appears similar to Figure 75 
below. To access data on your specific PT878, press [F2] (Next).

Figure 75: About Window

To return to Operate Mode, press [ESC] or [F3] (Exit).
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Chapter 6. Programming Meter Settings
Chapter 6. Programming Meter Settings

Along with display formats and site data, PT878 users can program global 
settings for the meter that suit their individual preferences. The global 
settings include:

• English or Metric measurement units

• Battery power

• Date and time parameters and appearance (locale)

• Screen contrast

• Backlight timeout

• Language settings

• Infrared communications settings

• Resetting forward and reverse totals

• User tables

• Printing a screen

• Taking a bitmap capture of a screen
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Chapter 6. Programming Meter Settings
6.1 Entering the Meter Menu

To enter the Meter Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Main Menu replaces the Status Bar at the top of the 
screen. Press the [ ] arrow key twice to scroll from the Site Menu to the 
Meter Menu. At the Meter Menu, press [ENTER]. The screen appears 
similar to Figure 76 below. While programming, refer to Figure 140 on 
page 223 of Appendix A, Menu Maps.

Figure 76: Meter Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys until you 
reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time and 
return to Operate Mode without changing the parameters.
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Chapter 6. Programming Meter Settings
6.2 Selecting Measurement Units

The first option, Units, enables you to select either English or Metric units 
as global measurement units for the PT878. The selected units then become 
the default settings for every measurement that has the option for 
metric/English units. To select the units, scroll to the Units entry on the 
Meter menu and press [ENTER]. The Meter Settings window opens, as 
shown in Figure 77 below.

Figure 77: Meter Settings Window
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2. Press [ENTER] to confirm the choice.
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Chapter 6. Programming Meter Settings
6.3 The Battery Charger

The Battery option allows you to monitor the current run time and status of 
the internal rechargeable batteries, as well as to condition NiCad batteries to 
maintain the maximum life possible. Conditioning NiCad batteries (a 
process that can take up to 12 hours for a fully charged pack) discharges the 
pack completely and then performs a fast charge. 

Note: When conditioning the batteries, be sure you have plugged the AC 
adapter into the PT878 and pressed the power key. NiMH batteries 
normally do not require conditioning.

To open the option window:

1. From the Meter menu, scroll to the Battery entry and press [ENTER]. 
The Battery Charger window opens, as shown in Figure 78 below. 

2. If you wish to open the Part Number window, press [ENTER]. You can 
choose from a 1.8 Ahr NiCad battery (part number 200-058) or a 3.0 
Ahr NiMH battery (part number 200-081). Scroll to the battery type you 
have installed and press [ENTER].

Note: If you do not set the correct battery type in the Part Number window, 
the battery continues to function, but the battery status icons (see 
page 10) will not be accurate.

Figure 78: Battery Charger Window
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Chapter 6. Programming Meter Settings
6.3  The Battery Charger (cont.)

3. To condition the batteries, press the [ENTER] key. The “Condition 
Battery” window should now read “Stop.” The status line should 
change to “Discharging.” (Updating the status could take up to 30 
seconds.)

Note: It is advisable to condition NiCad batteries when their run time is 
reduced to 50% of their previous run time.

4. To stop the discharge cycle, press the [ENTER] key and the “Condition 
Battery” window reappears. The status now changes to “On Charger.”

5. Press [F3] (OK) to return to Operate Mode.

6.4 Entering Date and Time 

In Operate mode, the Status Bar displays the current date and time above 
the measurements in the upper right corner of the screen. The Date/Time 
option allows you to set the date or time, which are required for correct data 
logging operation. 

To set the time:

1. From the Meter menu, scroll to the Date/Time entry and press [ENTER]. 
The Meter Settings window reopens, as shown in Figure 77 on 
page 113. 

2. From the Units option, press the [ ] key once to reach the date text 
box. This box displays the current meter date. 

3. Press [ENTER] to enter the text window. The meter highlights the center 
number. Use the [ ] and [ ] keys to scroll to any number you wish to 
change.
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6.4  Entering Date and Time (cont.)

4. Two alternatives are available to change a highlighted number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, to the 
desired number. (For example, if the text box highlights 09, pressing 
the [ ] key twice changes the number to 07. You can scroll from 01 
to 12 for the month and from 01 to 31 for the day (depending on the 
number you have selected for the month.) 

In either case, press [ENTER] to confirm the entry.

To enter or change the time:

1. From the time text box, press the [ ] key once to scroll to the time text 
box. This box displays the current meter time. 

2. Press [ENTER] to enter the text box. The meter highlights the first 
number. Use the [ ] and [ ] keys to scroll to any number you wish to 
change.

3. Two alternatives are available to change a highlighted number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, to the 
desired number. (For example, if the text box highlights 09, pressing 
the [ ] key twice changes the number to 07.) You can scroll from 01 
to 12 for the hour and from 01 to 59 for the minute and second inputs.

4. In either case, press [ENTER] to confirm the entry.

Pressing the [ ] or [ ] arrow keys causes the meter to scroll within the 
Meter Settings options.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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6.5 Changing Date and Time Appearance

In addition to setting the correct date and time, you can also change its 
presentation to suit local preferences. You can select a time display of 
AM/PM or 24-hour time.

To alter the time and date display:

1. From the Meter menu, scroll to the Locale entry and press [ENTER]. 
The Display Options window opens on the Format tab, as shown in 
Figure 79 below. To step through each parameter, press the [ ] key.

 

Figure 79: Format Tab in the Display Options Window
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Chapter 6. Programming Meter Settings
6.5  Changing Date and Time Appearance (cont.)

2. The first series of prompts asks you to select separator symbols for the 
date, time and decimal. You can choose from a dash, comma and slash 
(/) for the date; from a period and colon for the time: and from a period 
or comma for the decimal place. For each symbol type:

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired format.

c. Press [ENTER] to confirm your entry.

3. The next prompt asks you to select the date format.

a. Press [ENTER] to open the drop-down menu. Three options are 
available:

• YYYY/MM/DD (year/month/day)

• MM/DD/YYYY (month/day/year)

• DD/MM/YYYY (day/month/year)

b. Use the [ ] or [ ] arrow keys to scroll to the desired format.

c. Press [ENTER] to confirm your entry.

4. The PT878 now asks you to select whether you want the time presented 
in a 12-hour format (for example, 11:53:23 PM) or in a 24-hour format 
(23:53:23).

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the 12-hour or 24-hour 
entry.

c. Press [ENTER] to confirm your entry.
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Chapter 6. Programming Meter Settings
6.5  Changing Date and Time Appearance (cont.)

A line at the bottom, the Date/Time, Decimal Formats, displays how the 
format and separator selections will appear on the screen.

Pressing the [ ] arrow key returns the PT878 to the Locale tab.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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Chapter 6. Programming Meter Settings
6.6 Adjusting the Contrast

For more comfortable viewing in a particular environment, the PT878 
enables you to adjust the screen contrast. To adjust the screen contrast:

1. From the Meter menu, scroll to the Contrast entry and press [ENTER]. 
The Display Options window opens on the Display tab, as shown in 
Figure 80 below. (From the Format tab, press the [ ] key to move to 
the Display tab.) To step through each parameter, press the [ ] key.

Figure 80:  Display Tab in the Display Options Window

2. Scroll to the Darker or Lighter box as desired.

3. Press the [ENTER] button repeatedly until the screen has the desired 
contrast. 

Note: If you find the screen has become too light or too dark, scroll to the 
other box and press [ENTER] until you have adjusted the screen to 
your satisfaction.

Display

   Display Options

Cancel OK

Format

Darker

Lighter

Backlight Off Min3

Language English
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6.6  Adjusting the Contrast (cont.)

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

6.7 Setting Backlight Timeout

By using the Backlight Timeout option, you can set a specified time that the 
PT878 backlight will remain on before turning itself off. Automatic turnoff 
enables the PT878 to conserve battery power. 

To set the backlight timeout:

1. From the Meter menu, scroll to the Backlight entry and press [ENTER]. 
The Display Options window opens on the Display tab, as shown in 
Figure 80 on page 120.

2. Press the [ ] key three times to reach the Backlight Off text box. 

3. Then press [ENTER] to enter the box.

4. Use the numeric keys to enter the number of minutes that the backlight 
remains on (from 0 to 99).

5. Press [ENTER] to confirm the entry.

• To confirm the entries and return to Operate mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

Note: You can turn the backlight on or off at any time by pressing the power 
switch for 1 second.
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6.8 Changing the Display Language

IMPORTANT: To use this option, you must have previously loaded a 
language translation file into the PT878.

The PT878 offers the selection of several languages for its display. To 
change the display language:

1. From the Meter menu, scroll to the Language entry and press [ENTER]. 
The Display Options window opens on the Display tab, as shown in 
Figure 80 on page 120.

2. Press the [ ] key four times to reach the Language prompt. 

3. Then press [ENTER] to enter the drop-down menu.

4. Scroll to the desired language on the menu, here shown as either 
English or Francais (French).

5. Press [ENTER] to confirm the entry, and [F3] (OK) to close the option. 

6. Since changing the language requires restarting the PT878, a window 
(shown in Figure 81 below) opens, asking that you confirm the change. 
Press [F2] to cancel the change or [F3] to confirm the change.

Figure 81: Confirmation Window for Language Change

Change Language

Cancel OK

Choose CANCEL to exit or OK to
proceed.

Changing the meter’s language
requires a restart.
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6.8  Changing the Display Language (cont.)

The meter restarts in Operate Mode in the desired language. Figure 82 
below illustrates a French version of the display shown in Figure 58 on 
page 92.

Figure 82: French Version of Typical Display

Note: The PT878 defaults to US English. However, one or more alternate 
languages can be installed at any time. Consult your GE 
representative or www.gesensing.com for available languages.

6.9 Changing Communications Settings

On occasion, you might need to change the parameters by which the PT878 
communicates with a PC over the wireless infrared interface. While 
programming, see Figure 153 on page 237 of Appendix A, Menu Maps. To 
check or change these parameters:
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Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 123



Chapter 6. Programming Meter Settings
6.9  Changing Communications Settings (cont.)

1. From the Meter menu, scroll to the Communications entry and press 
[ENTER]. The Communications window appears similar to Figure 83 
below. 

Figure 83: Communications Window

2. The first prompt asks for the node identification number, which can be 
any number from 1 to 240. Do NOT change the node ID unless 
instructed by GE.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the node ID.

c. Press [ENTER] to confirm the entry.

3. The next prompt asks you to select the communications interface from 
two options: IrDA (Infrared Data Association) and the IR232 virtual 
interface. You must use IrDA when using an IR printer or transfer 
application such as QuickBeam. Use the [ ] and [ ] keys to scroll to 
the desired selection, and press [ENTER].

Communications

Node ID 2

Comm Interface IrDA   IR 232

Baud Rate   9600 bps

Parity None
Stop Bits   

Data Bits

1 2

7 8

Cancel OK
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6.9  Changing Communications Settings (cont.)

Note: For more information on loading software updates via IrDA, see 
Chapter 8, Servicing the PT878, page 195. 

4. The program now asks for the baud rate. The default rate is 9600 bps. 

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired rate, from 
300 to 115.2K bps.

c. Press [ENTER] to confirm the entry.

5. The next prompt asks for the parity from five options: None, Mark, 
Space, Even or Odd. The default parity is None.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired parity.

c. Press [ENTER] to confirm the entry.

6. The next prompt asks you to select either one or two stop bits.The 
default number is one. Use the [ ] and [ ] keys to scroll to the desired 
number, and press [ENTER].

7. The final prompt asks you to select either seven or eight data bits. The 
default number is 8. Use the [ ] and [ ] keys to scroll to the desired 
number, and press [ENTER].

IMPORTANT: Using IR232 requires the following parameters:

•Baud Rate -- 9600
•Parity -- None
•Stop Bits -- 1
•Data Bits -- 8 

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.
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6.10 Resetting Forward and Reverse Totals

On occasion, it might be necessary to clear and reset the forward and 
reverse totals computed by the Forward and Reverse Totalizers. To reset the 
totals:

1. From the Meter menu, scroll to the Totals entry and press [ENTER]. The 
window now appears similar to Figure 84 below.

Figure 84: Resetting Totals Menu

2. Use the [ ] or [ ] arrow keys to choose the total to be reset.

3. Press [ENTER] to reset the total(s).

The meter resets the selected total(s) to 0.0 and returns to Operate Mode.
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6.11 Setting Up User Tables

When you program user functions (see page 61), you can also support them 
with up to six user tables of non-linear or empirical data. To program one or 
more user tables:

1. From the Meter menu, scroll to the User Tables entry and press 
[ENTER]. The window now appears similar to Figure 85 below.

Figure 85: User Tables Window

2. The first prompt asks you to select the table to be programmed.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the table you wish to 
program.

c. Press [ENTER] to confirm the entry.

Programming

   User Function Tables

Cancel OK

Edit Tables

Table

Table ID

Table 1

UserTable1

# Data Points

Max Points
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6.11  Setting up User Tables (cont.)

3. The next step is to create a Table ID.

a. Press [ENTER] to open the window. The screen now appears similar 
to Figure 86 below.

Figure 86: Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or symbol, and 
press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a set of 
upper-case (capital) letters and a set of symbols. Use both screens to 
create the desired label.

c. Repeat this procedure for each letter or symbol you wish to add to 
the label. If you wish to delete a letter, press [F1] (Delete) to erase 
each letter or symbol, from right to left on the label.

d. When you have completed the label, press [F3] (OK) to confirm the 
label, or [F2] (Cancel) to leave the window without adding the label.

Note: It is not necessary to enter the “#Data Points” or “Max Points” text 
boxes.

Delete Cancel OK

UserTable1

A       B      C     D       E      F        G     H      I        J

K      L       M     N       O     P        Q      R     S      T

U     V      W      X      Y      Z        0       1       2      3     
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6.11  Setting up User Tables (cont.)

4. The final prompt asks you to enter or change data in the user table.

a. Press [ENTER] to open the window. The screen appears similar to 
Figure 87 below.

Figure 87: Edit User Table Window

b. Use the four arrow keys to move to the desired entry in the table. 

c. Press [ENTER]. Then use the numeric keys to enter the desired data, 
which appears in the right corner of the window above the table.

d. Press [ENTER] to confirm the data, which then appears in the 
appropriate slot in the table.

e. Repeat steps b, c and d on the previous page 129 until you have 
completed entering data for the table.

f. When you have finished, press [F3] (OK) to confirm the entries or 
[F2] (Cancel) to leave the window without confirming the table.

Programming

 Edit User Table 1

Cancel OK

UserTable1 Y

1

2

3

4
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6.11  Setting up User Tables (cont.)

The program returns to the Edit Tables window. 

• To confirm the entries and return to Operate Mode, press [F3] (OK). The 
PT878 returns to Operate Mode.

• To leave the window without confirming the entries, press [F2] (Cancel) 
or the [ESC] key. The PT878 returns to Operate Mode.

6.12 Taking a Bitmap Capture of a Current Screen

The Snapshot option enables you to take a screen capture of the current 
screen in bitmap format (.bmp) for printing or display or storage in a 
Windows-based PC. To take a “snapshot” of the screen:

1. From the Meter menu, scroll to the Snapshot entry and press [ENTER]. 

2. Another menu opens with three entries: Off, To Printer and To File. 
Scroll to the desired entry and press [ENTER].

Note: An icon of a printer (for printing capture) or a camera (for file 
capture — see page 16) appears at the far right of the status tray, 
indicating that you have activated the Snapshot option. Figure 76 on 
page 112 shows a screen with the Snapshot option activated.

3. To capture a screen, press the “.” (decimal) button in the lower left 
corner of the keypad twice. The meter beeps, indicating that it has made 
a screen capture.

The program now varies, depending on whether you selected printer or file 
capture.

• If you selected To Printer, the PT878 shows a message indicating that 
its infrared sensor is looking for a receiving printer. (If the sensor 
spots no printer, a window appears indicating that it cannot find a 
device. If it spots more than one compatible infrared device within its 
range, it asks you to select the desired device.) It transmits the 
capture to the printer once it has made a connection.

• If you selected To File, the captured file appears as “Screen 0X.bmp” 
in the Drive Manager (see page 102). To transfer the file to a PC, 
follow the instructions in Transferring a File to a PC on page 104.
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Chapter 7. Logging Data

A powerful and flexible feature of the PT878 is data logging. The meter 
enables you to choose up to 12 parameters to log. You can also select the 
start time and date, end time and date, and time interval. Logs can run one at 
a time or simultaneously. Error and circular logs are also available. The 
logged data is internally stored in battery-backed-up memory. A fixed 
amount of memory is assigned to data logging. The frequency of the time 
interval, the length of the log run, and the number of logs affect the amount 
of memory required for a particular log. For example, a log that records 
every 5 seconds will use up more memory than a log that records every 5 
minutes for a given amount of time. Once you make your data logging 
selections, the PT878 enables you to view the amount of memory left. You 
may also stop logging or view logged data while or after data is logged.

This section describes:

• How to enter the Logging Menu.

• How to set up a new log.

• How to view the data logger memory.

• How to start, stop or pause logging
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7.1 Entering the Logging Menu

To enter the Logging Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Main Menu replaces the Status Bar at the top of the 
screen. Press the [ ] arrow key three times to scroll from the Site Menu to 
the Logging Menu. At the Logging Menu, press [ENTER]. The screen 
appears similar to Figure 88 below. Refer to Figure 141 on page 224 of 
Appendix A, Menu Maps.

Figure 88: Logging Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys until you 
reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any time and 
return to Operate Mode without changing the parameters.
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7.2 The Log Manager

The Log Manager offers users a way to check the status and memory size of 
all the logs currently pending, running or finished. To select Log Manager, 
scroll to the Manager entry on the Logging Menu and press [ENTER]. The 
screen appears similar to Figure 89 below. The right section of the screen 
supplies information for the log highlighted in the list on the left. You can 
use the [ ] and [ ] arrow keys to scroll to a particular log and display 
information pertaining to that log.

Figure 89: Log Manager Window

To access the menu for the Log Manager, press the [MENU] key. The cursor 
highlights the File Menu in the upper left corner. Use the [ ] and [ ] keys 
to scroll to the desired menu, and press [ENTER] to open the menu.

Log Manager

Info: AAA.LOG

03/01/01 13:23:21
1216 bytes
109568 bytes free

Refresh Exit
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State: Finished

File    Log     View   Sort 

S:03/01/01 13:13:41
E:03/01/01 13:23:41
Interval: 10 Seconds
Records:51
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7.3 The File Menu

The File menu allows you, not only to create new logs, but also to copy, 
rename or delete logs, as well as to print them or transfer them to a PC. To 
open the File Menu from the Log Manager, press the [MENU] key and then 
[ENTER]. The screen appears similar to Figure 90 below.

Figure 90: File Menu in the Log Manager
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7.3.1 Setting up a New Log

The New Log option enables you to create and set up parameters for a new 
log. You can access this option in two ways:

• by scrolling to the New Log option in the Logging Menu (as shown in 
Figure 88 on page 132) and pressing [ENTER], or

• by scrolling to the New option in the File Menu of the Log Manager (as 
shown in Figure 90 on page 134) and pressing [ENTER].

In either case, the Create New Log screen appears similar to Figure 91 
below. Use the four arrow keys to scroll to the desired letter or number, and 
press [ENTER]. Repeat this procedure until you have created the desired log 
name. (Press [F1], Delete, to remove any unwanted letters or numbers.) 
When you have finished, press [F3] (OK) to confirm the entry.

Figure 91: New Log Window

The PT878 now asks for log formatting and measurements. The screen 
appears similar to Figure 92 on page 136.
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7.3.1 Setting up a New Log (cont.)

Figure 92: General Log Format Window

To step through each parameter, press the [ ] key.

1. The first prompt asks you to choose between a linear or circular format 
for the log. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

2. The next prompt asks you to choose whether the log is to be a standard 
or error log. 

a. Use the [ ] and [ ] keys to scroll to the appropriate radio button.

b. Press [ENTER] to confirm your selection.

General Measurements

Cancel Activate

Log Name 10SEC.LOG

End Date/Time

Standard Error
Linear Circular

Type
Format

Logging Interval 

 Start Date/Time 01:38:08

2000/11/01
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09:38:08
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136 Transport® Model PT878 Portable Liquid Flowmeter User’s Manual



Chapter 7. Logging Data
7.3.1 Setting up a New Log (cont.)

3. The next prompt asks for the starting date and time.

a. Press [ENTER] to enter the text box. The meter highlights the first 
number. Use the [ ] and [ ] keys to scroll to any number you wish 
to change, or the [ ] key to scroll to the time box.

b. Two alternatives are available to change a highlighted number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, to the 
desired number. (For example, if the text box displays 09, pressing 
the [ ] key twice changes the number to 07.) You can scroll from 01 
to 12 for the month and from 01 to 31 for the day (depending on the 
number you have selected for the month).

c. In either case, press [ENTER] to confirm the entry.

4. Follow the same procedure to enter the end date and time.

5. The final prompt in this window asks for the logging interval.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired interval in seconds. 

c. Press [ENTER] to confirm the entry.

6. You have completed entering parameters in this window. To select the 
measurements, 

a. Press the [ ] key to return to the Format prompt.

b. Then press the [ ] key to return to the General tab.

c. Finally, press the [ ] key to move to the Measurements tab, and 
press [ENTER]. The Measurements window appears similar to 
Figure 93 on page 138.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 137



Chapter 7. Logging Data
7.3.1 Setting up a New Log (cont.)

Figure 93: Log Measurements Window

To step through each entry, press the [ ] key.

1. Press [ENTER] to open the first entry. The Select Measurement window 
opens, as shown in Figure 94 on page 139.

General             NsMeasurements

NO UNIT                            NO UNIT
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NO UNIT                            NO UNIT
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7.3.1 Setting up a New Log (cont.)

Figure 94: Select Measurement Window

2. Scroll to the desired output type.

3. Press [SEL] to confirm your selection.

4. The prompt then moves to a list of unit types. (The available units 
depend on the selection made at the Data Source prompt.) Scroll to the 
desired output unit.

5. Press [F3] (OK) to confirm your selection.

6. You can repeat this procedure for up to 12 different parameters. 

7. When you have finished, press [F2] (Cancel) to cancel the entries, or 
[F3] (Activate) to confirm the entries and start the log.

If you started the log from the New Log option, the PT878 returns to 
Operate Mode, with a Pencil icon in the System Tray; if you started it from 
within the Log Manager, the meter returns to the Log Manager.

         Select Measurement

Cancel OK
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7.3.2 Copying (Cloning) a Selected Log

In the Clone Selected Log option, you can copy the parameters of a 
particular log, modify the parameters, and start the copy. To copy a log,

1.  First, select the log you wish to copy in the Log Manager (shown in 
Figure 89 on page 133).

2. Then open the File Menu, scroll to the Clone Selected Log option, and 
press [ENTER].

3. The Create New Log window (see Figure 91 on page 135) opens. 
Follow the procedure discussed on page 135 to create a log name, and 
press [F3] (OK) to confirm the name.

4. The General Log Format window (shown in Figure 92 on page 136) 
opens. Follow the procedure discussed on page 136 and page 137 to 
change any settings. 

Note: Unless otherwise specified, the cloned log always begins at the 
current date and time, and ends after the period of time used by the 
original log.

5. If you wish, scroll to the Measurements window (shown in Figure 93 on 
page 138) and follow the procedure discussed on page 138 and 
page 139 to modify any parameters. 

6. When you have completed modifying the log parameters, press [F2] 
(Cancel) to cancel the log or [F3] (Activate) to confirm and start the new 
log.

The PT878 returns to the Log Manager, which now displays the status of the 
cloned log.
140 Transport® Model PT878 Portable Liquid Flowmeter User’s Manual



Chapter 7. Logging Data
7.3.3 Renaming a Log

To rename a log:

1. First, select the log you wish to rename in the Log Manager (shown in 
Figure 89 on page 133)).

2. Then open the File Menu, scroll to the Rename option, and press 
[ENTER].

3. The Rename Log window opens. (Except for the heading, the window is 
identical to the Create New Log window shown in Figure 91 on 
page 135.) Follow the procedure discussed on page 135 to create a log 
name, and press [F3] (OK) to confirm the name.

The PT878 returns to the Log Manager, which highlights the renamed log.

7.3.4 Deleting a Log

To delete a log:

1. First, select the log you wish to delete in the Log Manager (shown in 
Figure 89 on page 133)).

2. Then open the File Menu, scroll to the Delete option, and press 
[ENTER].

3. A delete confirmation window opens, as shown in Figure 95 on 
page 142. Press [F2] (No) to stop the deletion, or [F3] (Yes) to delete the 
log.

The Log Manager reappears, with the specified log deleted.
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7.3.4 Deleting a Log (cont.)

Figure 95: Delete Confirmation Window

7.3.5 Deleting All Logs

To clear the Log Manager and memory of all logs, open the File menu, 
scroll to the Delete All Logs option, and press [ENTER]. A window opens, 
asking, “Delete All Logs?” Press [F2] (No) to stop the deletion, or [F3] (Yes) 
to delete the logs.

A blank Log Manager appears. All logs have been deleted.

7.3.6 Refreshing the Log Manager Screen

To refresh the Log Manager screen and view the most recent information on 
a given log, select the log you wish to view in the Log Manager. Then open 
the File Menu, scroll to the Refresh option, and press [ENTER]. The screen 
momentarily blanks, and then reappears with the most current information 
on the highlighted log.
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7.3.7 Printing a Log

To print a file from the Log Manager:

1. Highlight the desired log in the window on the left of the Log Manager. 

2. Press [MENU], scroll to the Print option, and press [ENTER].

3. The Enter Time window opens, as shown in Figure 96 below. To 
determine the exact time period for which you wish to print the log:

Figure 96: Enter Time Window

a. Use the arrow keys to scroll to the desired text box. Press [ENTER] 
to open the box.

b. Two alternatives are available to change a highlighted date or time:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, 
to the desired number. (For example, if the text box displays 09, 
pressing the [ ] key twice changes the number to 07.) You can 
scroll from 01 to 12 for the month, from 01 to 31 for the day 
(depending on the number you have selected for the month), and 
from 0 to 59 for minutes and seconds.

In either case, press [ENTER] to confirm the entry.

c. Repeat step 2 for any other entries you wish to change. When you 
have finished, press [F3] (OK) to confirm the entries and close the 
window.

-52.0 Enter Time

Start Date

End Date

Start Time

End Time
2003/03/01

2003/03/01 13:53:41 PM

13:23:41 PM
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 143



Chapter 7. Logging Data
7.3.7 Printing a Log (cont.)

The PT878 shows a message indicating that its infrared sensor is looking for 
a printer. (If the sensor spots no printer, a window appears with this 
message. If it spots two printers within its range, it asks you to select the 
desired device.) If successful, the PT878 returns to the Log Manager, while 
the printer prints out the log.

7.3.8 Transferring a Log to a PC

To upload a log to a PC:

1. Check that the Communications option (see Appendix F) has been set 
to the IrDA protocol, and that the IR beam on the PT878 has clear 
access to the IR sensor connected to the PC port.

Note: For Windows NT 4.0, check that the QuickBeam software (available 
through the path C:\Program Files\QuickBeam Suite) is running. 

2. Highlight the desired log in the left window of the Log Manager.

3. Press [MENU], scroll to the Transfer option, and press [ENTER]. 

The screen shows a message indicating that the PT878 is searching for an 
infrared device. (If the sensor spots no device, a window appears with this 
message, and asks if you want to try again.) If it finds a device, it sends 
another message indicating that it is uploading the log. (The meter also 
displays a message if the upload fails.) When the upload is complete, the 
meter returns to the Site Manager. The PC holds the transferred log in a 
C\Ir_Inbox folder (C:\Ir_Inbox for Windows NT, C:\My Received Files for 
Windows 98, or Desktop for Windows 2000). You can open the file on the 
PC using the PanaLog Viewer (available at www.gesensing.com) or 
PanaView software and export it in Microsoft Excel format.

Note: You cannot download log files back to the PT878.
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7.4 The Log Menu

The Log Menu allows you to pause, restart or end any or all logs that are 
currently pending or running. (However, you cannot restart any finished 
logs, even if they were finished before the programmed end time.) To open 
the Log Menu in the Log Manager, press [MENU]. Scroll to the Log option, 
and press [ENTER]. The window appears similar to Figure 97 below.

Figure 97: Log Menu in the Log Manager
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7.4.1 Stopping (Pausing) a Log

To stop a log that is currently pending or running, 

1. First, select the log you wish to pause in the Log Manager (shown in 
Figure 89 on page 133).

2. Then open the Log Menu, scroll to the Pause option, and press 
[ENTER].

The PT878 returns to the Log Manager, which displays the highlighted log 
with “Paused” in the State line.

7.4.2 Restarting a Log

To restart a paused log:

1.  First, select the log you wish to restart in the Log Manager (shown in 
Figure 89 on page 133).

2. Then open the Log Menu, scroll to the Start option, and press [ENTER].

The PT878 returns to the Log Manager, which displays the highlighted log 
with a status of “Pending” or “Running.”

7.4.3 Ending a Log

To end a log:

1.  First, select the log you wish to end in the Log Manager (shown in 
Figure 89 on page 133).

2. Then open the Log Menu, scroll to the End option, and press [ENTER].

The PT878 returns to the Log Manager, which displays the highlighted log 
with a status of “Finished.” The space not used by the finished log is freed 
for reuse.

Note: You cannot restart a finished log. You must create a new log with the 
same parameters.
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7.4.4 Stopping All Logs

To stop all log that are currently pending or running, open the Log Menu, 
scroll to the Pause All Logs option, and press [ENTER]. The PT878 returns 
to the Log Manager, which displays all log programmed to run now or in the 
future with a status of “Paused.”

7.4.5 Restarting All Logs

To restart all paused logs, open the Log Menu, scroll to the Start All Logs 
option, and press [ENTER]. The PT878 returns to the Log Manager, which 
displays the logs with a status of “Pending” or “Running.”

7.4.6 Ending All Logs

To end all currently pending or running logs, open the Log Menu, scroll to 
the End All Logs option, and press [ENTER].The PT878 returns to the Log 
Manager, which displays the running logs with a status of “Finished.”

7.4.7 View All Sites

To check on all logs, open the Log Menu, scroll to the View All Sites 
option, and press [ENTER]. Logs are associated with the site in use at the 
time the log is created. Thus, when another site is in use, the PT878 
automatically starts different logs. By default, the Log Manager only 
displays the logs created with the current site. View All Sites allows the 
Manager to list logs for all sites.
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7.5 The View Menu

Through the View menu, you can view the data of individual logs in 
graphical or spreadsheet formats. To open the View menu from the Log 
Manager, press [MENU]. Scroll to the View menu, and press [ENTER]. The 
screen appears similar to Figure 98 below.

Figure 98: View Menu
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7.5.1 Displaying Log Details

To view details of a given log, be sure the log is highlighted in the left 
window of the Log Manager. Then scroll to the View menu and press 
[ENTER]. Scroll to the Details option and press [ENTER]. The screen now 
appears similar to Figure 99 below.

Figure 99: Log Details Display Window - List of Measurements in Log

Press [F2] (Cancel) or [F3] (OK) to return to the Log Manager.

Log Info
State: Finished
S:03/01/01 13:13:41
E:03/01/01 13:23:41
Interval:10 Seconds
Records:51
Precision: 8 Error:No (Basic)

Velocity: Meters/sec

Exit
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7.5.2 Displaying Log Data in Graphical Form

To view a log in graphical form, be sure the log is highlighted in the left 
window of the Log Manager. Then scroll to the View menu and press 
[ENTER]. Scroll to the Graph option and press [ENTER].

Figure 100: Log Graph Display Window

The Select Measurement window opens and lists the log measurement 
parameters. If a log contains more than one measurement, you must select 
which measurement to plot from the list displayed. Once you have chosen 
the measurement parameter, press [F3] (View). The screen now appears 
similar to Figure 100 above. (Press [F2], Cancel, to leave the window 
without viewing the graph.)

• If you wish to alter the graph scale, press [F1] (Scale) and go to page 151. 

• If you wish to alter the time scale, press [F2] (Time) and go to page 152. 

• To leave the window, press [F3] (Exit).

AAA.LOG (Velocity, ft/s)

297

Time                      Exit

2001/03/01 2001/03/01 
13:23:41 PM 13:53:41 PM

289

Scale
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7.5.2 Displaying Log Data in Graphical Form (cont.)

Figure 101: Y-Axis Window

The Y-Axis window (shown in Figure 101 above) allows you to specify 
whether the Y axis on the graph extends to the maximum value (Max), over 
the entire range (Range) or between certain specified values (Set).

1. Use the [ ] and [ ] keys to scroll to the desired limit type. Press 
[ENTER] to confirm the entry.

If you select Max or Range for limits, you have finished entering data in this 
form. If you select Set, the PT878 asks for minimum and maximum limits.

2. Press the [ ] key to reach the Minimum text box.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

3. Repeat step 2 to enter the Maximum value.

4. When you have finished, press [F2] (Cancel) to cancel the entries, or [F3] 
(OK) to confirm the entries and change the graph.

AAA.LOG (Dew Point, °C) 
-52.0

2003/03/01 2003/03/01 
13:23:41 PM 13:53:41 PM

Y-Axis

Limits

Max Range Set

Minimum

Maximum

Cancel OK

-52

-52
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7.5.2 Displaying Log Data in Graphical Form (cont.)

If you wish to alter the time scale, press [F2] (Time). The Enter Time 
window appears similar to Figure 102 below.

Figure 102: Enter Time Window

1. Use the arrow keys to scroll to the desired text box. Press [ENTER] to 
open the box.

2. Two alternatives are available to change a highlighted date or time:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit increments, to the 
desired number. (For example, if the text box displays 09, pressing 
the [ ] key twice changes the number to 07.) You can scroll from 01 
to 12 for the month, from 01 to 31 for the day (depending on the 
number you have selected for the month), and from 0 to 59 for 
minutes and seconds.

In either case, press [ENTER] to confirm the entry.

3. Repeat step 2 for any other entries you wish to change.

When you have finished, press [F3] (OK) to confirm the entries and close 
the window, or press [F2] (Cancel) to leave the window without changing 
the entries.

AAA.LOG (Velocity, ft/s) 
-52.0 Enter Time

Start Date

End Date

Start Time

End Time
2003/03/01

2003/03/01 13:53:41 PM

13:23:41 PM
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7.5.3 Displaying Log Data in Spreadsheet Form

To view a log in spreadsheet form, be sure the log is highlighted in the left 
window of the Log Manager. Then scroll to the View menu and press 
[ENTER]. Scroll to the Spreadsheet option and press [ENTER]. The screen 
now appears similar to Figure 103 below.

Figure 103: Log Spreadsheet Window

Use the [ ] and [ ] keys to scroll to other columns, or the [ ] or [ ] 
keys to scroll backward or forward in time.

• To alter the times displayed, press [F1] (Time). The Enter Time window 
(shown on page 152) opens. Follow the instructions on page 152 to 
change the date or time.

• To refresh the display, press [F2] (Refresh). The display shows the most 
current data.

• Press [F3] (Exit) to return to the Log Manager.

Refresh Exit

123.LOG

Time
03/20/2001
14:24:46
14:24:56
14:25:06
14:25:17

14:25:27
14:25:37

14:25:47

Diagnostics
    P# Up
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449

Time
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7.6 The Sort Menu

The Sort Menu within the Log Manager allows you to arrange your log list 
either alphabetically (By Name) or chronologically (By Date).

Figure 104: Sort Menu in the Log Manager

7.6.1 Listing Logs by Name

If you want to list your logs alphabetically by log name within the Log 
Manager, press [MENU] to open the File Menu. Then scroll from the File 
Menu to the Sort Menu, shown in Figure 104 above. Press [ENTER]. The 
Log Manager screen refreshes, with the sites listed in alphabetical order.

7.6.2 Listing Logs in Chronological Order

If you prefer to list your logs chronologically by time of creation within the 
Log Manager, press [MENU] to open the File Menu. Then scroll from the 
File Menu to the Sort Menu, and scroll to the By Date option. Press 
[ENTER]. The Log Manager screen refreshes, with the sites listed in chrono-
logical order, from the most recent to the earliest.

Log Manager

Info: AAA.LOG

03/01/01 13:23:21
1216 bytes
109568 bytes free

   Refresh Exit
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State: Finished
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E:03/01/01 13:23:41
Interval: 10 Seconds
Records:51

File    Log     View   Sort

By Date
By Nameb
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Chapter 8. Servicing the PT878

For user convenience, the PT878 offers a Service Menu. This menu enables 
users to perform a variety of functions that they might occasionally require: 

• print out reports

• set up and view the thickness gauge measurements

• calibrate the PT878

• run diagnostics

• set up signal parameters and peak detection

• define error limits

• test the PT878 screen and keys

• diagnose setup problems with the impulse response

• check test points

• return to factory default parameters

• load updated versions of the meter program into the PT878.
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8.1 Entering the Service Menu

To enter the Service Menu, press the [MENU] key at the lower right of the 
PT878 keypad. The Menu Bar replaces the Status Bar at the top of the 
screen. Press the [ ] arrow key four times to scroll from the Site Menu to 
the Service Menu. At the Service Menu, press [ENTER]. The screen appears 
similar to Figure 105 below. When programming, refer to Figure 142 on 
page 225 of Appendix A, Menu Maps.

Figure 105: Service Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys until you 
reach the option. Then press [ENTER] to open the option window.

When entering parameters in an option, press:

• The [ ] key to step through the available parameters. 
• The [ ] key to scroll back to a previously entered parameter.
• The [F2] key (Cancel) or the [ESC] key to exit an option at any time and 

return to Operate Mode without changing the parameters.

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Site   Program   Meter Logging   Service

Units

Reports
T-Gauge DisplayTest T-Gauge Setup
Calibrate
Diagnostics
Signal Setup
Error Limits
Test                   
Factory Defaults
Flash Update
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8.2 Printing Reports

When used with an IR-compatible printer, the PT878 can print out a variety 
of data (current site, logs, drive contents, and user functions, tables, and 
settings) in the Reports option. To enter the Reports option, scroll to the 
Reports entry on the Service Menu and press [ENTER]. The screen appears 
similar to Figure 106 below. 

Figure 106: Reports Window

Press [ENTER] to open the drop-down list of available reports, as shown in 
Figure 106 above. Press the [ ]or [ ] arrow keys to scroll to the desired 
reports, and press [ENTER]. Then press [F2] (Print) to print out the desired 
reports, or press [F3] (Exit) to leave the option and return to Operate Mode. 
Figure 107 on page 158 shows a typical printout of a drive report.

         Reports

 Print Exit

Reports

Global Settings

Menu Commands

Drive Contents

All Reports

All User Settings

Current Site

User Functions
User Tables
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8.2  Printing Reports (cont.)

Figure 107: Printout of a Typical Drive Report
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8.3 Setting up the Thickness Gauge

For greatest accuracy in flow applications, the PT878 can measure pipe wall 
thickness using an optional thickness gauge transducer, instead of relying 
on the nominal pipe wall thickness. In Thickness Gauge mode, the PT878 
does not measure flow, but it can determine the thickness of most standard 
metal and plastic pipe materials over a range from 0.05 to 3 in. (1.3 to 76.2 
mm). 

The PT878 offers two basic thickness gauge functions: using the gauge to 
measure thickness after entering the pipe material, and calibrating the 
gauge. For the highest possible accuracy, you can also calibrate the velocity 
of the pipe material.

Using the thickness gauge involves three steps:

1. Enter the material and soundspeed (refer to Figure 108 on page 160).

2. Measure the pipe wall thickness (in the Display window on page 162).

3. If the measurement seems unreasonable, examine the acoustic signal to 
diagnose the problem (in the Graph window on page 163).

Calibrating the thickness gauge involves up to two additional steps:

4. Calibrate the thickness gauge itself (in the Zero window on page 165).

5. Calibrate the velocity of the pipe material (in the Velocity window on 
page 168), if possible and if the pipe material is not the material entered 
in the Zero window. This step requires a trustworthy reference, either a 
section of pipe (such as a flange or open pipe section) that can be 
measured with calipers or another measurement device, or a thickness 
calibration block from the same pipe material.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 159



Chapter 8. Servicing the PT878
8.4 Measuring Pipe Wall Thickness

8.4.1 Entering the Material and Soundspeed

IMPORTANT: The factory recommends calibrating the thickness gauge 
periodically (as discussed on page 165) before measuring 
thickness.

To enter the Thickness Gauge Display option, scroll to the T-Gauge Display 
entry on the Service Menu and press [ENTER]. The screen appears similar 
to Figure 108 below. 

Figure 108: Material Window 

1. From the Thickness Gauge Display option, press the [ ] arrow key 
four times to enter the Material window.

2. The first prompt asks you to select the material for the pipe wall you 
wish to measure from a drop-down list.

a. Press [ENTER] to open the list.

b. Use the [ ] or [ ] arrow keys to scroll to the desired material.

c. Press [ENTER] to confirm your selection.

Thickness Gauge Measure

Cancel OK

MaterialDisplay Graph Velocity Zero

Sound Speed m/sec0

Material Other
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8.4.1 Entering the Material and Soundspeed (cont.)

If you have selected a preprogrammed material, you have completed 
entering data in this window. Pressing the [ ] key returns the program to 
the Material tab. But if you selected “Other,” you can also enter a specific 
soundspeed.

3. To enter the soundspeed:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired soundspeed (from the 
brochure Soundspeeds and Pipe Size Data, 914-004).

c. Press [ENTER] to confirm your entry.

To leave the Material window:

• Press the [ ] or [ ] arrow key to move to another tab to take 
readings or perform a velocity calibration.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
soundspeed value.

• Press [F3] (OK) to confirm the new value. The PT878 returns to 
Operate Mode.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 161



Chapter 8. Servicing the PT878
8.4.2 Measuring Thickness in Numeric Format

To measure the actual thickness of a pipe, hold the calibrated transducer 
steady, press the [ ] or [ ] arrow key until you reach the Display tab and 
press [ENTER]. The T-Gauge Display option shows the thickness 
measurement in numeric format (displayed in Figure 109 below).

Note: Refer to Appendix D, Ultrasonic Thickness Gauge Theory of 
Operation, page 251, to learn how to position and align the 
transducer.

Figure 109: Thickness Gauge Display Window

Be sure the “Noise” or “Los” (loss of signal) boxes do not appear. Press [F2] 
(Cancel) or [F3] (OK) to return to Operate Mode, or press the [ ] arrow key 
to move to another window in the option.

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero

Thickness, mm

42.71

Material
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8.4.3 Displaying the Receive Signal in Graphical Format

Used chiefly for diagnostic purposes, the Graph option helps to determine 
why the thickness gauge is not working if you suspect a problem. The graph 
shows an image of the acoustic signal. If the display does not show a signal 
image similar to Figure 110 below, you may have a problem with the 
transducer, couplant, or the programmed values. Also, some materials (such 
as PTFE or fiberglass) do not support acoustic signals.

To open the Graph window and display the receive signal graphically, press 
the [ ] or [ ] arrow key until you reach the Graph tab and press [ENTER]. 
The screen appears similar to Figure 110 below.

Figure 110: Thickness Gauge Graph Window

Press [F2] (Cancel) or [F3] (OK) to return to Operate Mode, or press the [ ] 
arrow key to move to another window in the option. However, if you wish 
to adjust the graph, press the [ ] key. The screen now appears similar to 
Figure 111 on page 164.
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Cancel OK
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8.4.3 Displaying the Receive Signal in Graphical Format (cont.)

Figure 111: Graph Window in Zoom Format

• Press [F1] (In) to zoom in to magnify screen details.

• Press [F2] (Out) to zoom out fully.

• Press [F3] to toggle between the left and right cursors.

• Press [ ] and [ ] to move the selected cursor left and right.

• Press [ ] to select the graph.

• Press [ ] to return to tab navigation.

• Press [ESC] to return to Operate Mode without saving the calibration 
changes.

Display

Thickness Gauge Measure

Out Display

VelocityGraph Zero

Signal

In

Material
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8.4.4 Calibrating the Thickness Gauge Transducer

To zero the transducer offsets, go to the Zero tab. Press the [ ] or [ ] 
arrow key until you reach the Zero tab and press [ENTER]. The screen 
appears similar to Figure 112 below.

Figure 112: Zero Window 

Dual-Point Calibration

Note: The factory recommends dual calibration. Dual-point calibration is 
more reliable, but it requires two known thickness levels of the 
calibration material. Use single-point calibration only if you know 
the velocity of the calibration block material to a high degree of 
accuracy. For single-point calibration, complete the following 
procedure, but skip steps 6, 7 and 8. See Appendix D for more 
information.

Display

Thickness Gauge Measure

Cancel OK

Graph Velocity Zero Material

Block 1 Length

Calculated Current
Transducer Delay, 

0          0

Single Dual Calibration
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µs
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Dual-Point Calibration (cont.)

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks you to choose between single and dual-point 
calibration. Use the [ ] and [ ] arrow keys to move to the Dual radio 
button and press [ENTER]. 

3. The next prompt asks you to enter the length of Block 1. (If you are 
using a GE-supplied test block, the length is printed on the block.)

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the length.

c. Press [ENTER] to confirm the entry.

4. Press [ ] to move to the Calibrate button, and press [ENTER] to 
prepare for calibration. Then apply couplant B to the Block 1 surface, 
and hold the transducer against the block. 

5. When you have the transducer firmly pressed against the block and the 
Ready button appears, press [ENTER] again to perform the calibration.

Note: For single-point calibration, skip to step 9.

6. The next prompt asks you to enter the length of Block 2.

a. Use the arrow keys to move to the Block 2 text box.

b. Press [ENTER] to open the text box.

c. Use the numeric keys to enter the length.

d. Press [ENTER] to confirm the entry.

7. Press [ ] to move to the Calibrate button, and press [ENTER] to 
prepare for calibration. Then apply couplant B to the block surface, and 
hold the transducer against the block. 

8. When you have the transducer firmly pressed against the block, press 
[ENTER] (Ready button) again to perform the calibration.

9. Hold the transducer steady until the Set button appears. Press [ENTER] 
to store the calibration. 
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Dual-Point Calibration (cont.)

IMPORTANT: Be sure to hold the transducer steady until the GE wait 
cursor disappears.

10. Use the [ ] key to return to the Zero tab, and then scroll to the Display 
tab (page 162) to confirm the block length within ±0.002. If the 
measurement is not within this limit, recalibrate the transducer offsets.

Once you have completed calibration, the transducer should remain 
calibrated until the meter memory is cleared or a dramatic shift in ambient 
conditions occurs.

To leave the Zero window:

• Press the [ ] or [ ] arrow key to move to another tab to take 
readings or perform a velocity calibration.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
soundspeed value.

• Press [F3] (OK) to confirm the new value. The PT878 returns to 
Operate Mode.
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8.4.5 Calculating Velocity (Pipe Material Soundspeed)

The nominal soundspeed for your pipe material will give thickness 
measurements of reasonable accuracy. However, for greater accuracy, 
calibrate pipe material sound velocity.

IMPORTANT: This step is necessary only if the actual pipe material 
soundspeed differs from the soundspeed of the material 
used in the calibration block. It is possible only if you have 
a sample of pipe material with thickness known to a high 
level of precision. 

To open the Velocity window, press the [ ] or [ ] arrow key until you 
reach the Velocity tab and press [ENTER]. The screen appears similar to 
Figure 113 below.

Figure 113: Soundspeed Window

1. Scroll to the Velocity tab as shown in Figure 113 above. Press [ENTER].

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero Material

Block Length 0

Calculated Current

Determine the Sound Speed
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8.4.5 Calculating Velocity (Pipe Material Soundspeed) (cont.)

2. To enter the block length (here, the thickness of the sample as measured 
with a caliper or calibrated sample), press the [ ] arrow key and then 
press [ENTER] to open the Block Length text box. Use the numeric keys 
to enter the desired block length. Press [ENTER] to confirm the entry.

3. Prepare the sample for calibration by applying couplant B to its surface, 
and press [ENTER]. The screen now appears similar to Figure 114 
below.

4. Hold the transducer steady against the sample, and wait for the Set 
button to appear.

5. To calibrate the gauge, press the [ ] arrow key to move to the Set 
button.

6. Press [ENTER] (Set button) to start the calibration sequence. 

Figure 114: Velocity Window - Calculated and Current Values
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Cancel OK

VelocityGraph Zero Material

Block Length

Calculated Current

1

Press Set to Commit Value

Set

22129. 74733.
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8.4.5 Calculating Velocity (Pipe Material Soundspeed) (cont.)

7. The “Calculated” box shows the thickness value measured. The PT878 
asks for confirmation of the calculated and current values. Press 
[ENTER] to commit the calculated value, or to recalculate the value.

Note: If you commit the calculated value, the settings in the Material 
window also change from the previous material to “Other” with the 
new soundspeed.

To leave the Velocity window:

• Press the [ ] or [ ] arrow key to move to another tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
soundspeed value.

• Press [F3] (OK) to confirm the new value and return to Operate 
Mode.

8.5 Programming the Thickness Gauge

While the T-Gauge Display option allows you to program the appropriate 
material and soundspeed, the Thickness Gauge Setup option enables you to 
view or change five parameters:

• Low Signal Threshold

• Transducer Delay

• Signal Inversion

• Noise Threshold

• Detection Threshold

Note: The thickness gauge programming settings are entered at the factory. 
You should not change them unless instructed by the factory.

The Programming window appears similar to Figure 115 on page 171.
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8.5  Programming the Thickness Gauge (cont.)

Figure 115: Thickness Gauge Programming Window

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks for the low signal threshold. If the signal strength 
falls below this value, a “Low Signal” message appears on the screen. 
To change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

3. The next value, transducer delay, represents the time the ultrasonic 
signal takes to travel from the meter to the pipe material surface. To 
change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

Thickness Gauge Setup

Cancel OK

Low Signal Thresh 0 %

Transducer Delay 0

Signal Inversion

Noise Threshold

On Off

0

Detection Threshold

%

0 %

µs

Programming
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8.5  Programming the Thickness Gauge (cont.)

4. The signal inversion prompt enables you to invert the thickness 
transducer signal. Signal inversion may be necessary if your thickness 
readings show unusual jitter, or for certain unusual combinations of 
pipe and fluid or pipe and lining. Consult the factory before measuring 
the thickness of lined pipes.

Note: When measuring the thickness of certain pipe materials, you might 
need to drain the pipe before measuring the pipe wall, because 
certain pipe/liquid combinations muffle the ultrasonic echo.

Signal inversion should be on, unless you have received other instructions. 
To change its status, use the [ ] and [ ] arrow keys to move to the 
appropriate radio button and press [ENTER].

5. To enter the noise threshold:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

6. The final value, the detection threshold, represents the percent of peak 
the PT878 uses to make measurements. It will consider anything above 
the entered percentage as part of the signal. To change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

You have finished entering values for the Programming window. To leave 
this window:

• Press the [ ] arrow key to move to the Materials tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes. The PT878 returns to Operate Mode.

• Press [F3] (OK) to confirm the new data and return to Operate Mode. The 
PT878 returns to Operate Mode.
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8.6 Displaying Diagnostic Parameters

The Diagnostics option enables you to view current diagnostic parameters 
without having to open a display window in Operate Mode. To enter the 
option, scroll to the Diagnostics entry on the Service Menu and press 
[ENTER]. The screen appears similar to Figure 116 below.

Figure 116: Diagnostics Window

Press [F2] (Cancel) or [F3] (OK) to close the window and return to Operate 
Mode.

Note: For an explanation of diagnostic parameters, refer to Chapter 9, 
Diagnostics and Troubleshooting.
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8.7 Calibrating the Analog Output and Inputs

The Calibration option allows you to calibrate the analog output and inputs. 
To enter the option, scroll to the Calibrate entry on the Service Menu and 
press [ENTER]. The screen appears similar to Figure 117 below. 

Figure 117: Outputs Window in the Calibration Option

8.7.1 Calibrating the Analog Output

The calibration procedure consists of calibrating the analog output zero 
point (0 or 4 mA) and then calibrating the full scale point (20 mA). You 
enter, first the setpoint, and then the actual value derived from an ammeter 
or digital voltmeter. The analog outputs have a resolution of ±5.0 µA. Press 
the [ ] arrow key to enter the Analog Output window.

 Analog Output

Calibrate/Test I/O

Analog Input

   Setpoint

Cancel  OK

mA
4

Calibrate

    Actual 4

4 mA 20 mA

Actual 20 mA

Reset

20
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8.7.1 Calibrating the Analog Output (cont.)

1. Connect the digital multimeter to the analog output.

2. The next prompt asks for the setpoint (4 or 20 mA). Use the [ ] and 
[ ] arrow keys to move to the appropriate radio button and press 
[ENTER].

3. The next prompt asks you to enter the actual value shown on the 
multimeter or ammeter.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

4. Repeat steps 2 and 3 for the other setpoint.

5. Press the [ ] arrow key to move to the Calibrate box, and then press 
[ENTER] to calibrate the output.

If you are unsatisfied with the calibration, you can reset the inputs to factory 
defaults. Press the [ ] arrow key to move to the Reset box, and then press 
[ENTER] to undo the calibration.

You have completed calibrating the outputs. To leave the Output window,

• Press the [ ] key to return to the Output tab, and the [ ] arrow key to 
move to the Input tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes. 

• Press [F3] (OK) to confirm the new data. The PT878 returns to Operate 
Mode.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 175



Chapter 8. Servicing the PT878
8.7.2 Calibrating Inputs

To open the Inputs window, press the [ ] arrow key and press [ENTER]. 
The screen appears similar to Figure 118 below.

Note: Calibrating the analog inputs requires use of a current source.
 

Figure 118: Inputs Window in the Calibrate Option

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks you to select the input.

a. Press [ENTER] to open the drop-down list.

b. Use [ ]or [ ] arrow key to scroll to the desired output (A or B).

c. Press [ENTER] to confirm your selection.

3. The next prompt asks for the value to which you want to set the low 
input (0 or 4 mA).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry. 

Analog Output

Calibrate/Test I/O

Analog Input

Input# A

Low 

Cancel  OK

 4 mA

mA20

Calibrate

High

Read

Read

Reset
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8.7.2 Calibrating Inputs (cont.)

4. Press the [ ] arrow key to move to the Read box, and then press 
[ENTER] to read the low input.

5. The next prompt asks for the value to which you want to set the high 
input (20 mA).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry. 

6. Press the [ ] arrow key to move to the Read box, and then press 
[ENTER] to read the high input.

7. Press the [ ] key to move to the Calibrate box, and press [ENTER] to 
calibrate the inputs.

8. At this point, you have two options:

a. If you are unsatisfied with the calibration, you can reset the inputs to 
factory defaults. Press the [ ] arrow key to move to the Reset box, 
and then press [ENTER] to undo the calibration.

b. If you are satisfied with the calibration, press the [ ] key to return 
to the Input# prompt, and repeat steps 2 through 8 for the other 
input.

You have completed calibrating the inputs. To leave the Inputs window,

• Press the [ ] key to return to the Inputs tab, and the [ ] arrow key 
to move to the Outputs tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes.

• Press [F3] (OK) to confirm the new data. The PT878 returns to 
Operate Mode.
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8.8 Setting up Signal Parameters

The Signal Setup option enables you to set parameters that affect the 
transducer signal:

• Delta-T Offset

• Transmit Sample Size

• Zero Cutoff

• Velocity Averaging 

• Errors Allowed

• Peak Detection Method

• Peak Thresholds

• Transmit Code

To enter the option, scroll to the Signal Setup entry on the Service Menu 
and press [ENTER]. The screen appears similar to Figure 119 below.

Figure 119: Signal Parameter Window 

Peak DetectSignal Para

Signal Setup

Cancel OK

Delta-T Offset

Errors Allowed

Velocity Averaging

Transmit Sample Size

Zero Cutoff 0 m/s

10

8

Pulse/Code

5 ns

8
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8.8.1 Setting up Signal Parameters

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks for the Delta-T offset. Delta-T is the difference 
between the upstream and downstream transit time of the transducers. 
The Delta-T offset should normally be set to zero.

Note: Consult the factory before performing this step.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry. 

3. The next prompt, the transmitter sample size, is the number of pulses 
each transmitter (upstream and downstream) emits. It is set to 8 by 
default.

Note: Consult the factory before performing this step.

a. Press [ENTER] to open the drop-down list.

b. Use the [ ] or [ ] arrow keys to scroll to the desired number.

c. Press [ENTER] to confirm your selection.

4. The next prompt asks for the zero cutoff. Near “zero” flow, the PT878 
may have fluctuating readings due to small offsets (caused by factors 
such as thermal drift in the fluid). The zero cutoff causes velocity 
measurements less than the cutoff to be reported as zero. To set the 
cutoff:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.
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8.8.1 Setting up Signal Parameters (cont.)

5. The next prompt asks for velocity averaging. 

a. Press [ENTER] to open the drop-down list.

b. Use the [ ] or [ ] arrow keys to scroll to the desired number of 
velocity measurements to average together to smooth out noise in 
the system.

c. Press [ENTER] to confirm your selection.

6. The final prompt, errors allowed, specifies the number of errors the 
meter can record before displaying an error message.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

You have finished entering data in the Signal Parameter window. To leave 
this window,

• Press the [ ] key to return to the Signal Parameter tab, and the [ ] 
arrow key to move to the Peak Detection tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes.

• Press [F3] (OK) to confirm the new data. The PT878 returns to 
Operate Mode.
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8.8.2 Setting up Peak Detection

The PT878 can use two different methods to identify the peak of the 
received signal. In the “Peak” method, the peak is identified by testing a 
derivative of the signal. In the “Threshold” method, the peak is identified as 
the point where the signal crosses a threshold that is a percentage of the 
maximum signal detected. The peak method is more reliable in identifying 
the signal in dynamic conditions, while the threshold method is more 
reliable in marginal signal conditions.

Note: Do not change the peak detection method or values unless 
recommended by the factory.

From the Signal Parameter tab, press the [ ] arrow key to move to the Peak 
Detection tab. The window appears similar to Figure 120 below.

Figure 120: Peak Detection Window - Signal Setup Option

Signal Setup

Cancel OK

Signal Para Peak Detect Pulse/Code

Max Threshold

     Min Threshold 25

75

Peak Detect Method

%

%
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8.8.2 Setting up Peak Detection (cont.)

1. The first prompt asks for the peak detection method. Use the [ ] and 
[ ] arrow keys to move to the appropriate radio button and press 
[ENTER].

If you have selected the peak detection method, you have completed 
entering data in this window. But if you have selected the threshold method, 
you must also enter the minimum and maximum threshold percentage 
(available from 0 to 100) used to measure transit time.

2. To enter the minimum threshold:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired percentage.

c. Press [ENTER] to confirm your entry.

3. Repeat step 2 to enter the maximum threshold.

4. The final prompt asks for the percent of peak.

a. Press [ENTER] to open the text box.

b. Use the numeric keys (and the - key for negative numbers) to enter 
the desired percentage.

c. Press [ENTER] to confirm your entry.

You have completed entering data for Peak Detection. To leave this 
window,

• Press the [ ] key to return to the Peak Detection tab, and the [ ] arrow 
key to move to the Signal Parameter tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes.

• Press [F3] (OK) to confirm the new data and return to Operate Mode.
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8.8.3 Selecting the Transmit Code

The Pulse/Code tab allows users to select the transmit code used by the 
PT878 to make measurements. The default option, “Auto,” directs the meter 
to select the optimal code, based on the pipe size. From the Signal 
Parameter tab, press the [ ] arrow key twice to move to the Pulse/Code tab, 
as shown in Figure 121 below.

Figure 121: Pulse/Code Window - Signal Setup Option

1. Press the [ ] arrow key to reach the Transmit Code prompt, and press 
[ENTER] to open the drop-down menu.

2. Use the [ ] or [ ] arrow keys to scroll to the desired number of pulses 
(1, 2, 4, 11) or to Auto for automatic code selection.

You have completed entering the Transmit Code. To leave this window,

• Press the [ ] key to return to the Pulse/Code tab, and the [ ] arrow key 
to move to the Signal Parameter tab.

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
changes.

• Press [F3] (OK) to confirm the new data and return to Operate Mode.

Signal Setup

Cancel OK

Signal Para Peak Detect Pulse/Code

Transmit Code Auto
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8.9 Setting Error Limits

The Error Limits option enables you to set limits for an incoming signal. 
When the signal falls outside the programmed limits, an error indication 
appears. To enter this option, scroll to the Error Limits entry on the Service 
Menu and press [ENTER]. The screen appears similar to Figure 122 below.

Figure 122: Signal Error Limits Option

1. The first prompt asks for the minimum and maximum limits for the 
transducer signal received by the PT878. The default values are 40 for 
minimum and 85 for maximum. The E1: LOW SIGNAL error message 
appears if the signal strength falls below the limit programmed here.

     To enter the minimum signal

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

Programming

Signal Error Limits

Cancel OK

Signal

Sound Speed (±)

        Amplitude

Velocity -12 m/s

Min Max
40 85

12

10 34

%20

Acceleration m/s15
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8.9  Setting Error Limits (cont.)

d. Press the [ ] arrow key to move to the maximum signal box, and 
repeat steps a, b and c.

e. Press the [ ] arrow key to return to the minimum signal box, and 
the [ ] key to move to the next limit.

2. The next prompt calls for the low and high velocity limits. The E3: 
VELOCITY RANGE error message appears if the velocity falls outside 
these limits. Repeat Step 1 on page 184 to enter the desired limits.

3. The third prompt calls for the low and high limits for the amplitude 
discriminator. The discriminator measures the size of the transducer 
signal sent from the PT878. If the signal falls outside these limits, the 
E5: AMPLITUDE ERROR message appears. Repeat Step 1 on 
page 184 to enter the desired limits. 

4. The fourth prompt asks for the acceptable limits for the soundspeed, 
based on conditions in your particular system. The E2: SOUNDSPEED 
ERROR message appears if the fluid soundspeed exceeds that entered 
in the Pipe option of the Program menu by more than this percentage. 
The default value is 20% of the nominal soundspeed.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired percentage.

c. Press [ENTER] to confirm your entry.

5. The final prompt asks for the acceleration limit for detecting cycle 
skipping. The E6: ACCELERATION ERROR message appears if the 
velocity changes by more than this limit from one reading to the next.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired speed.

c. Press [ENTER] to confirm your entry.
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8.9.0 Setting Error Limits (cont.)

Note: In the velocity and acceleration boxes, if the PT878 currently 
displays metric measurements, the F1 softkey displays the word 
“English.” If it displays English measurements, the F1 softkey 
displays “Metric.” Press [F1] to display the measurement in the 
alternate format.

You have completed entering signal error limits. 

• Press [F2] (Cancel) to return to Operate Mode without confirming the 
error limits, or

• Press [F3] (OK) to confirm the new limits and return to Operate Mode.
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8.10 The Test Option

Within the Service Menu, the Test option includes seven tests to ensure that 
the PT878 is performing properly: Test Screen, Test Keys, Watchdog Test, 
Impulse Response, Wave Snapshot, Simulate and Battery Test.To enter this 
option, scroll to the Test entry on the Service Menu and press [ENTER]. The 
screen appears similar to Figure 123 below.

Figure 123: Test Option in the Service Menu

Scroll to the desired entry in the option menu and press [ENTER].
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Factory Defaults
Flash Update

Test                        
Test Screen
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8.10.1 Testing the Screen

To test the proper functioning of the PT878 screen, scroll to the Test Screen 
option in the Test Menu and press [ENTER]. The screen then shows the 
message, “Press Any Key To Continue.” Once you press a key, a screen 
with a checkerboard pattern appears, as shown in Figure 124 below.

Figure 124: Functioning Test Screen

Pressing a key two more times should result in two more checkerboard 
patterns, followed by a series of dark and light screens. Pressing the key 
through this sequence should return the PT878 to Operate Mode. If the test 
does not proceed according to this sequence, please consult the factory.
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8.10.2 Testing the Keys

The Test Keys option checks the functioning of the various keys on the 
keypad. To start the test, scroll to the Test Keys option on the Test Menu and 
press [ENTER]. The screen appears similar to Figure 125 below. Press any 
key on the keypad, and a window representing that key should darken.

Figure 125: Test Keys Window

Pressing the [F3] key returns the meter to the Operate Mode. If any key does 
not appear on the screen, contact the factory.

Note: The power key does not appear.
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8.10.3 Testing the Watchdog Timer Circuit

The PT878 includes a watchdog timer circuit. If a software error causes the 
meter to stop responding, this circuit automatically resets the meter. A 
properly functioning PT878 restarts if you run the Watchdog Test.

To start the Watchdog Test, scroll to the Watchdog Test option in the Test 
Menu and press [ENTER]. The screen appears similar to Figure 126 below.

Figure 126: Watchdog Test Screen

Press [F2] (No) to cancel the test and return to the Menu screen, or press [F3] 
(Yes) to start the test. The PT878 should go blank for a few seconds, and 
then restart. If it does not follow this sequence, consult the factory.
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** WARNING **
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8.10.4 Setting Impulse Response

The Impulse Response option enables you to force the meter to transmit in 
one direction only, without changing the AGC setting. You can then 
diagnose problems with transducer, pipe, or fluid configurations. To enter 
the option, scroll down to the Impulse Response entry in the Service Menu 
and press [ENTER]. The screen appears similar to Figure 127 below.

Figure 127: Impulse Response Option

1. The first prompt asks in which direction you wish the meter to transmit, 
upstream or downstream.

a. Press [ENTER] to open the drop-down list.

b. Use the [ ] or [ ] arrow keys to scroll to the desired number.

c. Press [ENTER] to confirm your selection.

Transmit    Stop Exit

Impulse Response

 

 
 

. 

Direction Upstream

Percent Gain             20 %

Stopped.
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8.10.4 Setting Impulse Response (cont.)

2. The second prompt asks for the percent of gain.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired percentage.

c. Press [ENTER] to confirm your entry.

You have completed entering data for the Impulse Response option.

• Press [F1] to start transmitting in the chosen direction.

• Press [F2] to stop transmitting.

• Press [F3] to leave the option and return to Operate Mode.

8.10.5 Taking Wave Samples for Diagnosis

The Wave Snapshot option allows you to capture receive signals to a file 
that you can send to a PC for diagnostic purposes. To use this option, scroll 
down to the Wave Snapshot entry in the Service Menu and press [ENTER]. 
The PT878 then captures three pairs of upstream and downstream raw 
signals to a file named Wave01.met. (If you repeat the captures, the 
successive files will be named Wave02.met, Wave03.met, etc.) You can 
then transfer the files over the IR port to a PC for analysis by a service 
engineer. 

Note: Refer to page 104 for information on transferring a file to a PC.

8.10.6 Applying a Stored Signal for Diagnosis

The Simulate option places the PT878 in a mode in which it uses a stored 
signal (instead of the live signal from the transducers) to make flow 
calculations for diagnostic purposes. On the PC, you must rename a 
Wavexx.met file as Wave.met and send it back to the PT878 over the IR 
link. Then, on the PT878, scroll down to the Simulate entry in the Service 
Menu and press [ENTER]. The PT878 then applies the simulated signal.

Note: Refer to page 105 for information on transferring a file from a PC to 
the PT878.
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8.10.7 Testing the Battery

The Battery Test option provides additional battery information for service 
troubleshooting. To enter the option, scroll down to the Battery Test entry in 
the Service Menu and press [ENTER]. The screen appears similar to 
Figure 128 below.

Figure 128: Battery Test Option

The screen displays current status (Fast Charge, On Charge, Discharging, or 
On Battery), the time remaining for the PT878 to run on the battery, the time 
for the Fast Charge, and the current condition of the backup battery.

1. If you wish to open the Part Number window, press [ENTER]. You can 
choose from a 1.8 Ahr NiCd battery (part number 200-058) or a 3.0 Ahr 
NiMH battery (part number 200-081). Scroll to the battery type you 
have installed and press [ENTER].

2. To condition the batteries, press the [ENTER] key. The “Condition 
Battery” window should now read “Stop.” The status line should 
change to “Discharging.” (Updating the status could take up to 30 sec.)

3. To stop the discharge cycle, press the [ENTER] key and the “Condition 
Battery” window reappears. The status now changes to “On Charger.”

4. Press [F3] (OK) to return to Operate Mode.

Service Battery Form

Cancel OK

Status: Fast Charge

Batt Voltage     5.78 Volts
Fast Charge     3 Min

Condition Battery

Run Time          250 Minutes 

Backup Battery: OK Batt temp 27.7 °C

       Part Number: 1.8Ahr NiCd (200-058)
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8.11 Resetting to Factory Default Parameters

For various reasons, you might wish to return the PT878 to its original 
settings. The Factory Defaults option enables you to return the meter to its 
preprogrammed default settings. To enter the option, scroll down to the 
Factory Defaults entry in the Service Menu and press [ENTER]. The screen 
will appear similar to Figure 129 below.

Note: All sites and logs will be lost if you use the Factory Defaults option. 
Be sure to transfer or print all sites and logs before resetting!

Figure 129: Factory Defaults Option

1.  To restore Factory Default settings:

• Press [F2] (Cancel) to return to Operate Mode without changing the 
current settings.

• Press [F3] (OK) to confirm that you wish to restore the factory default 
settings.

2. The program asks for confirmation: “Are you SURE?” Repeat the 
procedure shown in Step 1 above.

The PT878 replaces the default site file and the global meter settings with 
the factory default settings, and returns to Operate Mode.

Factory Defaults

Cancel OK

*** WARNING ***
You will LOSE all changes by
pressing OK.

Choose CANCEL to exit or OK to
proceed.
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8.12 Updating PT878 Software

By using a Windows-based PC with an infrared adapter, PT878 users can 
update the meter’s operating software without the need to change the 
hardware. This software can include the bootloader, FPGA software (timing 
software for transit-time), instrument software, the meter string file and the 
Help string file. The updating procedure involves three steps:

1. Setting up the PT878 in Flash Update mode.

2. Selecting the loading interface.

3. Loading the new software from the PC into the PT878.

CAUTION! To guard against mishap, you should print out, download 
or otherwise record all logs, settings and other data you 
wish to save. 

IMPORTANT: When uploading new software, the PT878 uses a 
“bootloader” program. Be sure that the software you are 
installing is compatible with the installed bootloader 
version, shown in the “About” option discussed on 
page 110. If you need to replace both programs, install the 
new bootloader first, before any other software.

With the current bootloader software (version 3.0 and later), two interfaces 
are available for sending software to the PT878:

• IrOBEX, a recently introduced Microsoft infrared standard which allows 
more straightforward use and faster file transfers, while tolerating IR 
interruptions better.

• IrCOMM, an infrared standard supported by certain Microsoft operating 
systems.

GE recommends updating software via the IrOBEX standard; however, the 
IrCOMM standard is available for users who have problems with IrOBEX. 
This section covers procedures for both standards.
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8.12.1 Updating Software Via IrOBEX

To begin updating software via IrOBEX, scroll down to the Flash Update 
entry in the Service Menu and press [ENTER]. The screen appears similar to 
Figure 130 below.

Figure 130: Flash Update Window

• Press [F2] (Cancel) to return to Operate Mode without erasing the 
program.

• Press [F3] (OK) to confirm that you wish to erase the program.

4. The meter asks for confirmation. Repeat the options shown in Step 1 
above. After the PT878 reboots, the screen appears similar to 
Figure 131 below.

Figure 131: Flash Reloading Window

 Update Flash

OK

--WARNING--
This will erase the
instrumentation coding.

Choose ‘Cancel’ to exit or ‘OK’
to continue.

Cancel

Panametrics PCI Loader v3.0 2/26/02
[HW Rev3+]

Reload Flash via Infrared (Yes/No)?

Backup Battery: OK
Firmware CRC: Valid

IrOBEX          No           IrCOMM
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8.12.1 Updating Software Via IrOBEX (cont.)

5. The meter now asks if you wish to reload the flash memory via the 
infrared communications port. 

• Press [F1] (Yes) to begin reloading via OBEX, or

• Press [F2] (No) to stop the reloading procedure.

Be sure the infrared sensor on the meter has a clear path to the infrared 
adapter on the PC. Now return to the PC.

6.  You now have two options:

• In Windows Explorer, browse to the file you wish to send. Select and 
right-click on it. Select Send To  Infrared Recipient or Nearby 
Computer (or QuickBeam if QuickBeam has been installed).

• Open the Infrared Transfer Application (My Computer\Infrared 
Recipient), click on Send Files, and select the files you wish to send.

In either case, a window displays the status of the file upload.

8.12.2 Updating Software Via IrCOMM

Note: While Windows 95/98/98SE and NT (with QuickBeam) support 
IrCOMM, Windows 2000 and XP do not. Refer to Appendix F.

Before you install new coding, you must be sure that the PC has the correct 
protocols to transmit the software to the meter.
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8.12.2a Setting up the PC

Note: The use of Hyperterminal is shown here as an example. If you are 
using a different communications software, see its manual for 
detailed instructions.

1. From the Start Menu, click Programs/Accessories/Hyperterminal to 
open the Hyperterminal window.

2. If the call is not connected, click on Connect from the Call menu in 
Hyperterminal.

3. From the File menu, click Properties. Be sure the New Connection 
Properties window is set to your virtual infrared port.

Note: You can determine which virtual port your infrared is using by 
opening Infrared Monitor in the Control Panel and clicking on the 
Options tab.It displays the message, “Providing Application Support 
on:” and lists the virtual infrared port, as shown in Figure 132 
below.

Figure 132: Port Settings for COMM 4
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8.12.2b Installing New Software

To begin the loading procedure, scroll down to the Flash Update entry in the 
Service Menu and press [ENTER]. The screen appears similar to Figure 133 
below.

Figure 133: Flash Update Option

1. As shown in Figure 133 above, the Flash Update option erases all 
instrument coding. 

• Press [F2] (Cancel) to return to Operate Mode without erasing the 
program.

• Press [F3] (OK) to confirm that you wish to erase the program.

 Update Flash

OK

--WARNING--
This will erase the
instrumentation coding.

Choose ‘Cancel’ to exit or ‘OK’
to continue.

Cancel
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8.12.2b Installing New Software (cont.)

2. The meter asks for confirmation. Repeat the options shown in Step 1 
above. The screen on both the PC and the PT878 now appears similar to 
Figure 134 below.

Figure 134: Flash Reloading Window

3. The meter now asks if you wish to reload the flash memory via the 
infrared communications port. 

• Press [F3] (Yes) (or C on the PC keyboard) to begin reloading via 
IrCOMM, or

• Press [F2] (No) (or ESC on the keyboard) to stop the reloading 
procedure.

4. Be sure the infrared sensor on the meter has a clear path to the infrared 
adapter on the PC, and return to the PC Hyperterminal program.

GE Sensing PCI Loader 
[HW Rev3+]

Reload Flash via Infrared (Yes/No)?

Backup Battery: OK
Firmware CRC: Valid

IrOBEX          No           IrCOMM

v3.0 2/26/03
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8.12.2b Installing New Software (cont.)

5. In the Hyperterminal window, pull down the Transfer menu and click 
Send File. A window opens similar to Figure 135 below.

Figure 135: The Send File Window in the Transfer Menu

6. Click on the replacement software (designated by a .cod extension) 
from the folder where it has been stored.

7. From the Protocol drop-down menu, select Xmodem.

8. Click Send. For a successful transfer, the PC window appears similar to 
Figure 136 on page 201, while the PT878 screen displays the program 
ID, size, load address and a count of blocks being loaded.

Figure 136: The File Transmission Window
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Chapter 9. Diagnostics and Troubleshooting

The TransPort is a reliable instrument that is easy to maintain. It will 
provide accurate flow measurement readings as long as it is operated as 
described in this manual. If problems do arise with the electronics, 
transducers or the flowcell, the TransPort displays an error message 
specifying the possible problem. The TransPort also has a set of diagnostic 
parameters to help you find and remedy the problem.

In general, troubleshooting may be necessary if the TransPort displays an 
error message, the flow readings are erratic, or you have other reasons to 
doubt the accuracy of readings (for example, readings do not agree with 
other flow measuring devices connected to the same process).

This section describes error messages, diagnostic parameters, and shows 
you how to isolate problems to one of the following areas:

• Electronics, including programmed values

• Flowcell, which includes the pipe and fluid

• Transducers and cables.
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9.1 Error Code Messages

Error Code messages appear on the screen while you are displaying 
measurements. When logs appear in graph form, errors are indicated by a 
vertical gray bar at the point of error. When they appear in a spreadsheet 
format, errors are indicated by their number, in place of the measurement. 
The Error Code messages are only general descriptions of the possible 
problems. Use Table 7 below to isolate and remedy the problem. If you are 
unable to remedy the problem, contact the factory.

Note: We suggest that, in order to isolate the indicated problem more 
easily, you obtain a test flowcell. Contact the factory for details.

Table 7: Error Messages

Error Problem Possible Cause Action

E0  No error. Displays briefly after dis-
play of another error 
message

None required. 
Measurement is valid.

E1 Low Signal - Poor 
ultrasonic signal 
strength.

Broken cable.
Flowcell problem. 
Transducer problem. 
Electronic failure.

Check transducer cable. See 
Flowcell Problems on page 208 
and Transducer Problems on 
page 210. Check programming 
and transducer spacing. 
Contact the factory if problem 
persists.

E2 Soundspeed Error 
(Soundspeed is 
programmed using 
the Program Menu 
Pipe option, as 
described in 
Chapter 5.)

Poor flow conditions. 
Incorrect programming. 
Bad transducer spacing. 
Measurement is very 
different from the 
programmed 
soundspeed. 

Check soundspeed against 
nominal soundspeed. 
See Flowcell Problems on 
page 208 and Transducer 
Problems on page 210. 
Check programming and 
transducer spacing.
204 Transport® Model PT878 Portable Liquid Flowmeter User’s Manual



Chapter 9. Diagnostics and Troubleshooting
E3 Velocity Range - 
Velocity exceeds 
programmed  limits 
(Velocity limit is 
programmed using 
the Service Menu 
Error Limits option 
as described in 
Chapter 8.) 

Programming error, poor 
flow conditions, or bad 
transducer spacing.

Make sure flow rate is within 
±12m/s (±40 ft/s). Check 
programming and transducer 
spacing. If programmed value 
is outside of limit, change the 
limits as described in Chapter 8 
on page 184. See Flowcell Prob-
lems on page 208 and Trans-
ducer Problems on page 210.

E4 Signal Quality If too high - electronic 
failure. 
If too low - flowcell, 
electrical problem.

Check for source of electrical 
interference. Check electronics 
with a test flowcell. If unit still 
fails to operate, contact the 
factory

E5 Amplitude Error Excessive particles or 
bubbles present in fluid. 
A lot of second phase 
present

See Flowcell Problems on 
page 208.

E6 Cycle skip, 
Acceleration

Poor flow conditions or 
bad transducer spacing.

Check transducer spacing as 
programmed and as set on 
pipe. See Flowcell Problems on 
page 208 and Transducer 
Problems on page 210.

E7 Analog Out Error Under current output. Check that output load is within 
specification <550 ohm.

E8 Temperature Input 
Supply

Supply temperature 
input out of range.

Check cable and transmitter.

E9 Temperature Input 
Return

Return temperature 
input out of range.

Check cable and transmitter.

Table 7: Error Messages (cont.)

Error Problem Possible Cause Action
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 205



Chapter 9. Diagnostics and Troubleshooting
9.2 Displaying Diagnostic Parameters

As part of its measurement menu, the PT878 offers a list of diagnostic 
parameters to aid in troubleshooting in the event of flowcell, transducer, or 
electrical problems. You can select any diagnostic parameter for display as a 
measurement as discussed in Chapter 5, Displaying and Configuring Data, 
on page 95. Table 8 below shows all the available diagnostic parameters 
and ranges.

Table 8:  Diagnostic Parameters

Diagnostic
Parameter  Displays Good Bad

DT Displays Delta T, or the difference between 
the upstream and downstream transit 
times.

N/A Continuous 
large fluctu-
ations of 1 

ms or more.

Amplitude 
Up

Displays the value for the amplitude dis-
criminator of the upstream transducer.

20-28 <20 or >28

Amplitude 
Down

Displays the value for the amplitude dis-
criminator of the downstream transducer.

20-28 
fluctuations

< 20 or > 28 
fluctuations

T Up Displays the upstream transit time of the 
ultrasonic signal in micro seconds.

N/A N/A

T Down Displays the downstream transit time of 
the ultrasonic signal in micro seconds.

N/A N/A

Gain/Up Displays upstream gain in dB. N/A N/A

Gain/Dn Displays downstream gain in dB. N/A N/A

Soundspeed
(m/s or f/s)

Displays the measured soundspeed of the 
fluid.

Check the soundspeed of 
fluid in Soundspeeds and 

Pipe Size Data.

P#up Displays signal peaks for the upstream 
transducer.

100-900 <100, >900

P#dn Displays signal peaks for the downstream 
transducer.

100-900  <100, >900

Reynolds # Displays the Reynolds Number. N/A N/A

K(RE) Displays the K Factor, based on the 
Reynolds Number.

N/A N/A

Raw Up Displays raw upstream signal. N/A N/A

Raw Down Displays raw downstream signal. N/A N/A
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Xmit Corr 
Up

Displays raw upstream signal correlated 
with transmit signal.

N/A N/A

Xmit Corr 
Dn

Displays raw downstream signal correlated 
with transmit signal.

N/A N/A

Cross Corr Displays transmit upstream signal corre-
lated with transmit downstream signal.

N/A N/A

SS up Displays the signal strength for the 
upstream transducer.

50-80 <50

SS do Displays the signal strength for the 
downstream transducer.

50-80 <50

PEAK% Displays the Percent of Peak. Set to -40 by 
default. To change see page 182.

N/A N/A

Qup Displays the signal quality for the upstream 
transducer. 

±300 or 
higher

 between 
±100

Qdown Displays the signal quality for the down-
stream transducer.

±300 or 
higher

between 
±100

NFup Displays the normalization factor for the 
upstream transducer.

 0.85 -   1.0 <0.85

NFdn Displays the normalization factor for the 
downstream transducer.

0.85 - 1.0 <0.85

TEMPs Displays the temperature for the supply 
input (energy measurement).

N/A N/A

TEMPr Displays the temperature for the return 
input (energy measurement).

N/A N/A

Ts - Tr Displays the difference between the tem-
perature for supply input and the tempera-
ture for return input (energy measurement).

N/A N/A

DENSs Displays the density for the supply input. 
(Energy measurement.)

N/A N/A

DENSr Displays the density for the return input. 
(Energy measurement.)

N/A N/A

DELTh Displays the delta enthalpy, or difference 
between the supply and return enthalpy 
(enthalpy is a measure of energy contained 
in the fluid.) (Energy measurement.)

N/A N/A

Table 8:  Diagnostic Parameters (cont.)

Diagnostic
Parameter  Displays Good Bad
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9.3 Flowcell Problems

Flowcell problems fall into two categories: fluid problems and pipe 
problems. Read the following sections carefully to determine if such 
problems exist.

9.3.1 Fluid Problems

Most fluid-related problems can be solved by proper design of the 
flowmeter installation and the proper choice of transducer frequency. 
Contact the factory if you cannot solve a fluid-related problem.

Certain fluid properties may prevent proper flow measurement. Some fluid 
properties that cause problems are listed below.

1. THE FLUID MUST BE HOMOGENOUS, SINGLE PHASE, 
RELATIVELY CLEAN, and FLOWING STEADILY. Solid particles 
and gas bubbles absorb and disperse ultrasound. Although, in some 
cases, solids and gases have little effect on the operation of the 
TransPort, excessive amounts will prevent ultrasound transmission 
through the fluid and interfere with proper flow measurement. 
Temperature gradients may also cause a problem.

2. THE FLUID MUST NOT CAVITATE NEAR THE FLOWCELL. 
Fluids with a high vapor pressure may cavitate near or in the flowcell. 
This causes problems resulting from gas bubbles in the fluid. Cavitation 
can usually be controlled through proper installation design.

3. THE FLUID MUST NOT ATTENUATE ULTRASOUND 
EXCESSIVELY. Some fluids, particularly those that are very viscous, 
absorb ultrasound energy. In these cases an “E1” will display on the 
screen to indicate that the ultrasonic signal is not of sufficient strength 
for reliable measurements.

4. THE FLUID SOUNDSPEED MUST NOT VARY EXCESSIVELY. 
The TransPort will tolerate relatively wide, but slow, changes in fluid 
soundspeed due to changes in fluid composition and temperature. 
However, if you are measuring a fluid that is considerably different 
from the fluid programmed into the TransPort, you may have to adjust 
the meter for the new fluid. Refer to Chapter 3, Programming Site Data, 
on page 37.
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9.3.2 Pipe Problems

Improper pipe conditions and/or flowcell installation can cause problems 
with fluid flow measurement. Check the items below if you suspect this 
class of problem. Contact the factory for unsolved pipe-related problems.

1. THE INSIDE OF THE PIPE OR FLOWCELL MUST BE 
RELATIVELY CLEAN. Excessive build up of scale, rust, or debris will 
interfere with flow measurement. Generally, a thin coating or a solid 
well-adhered buildup on the pipe wall will not cause problems. Loose 
scale and thick coatings (such as tar or oil) will interfere with 
ultrasound transmission and may result in incorrect or unreliable 
measurements.

2. THE FLOWCELL ORIENTATION MUST NOT ALLOW 
SEDIMENT OR GAS ENTRAPMENT AT THE TRANSDUCER 
LOCATIONS. Sediment or gas trapped in the transducer ports for 
wetted transducers, or at the transducer locations for clamp-on 
transducers, will interfere with flow measurement. Realignment of the 
flowcell or transducers often cures these problems. In some cases 
different transducers may be used that protrude into the flow stream.

3. THE PIPE OR FLOWCELL DIMENSIONS MUST BE ACCURATE. 
The accuracy of your flow measurements will be no better than the 
accuracy of your programmed pipe or flowcell dimensions. If GE did 
not supply your flow cell, the dimensions you program must be 
consistent with the required flow accuracy. Check your pipe for wall 
thickness, diameter, dents, eccentricity, weld deformity, and 
straightness. 

4. THE PIPE SURFACES SHOULD BE SMOOTH (FOR CLAMP-ON). 
When using clamp-on transducers, both the inside and the outside of the 
pipe at the transducer locations must be smooth. If the pipe is extremely 
rough, the ultrasonic signal will be scattered by the rough surface, and 
will not be received by the flowmeter, preventing flow measurement.

5. THE PIPE MUST ALLOW ULTRASOUND TO PASS THROUGH 
(FOR CLAMP-ON). Some pipe materials or linings such as Fiberglass 
(or generic fiber reinforced pipe), Teflon, and polyethylene, absorb 
ultrasound and may cause problems in clamp-on applications. Pipes 
with extremely thick walls or high OD to ID ratios may also present 
difficulties.
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9.4 Transducer Problems

Ultrasonic transducers are rugged. However, they are subject to physical 
damage due to mishandling and chemical attack. Clamp-on transducers are 
also subject to installation variables such as physical misalignment and 
faulty coupling to the pipe on which they are mounted.

Because transducer problems are largely dependent on the type of 
transducer used, wetted or clamp-on, the following list of potential 
problems is grouped according to transducer type. Contact the factory if you 
cannot solve a transducer-related problem.

9.4.1 Wetted Transducer Problems

1. LEAKS

Leaks may occur around the transducer and in the fittings of the flow cell. 
Repair as you would any other leak. Check the transducer and cables for 
damage if the leaking fluid is corrosive. 

2. CORROSION DAMAGE

Wetted transducers may be damaged by corrosive fluids if the transducer 
material does not match the application. Most often, corrosion damage 
occurs at the electrical connector. To check for damage, remove the 
transducer from the flow cell. If the wetted end of the transducer is rough 
and pitted, the transducer may have to be replaced. GE can supply suitable 
transducer materials for most fluids. Contact the factory for information on 
special transducers.

3. INTERNAL DAMAGE

An ultrasonic transducer consists of a ceramic “crystal” bonded to the 
transducer case. The bond between the crystal and the case may be damaged 
by extreme mechanical shock and by temperature extremes. The crystal 
itself can also be damaged by the same conditions. The internal wiring can 
be corroded or shorted if contaminants enter the transducer housing.
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9.4.1 Wetted Transducer Problems (cont.)

4.  PHYSICAL DAMAGE

Transducers may be physically damaged by dropping them onto a hard 
surface or striking them against another object. Usually the connector on the 
transducer is the part that is damaged, as it is the most fragile. Minor 
damage may be repaired by carefully bending the connector back into 
shape. If the connector cannot be repaired, replace the transducers. Note 
that transducers must be replaced in pairs. Before replacement, make sure 
that the transducer number in the programmed parameters is the one 
engraved on the new transducers (see Chapter 3, Programming Site Data).

9.4.2 Clamp-on Transducer Problems

1. POOR COUPLING TO PIPE

Clamp-on transducers must be in intimate contact with the pipe. The pipe 
wall must be smooth and generally free of paint. The couplant material must 
fill voids between the transducer and the pipe, and must be firmly coupled 
or bonded to both the pipe and the transducer. The pipe and transducer must 
be clean and dry for permanent couplant, such as grease or epoxy, to adhere 
properly. Enough pressure must be applied to the transducer by its clamp to 
hold it firmly against the pipe. 

2. MISALIGNMENT

The transducer transmits relatively narrow beams of ultrasound, and 
therefore transducer alignment is critical to assure that the beam can travel 
from one transducer to the other without undue attenuation. Be sure to 
exactly follow the instructions that came with your transducers and 
clamping fixtures. Also, be sure that the transducer spacing agrees with the 
calculated spacing (S).

3. INTERNAL DAMAGE

Ultrasonic transducers consist of a ceramic “crystal” bonded to the 
transducer case. The bond between the crystal and the case may be damaged 
by extreme shock and by temperature extremes. The crystal itself can also 
be damaged by the same conditions. The internal wiring can be corroded or 
shorted if contaminants enter the transducer housing.
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9.4.2 Clamp-on Transducer Problems (cont.)

4. PHYSICAL DAMAGE
Transducers may be physically damaged by being dropped onto a hard 
surface or being struck against another object. Usually the transducer 
connector is the part that is damaged, as it is the most fragile. Minor damage 
may be repaired by carefully bending the connector back into shape. If the 
connector cannot be repaired, replace the transducers. Note that transducers 
must be replaced in pairs, and that after replacement the flowmeter 
parameters should be checked (see Chapter 3, Programming Site Data).

5. CYCLE SKIP CONDITION
A cycle skip is usually caused by a distorted or altered signal due to poor 
couplant, bad wall, or unusual fluid disturbances. To resolve a cycle skip, 
recouple both transducers with proper couplant. Try standard CPL-1 
couplant that is good to 212°F (100°C) or CPL-2 for up to 500°F (260°C). 
In addition, make sure the pipe wall is free of paint and rust.

Contact the factory if you cannot solve a transducer-related problem.

9.4.3 Relocating Transducers

If the coupling or pipe wall are not the problem, try relocating the 
transducers using the following method. However, before beginning, make 
sure the transducers are not located on or near pipe welds or seams:

Move one transducer about 1/2 inch (12.7 mm) closer to the other 
transducer. If this resolves the problem, you must modify the “S” dimension 
programmed into the PT878 by using the following steps:

1. Press [MENU].

2. Scroll to the Program menu and press [ENTER].

3. Scroll to the Path option and press [ENTER].Then scroll down to the 
Spacing box and press [ENTER].

4. Use the numeric keys to enter the transducer spacing. Subtract 0.5 in. 
(12.7 mm) from the original “S” and enter the new “S” dimension.

5. Press [F3] (OK).
If this method does not resolve the problem, contact the factory.
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This section contains specifications for the following:

• Overall

• Electrical

• Transducer

• Fluid Types

• Pipe Size and Materials

• Available Options

10.1 Overall

10.1.1 Hardware Configuration

Channel Options: Single channel
Mode Options: Transit-time

10.1.2 Size/Weight

Size without boot:  238 × 138 × 38 mm 
                                 (9.4 × 5.5 × 1.5 inches)

Weight with boot:    1.36 kg (3 lb)

10.1.3 Enclosure

Submersible, IP67

10.1.4 Flow Accuracy (Velocity, % of reading):

Clamp-on Transducers: Pipe Diameter > 150 mm (6 in.)
±1% to 2% of reading typical
Pipe Diameter ≤ 150 mm (6 in.)
±2 to 5% of reading typical
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Note: Accuracy depends on pipe size and whether measurement is one-path 
or two-path. Accuracy to ±0.5% of reading may be achievable with 
process calibration.

Range: –12.2 to 12.2 m/s (–40 to 40 ft/s)
Rangeability: 400:1
Repeatability:  ±0.1% to 0.3% of reading
Note: Specifications assume a fully developed flow profile (typically 10 

diameters upstream and 5 diameters downstream of straight pipe 
run) and flow velocity greater than 1 ft/s (0.3 m/s). 

Energy Accuracy The accuracy of the energy measurement is a
(% of reading): combination of the accuracy of the flow and

temperature measurement. Accuracy of 1% is
typical for calibrated systems.

Low Voltage This unit complies with European Standard
Directive EN61010-1 Installation Category II,
Compliance: Pollution Degree 2. 

EMC This unit complies with EN61326:1998
Directive CL.A Annex C. For continuous unmonitored
Compliance operation, follow provisions of the 89/336/EMC 

Compliance.

10.2 Electrical

Internal Batteries

Type: Rechargeable batteries. (Optional NiCad 6R
nonrechargeable alkaline available.)

Battery Life: 9-11 hours of continuous operation is typical 

Battery Charger:

Input: 100-250 VAC, 50/60 Hz, 0.38 A

Memory:                        1 MB datalog/site battery-backed RAM
                                         1 MB program FLASH memory
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Environmental

Operating 
Temperature: –20 to 55°C (–4 to 131° F)
Storage 
Temperature: –40 to 70°C (–40 to 158° F)

Note: To ensure maximum battery life storage, do not exceed 35 °C (95° F) 
for long periods.

Operating Modes

Flow Measurement: Transit-Time™ mode with clamp-on or wetted
transducers

Energy: To calculate energy flow rate, use the external
loop-powered RTD transmitter (Part # 2CHRT)

Input/Output

Keypad: 25-key rubberized tactile membrane keypad

Display: 240 × 200 pixel LCD graphic display
with EL backlight

Printer/Terminal: Infrared communications port

Analog Output: One 4-20 mA or 0-20 mA current output

Digital Output: One user-selectable pulse (solid-state, 5-V max.) or
frequency (5-V square wave, 100 to 10,000 Hz)

Analog Input: Two 4-20 mA analog inputs with switchable 16 V
supply for loop-powered temperature transmitters

Acoustic: One pair of LEMO® coaxial transducer connectors 

Cable and length: Cable length 8 m (25 ft) standard. Up to 305 m
(1000 ft) optional with extension cables.
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10.3 Operational Specifications

Site Parameter Menu-driven operator interface using a keypad and 
Programming: “soft” function keys.         
                                   On-line help functions including pipe tables.

Storage for saving parameters for up to 64 sites.

Data Logging: Memory capacity to log over 100,000 flow data
points. 
Keypad programmable for log units, update times
and start and stop times. 

Display Functions: Graphic displays shows flow in numeric or
graphical format. Also displays logged data.
Supports multiple languages: English, French,
German, Japanese, Spanish, (Castilian and South
American), Italian, Portuguese, Dutch, Russian and
Swedish.

Totalizers: Pulse or frequency totalizer output.
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10.4 Transducer

10.4.1 Clamp-On Ultrasonic Flow Transducers

Temperature Range:

Standard: –40° to 150°C (–40° to 300°F)

Optional (overall): –190° to 300°C (–310° to 572°F)

Housing: 

Standard: None

Optional: List models or consult factory: 

Mounting: SS Chain or strap, welded or magnetic
clamping fixtures

10.4.2 Temperature Transducers

Types: Loop-powered 3-wire platinum RTDs;clamp-on
and wetted (thermowell) types are available.

Accuracy:              0.15°C wetted RTDs (matched pairs)

Range:                 –20 to 260°C (-4 to 500°F)

10.5 Pipe Size and Material

10.5.1 Clamp-On Transducers:   

Materials: All metals, most plastics; consult GE Sensing for
concrete, composite materials and highly corroded 
or lined pipes

Pipe Sizes:         12.7 mm to 7.6 m outside (OD)
                          (0.5 to 300 in.)

Pipe Wall Thickness:       Up to 75 mm (3 in.)
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10.6 Available Options

Thickness Measuring Mode

Standard GE Sensing & Inspection Technologies 
Transducer: dual element transducer

Pipe 
Thickness Range: 1.3 to 76.2 mm (0.05 to 3.0 in.)

Pipe Materials: Most standard metal and plastic pipe materials

Accuracy: ±1% typical or ±0.05 mm (±0.002 in.)

Display Resolution: 0.01 mm (0.001 in.)

Thermal Continuous operation to 37°C (100°F) 
Exposure: Intermittent operation to 260° C (500° F)

for 10 seconds followed by air cooling for 2 minutes.

Energy Equipment

Dual RTD transmitter; two 4 to 20-mA transmitters with input for 3-wire 
RTD (100 Ω Pt) and terminals for 4 to 20-mA output; and 6-ft. cable

PC Option

Infrared adapter plugs into any available serial port to give desktop PCs 
infrared capability

Printer Option

Thermal printer with rechargeable battery and 120 to 240-VAC power 
supply/recharger

PC Interface Software

PanaView™ Instrument Interface Software
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Figure 137: Main Menu

• Site Menu - Figure 138 on page 221.

• Program Menu -

• Pipe Option - Figure 139 on page 222

• Transducer Option - Figure 143 on page 227

• Lining Option - Figure 144 on page 228

• Fluid Option - Figure 145 on page 229

• Path Option - Figure 146 on page 230

• Energy Option - Figure 147 on page 231

• Analog Input Option - Figure 148 on page 232

• Analog Output Option - Figure 149 on page 233

• Digital Output Option - Figure 150 on page 234

• User Functions Option - Figure 151 on page 235

• Correction Factors Option - Figure 152 on page 236

• Meter Menu - 

• Meter Menu - Figure 140 on page 223 

• Communications Option - Figure 153 on page 237.

• Logging Menu - Figure 141 on page 224.

• Service Menu - Figure 142 on page 225

Menu

Site Program Meter Logging Service
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Figure 138:  Site Menu
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Figure 139:  Program Menu with Pipe Option
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Figure 140:  Meter Menu
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Figure 141:  Logging Menu
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Figure 142:  Service Menu
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Figure 143: Transducer Option
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Figure 144: Lining Option
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Figure 145: Fluid Option
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Figure 146: Path Option
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Figure 147: Energy Option
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Figure 148: Analog Input Option
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Figure 149: Analog Output Option
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Figure 150: Digital Output Option
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Figure 151: User Functions Option

Program

User Functions

Menu

Function

User1 User2 User3 User4 User5 User6 User7 User8

Label
Units Symbol

Decimal Places

0 1 2 3 4

Equation

Note: Press [F2] (Cancel) to cancel the entries and return to Menu.
         Press [F3] (OK) to confirm the entries and return to Menu.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 235



Appendix A. Menu Maps
Figure 152: Correction Factors Option
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Figure 153: Communications Option
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Appendix B. Measuring P and L Dimensions

If you are using wetted transducers, the PT878 requires you to enter the path 
length (P) and the axial dimension (L). P is the transducer face-to-face 
distance, and L is the axial projection of P in the flow stream. 

To determine L, physically measure the distance between the center of the 
transducer ports at the inside wall as shown in Figure 154 below, if possible. 
If not, consult the factory.

Figure 154: Top View of 180° Transducer Installation
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L
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To determine P, you need the following:

• the pipe inside diameter (ID)

• the wall thickness (WT)

• the installed pipe coupling length (CL)

• the transducers face depth (FD)

• the mounting angle (MA)

Use Figure 155 below to properly measure the coupling length. Typically, 
the transducer face is positioned just outside the inside diameter (ID) of the 
pipe, or slightly retracted inside the coupling.

Figure 155: Determining the Pipe Coupling Length

FD

MA 45°

CL
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Use the following formula to determine the P dimension:

[ID + 2(WT)]/(cos MA) = 2 (CL- FD) = P dimension

For example, given the following:

• inside diameter (ID) = 48”

• wall thickness (WT) = 3/8”

• installed coupling length (CL) = 2.0”

• a transducer face depth (FD) = 1.75”

• mounting angle (MA) = 45°

The P dimension would be:

[48 + 2(3/8)]/(0.7071) + 2(2.0-1.75) = 69.4”
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Appendix C. Temperature Transmitter Installation

The PT878 requires a supply and return temperature input to measure 
energy rate and consumption. You must connect the temperature sensors to 
a 4 to 20 mA transmitter (powered by the PT878 or externally) and then 
from the transmitter to the PT878 (a special GE cable is required to make 
transmitter-to-PT878 connections).

The factory can supply the Resistive Temperature Device (RTD) and a Dual 
Transmitter (DTR) or you may supply your own. If you supply your own 
equipment, you will need to order a special GE cable with a LEMO 
connector to make connections from the transmitter to the PT878.

To install the RTDs, you need to do the following:

• find a suitable installation site

• mount RTDs on the pipe

• make electrical connections

Use the instructions that follow to install the RTDs.

C.1 Guidelines for RTD Installation

You should have discussed possible installation sites with an applications 
engineer or field sales person by the time you receive the RTDs. However, 
you should follow these guidelines to ensure accurate temperature 
measurement:

• Do not install the RTD on a pipe seam.

• Clean the pipe at the installation location.

• Do not install the RTD on the top or the bottom of the pipe.

• Apply thermal couplant to the RTD before mounting it to the pipe.

• Insulate the pipe and RTD after installation.

If you have a GE RTD, use the instructions in the next section to properly 
mount the RTD on the pipe.
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C.2 Mounting RTDs on the Pipe

The factory supplies a clamping fixture to mount the RTDs to the pipe; 
however, you must assemble the clamping fixture before you can mount the 
RTDs to the pipe. Use the following instructions below to mount the RTDs.

C.2.1 Assembling the Clamping Fixture

The clamping fixture consists of the following parts:

• one strap (length depends on the pipe size)
• a screw buckle
• a feeder buckle

To assemble the clamping fixture:

1. Cut the strap equal to the circumference of the pipe.

2. Fold 1/2 inch of one end of the strap into a hook shape.

3. Secure the screw buckle to one end of the strap by placing the strap 
through the buckle and folding the strap.

4. Crimp the strap closed to secure the screw buckle in place.

5. Each RTD has a securing post (located on the rounded portion of the 
RTD) that secures the RTD in place when it is mounted on the pipe. 
Place the RTD on the strap by sliding the strap under the securing post.

IMPORTANT: Make sure you place the RTD on the strap so   when the strap 
is wrapped around the pipe, the flat surface of the RTD sits 
against the pipe.

6. Secure the feeder buckle to the other end of the strap by placing the 
strap through the buckle and folding the strap (the folded section should 
be approximately 1/2 inch). 

7. Crimp the strap closed to secure the feeder buckle in place.

Repeat steps 1 through 7 for the remaining RTD and clamping fixture. 
When you have completed assembly, proceed to the next section to fasten 
the RTD to the pipe.
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C.2.2 Mounting the RTD to the Pipe

Use the steps below to fasten the RTD to the pipe:

1. Prepare the pipe where you intend to place the RTD. The area should be 
clean and free of loose material.

2. Apply couplant (GE part number 401-001) to the copper face of the 
RTD. Use enough couplant to cover the face of the RTD, but not so 
much that the couplant oozes out from underneath.

3. Position the RTD on the pipe and wrap the clamping fixture around the 
pipe.

4. To secure the RTD, you place the feeder buckle into the screw buckle 
and use a screwdriver to tighten. Turn the screw clockwise until the 
strap is set securely against the RTD.

Proceed to the following section to make electrical connections.

C.3 Making Electrical Connections

The PT878 will not accept a signal directly from the RTD; therefore, you 
must have some type of 4 to 20-mA transmitter. The factory supplies a dual 
transmitter (DTR) with a special LEMO connector that attaches to the 
PT878. The PT878 supplies power to the DTR using an internal 16 V 
supply. If you decide to supply your own transmitter, you can use the 16 V 
supply to power your transmitter; however, you will need to order the 
special LEMO connector cable to connect your transmitter to the PT878.

To make electrical connections, you must connect the RTD sensor to the 4 
to 20-mA transmitter, and then connect the DTR to the PT878. Use the 
following sections to make electrical connections.
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C.3.1 Connecting the RTD to the 4 to 20-mA Transmitter

RTDs should have two common leads and one signal lead. If you are using a 
GE RTD, the wire colors may vary; however, two of the RTD wires will be 
the same color. The wires that are the same color are the common leads and 
the remaining wire is the signal lead.

If you are using your own transmitter, make the necessary connections. If 
you are using the GE DTR, connect the RTD wires to the terminal block 
labeled RTD Inputs. Connect the common and signal wires to the 
appropriate pins as designated on the terminal block label.

IMPORTANT: The supply and return RTD cables must be the same length 
in order to make accurate temperature measurements. 

When you have completed supply and return connections, proceed to the 
next section.
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C.3.2 Connecting the Transmitter to the PT878

If you are using the GE DTR, simply plug the LEMO connector into the I/O 
connector as shown in Figure 156 below.

Figure 156: Connection Locations

Note: For input/output cable connections see Table 1 on page 8.

If you are using your own transmitter, you must connect the special GE 
cable to your transmitter as shown in Table 9 below.

Once you complete making the above connection, plug the LEMO 
connector into the I/O connector as shown in Figure 156 above. You have 
completed RTD installation.

Table 9: Cable Connections from GE Cable to Customer-Supplied Transmitter

Pin Number
GE Cable 

Wire Color
GE Cable  Description

2 Red 16 V (unpowered transmitters only)
3 White Supply Temperature
4 Yellow Return Temperature
5 Green Ground (for both supply and return)

Power

Infrared Transceiver

DownstreamUpstream
Transducer

Input/Output
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Appendix D. Ultrasonic Thickness Gauge Theory of 
Operation

All ultrasonic thickness gauging involves timing the round trip of a sound 
pulse in a test material. Because solid metal has an acoustic impedance that 
differs from that of gasses, liquids, or corrosion products such as scale or 
rust, the sound pulse will reflect from the far surface of the remaining metal. 
The test instrument is programmed with the velocity of sound in the test 
material, and computes the wall thickness from the simple formula 

Distance = Velocity × Time

Single element transducers use one element as both transmitter and receiver. 
Dual element transducers incorporate separate transmitting and receiving 
elements. These elements are mounted on delay lines that are usually cut at 
an angle to the horizontal plane (the roof angle), so that the transmitting and 
receiving beam paths cross beneath the surface of the test piece. This 
crossed-beam design of duals provides a pseudo-focussing effect that 
optimizes measurement of minimum wall thickness in corrosion 
applications. Duals will be more sensitive than single element transducers 
to echoes from the base of pits that represent minimum remaining wall 
thickness. Also, duals may often be used more effectively on rough outside 
surfaces. Couplant trapped in pockets on rough sound entry surfaces can 
produce long, ringing interface echoes that interfere with the near surface 
resolution of single element transducers. With a dual, the receiver element 
is unlikely to pick up this false echo. Finally, duals may be designed for 
high temperature measurements that would damage single element contact 
transducers.
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D.1 Factors Affecting Performance and Accuracy

A. Surface Condition - Loose or flaking scale, rust, corrosion or dirt on the 
outside surface of a test piece will interfere with the coupling of sound 
energy from the transducer into the test material. Thus, any loose debris of 
this sort should be cleaned from the specimen with a wire brush or file 
before measurements are attempted. Generally it is possible to make 
corrosion measurements through thin layers of rust, as long as the rust is 
smooth and well bonded to the metal below. Some very rough cast or 
corroded surfaces may have to be filed or sanded smooth in order to insure 
proper sound coupling. It may also be necessary to remove paint if it has 
been applied in thick coats, or if it is flaking off the metal. While it is often 
possible to make corrosion measurements through thin coats of paint (on the 
order of a few thousandths of an inch or 0.1 - 0.2 mm), thick paint will 
attenuate signals or possibly create false echoes, causing inaccurate 
measurements.

Severe pitting on the outside surface of a pipe or tank can be a problem. On 
some rough surfaces, the use of a gel or grease rather than a liquid couplant 
will help transmit sound energy into the test piece. In extreme cases it will 
be necessary to file or grind the surface sufficiently flat to permit contact 
with the face of the transducer. In applications where deep pitting occurs on 
the outside of a pipe or tank it is usually necessary to measure remaining 
metal thickness from the base of the pits to the inside wall. There are 
sophisticated ultrasonic techniques utilizing focussed immersion 
transducers that can measure directly from the base of the pit to the inside 
wall, but this is generally not practical for field work. The conventional 
technique is to measure unpitted metal thickness ultrasonically, measure pit 
depth mechanically, and subtract the pit depth from the measured wall 
thickness. Alternately, one can file or grind the surface down to the base of 
the pits and measure normally.

As with any difficult application, experimentation with actual product 
samples is the best way to determine the limits of a particular 
gauge/transducer combination on a given surface.
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D.1.1 Transducer Positioning/Alignment

For proper sound coupling the transducer must be pressed firmly against the 
test surface. On small diameter cylindrical surfaces such as pipes, hold the 
transducer so that the sound barrier material visible on the probe face is 
aligned perpendicular to the center axis of the pipe. See Figure 157 below.

Figure 157: Proper Alignment of Transducers for Cylindrical Surfaces

While firm hand pressure on the transducer is necessary for good readings, 
the probe should never be scraped along or twisted against a rough metal 
surface. This will scratch the face of the transducer and eventually degrade 
performance. The safest technique for moving a transducer along a rough 
surface is to pick it up (not slide it) and reposition it for each measurement.

Remember that an ultrasonic test measures thickness at only one point 
within the beam of the transducer. In corrosion situations, wall thicknesses 
often vary considerably. Test procedures usually call for making a number 
of measurements within a defined area and establishing a minimum and/or 
average thickness. Ideally, data should be taken at increments no greater 
than half the diameter of the transducer, to insure that no pits or other local 
variations in wall thickness are missed. It is up to the user to define a pattern 
of data collection appropriate to the needs of a given application. 

It is possible that on some severely corroded or pitted materials there will be 
spots where readings cannot be obtained. This can happen when the inside 
surface of the material is so irregular that the sound energy is scattered 
rather than being reflected back to the transducer. The lack of a reading may 
also indicate a thickness outside the range of the transducer and instrument 
being used. Generally, an inability to obtain a valid thickness reading at a 
particular point on a test specimen could be a sign of a seriously degraded 
wall which may warrant investigation by other means.

Transducer
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 251



Appendix D. Ultrasonic Thickness Gauge Theory of Operation
D.1.2 Calibration
The accuracy of measurements are only as good as the accuracy and care 
with which the gauge has been calibrated. It is essential that the thickness 
gauge be calibrated (as shown on page 159) whenever the transducer is 
changed or you have a reason to doubt the accuracy of the readings. 
Periodic checks with samples of known thicknesses are recommended to 
verify that the gauge is operating properly.

D.1.3 Taper or Eccentricity

If the contact surface and the back surface are tapered or eccentric with 
respect to each other, the return echo again becomes distorted and the 
accuracy of measurement is diminished.

D.1.4 Acoustic Properties of the Material

There are several conditions found in engineering materials that can 
severely limit the accuracy and thickness range that can be measured.

D.1.4a Sound Scattering
In some materials, notably certain types of cast stainless steel, cast irons, 
and composites, the sound energy is scattered from individual crystallites in 
the casting or from dissimilar materials within the composite. This effect 
reduces the ability to discriminate a valid return echo from the back side of 
the material and limits the ability to gauge the material ultrasonically.

D.1.4b Velocity Variations
A number of materials exhibit significant variations in sound velocity from 
point-to-point within the material. Certain types of cast stainless steels and 
brass exhibit this effect due to a relatively large grain size and the 
anisotropy of sound velocity with respect to grain orientation. Other 
materials show a rapid change in sound velocity with temperature. This is 
characteristic of plastic materials where temperature must be controlled in 
order to obtain maximum precision in the measurement.

D.1.4c Sound Attenuation or Absorption
In many organic materials, such as low density plastics and rubber, sound is 
attenuated very rapidly at the frequencies used in normal ultrasonic 
thickness gaging. Therefore, the maximum thickness that can be measured 
in these materials is often limited by sound attenuation.
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Appendix E. Material Safety Data Sheet for Couplant

(To comply with 29 CFR 1910.1200) Effective Date 4/1/98

Note: N/A = not applicable or not available

E.1 Product Identification

Product Name: SOUNDSAFE®
Generic Name: Ultrasonic Couplant
Manufacturer: Sonotech, Inc.   
                          774 Marine Dr., Bellingham, WA 98225 
                          360-671-9121 
                      FAX: 360-671-9024    
                          E-mail: sonotech@nas.com 
                       http://www.sonotech-inc.com

NFPA Hazardous Materials Identification System (est)

Health.............................. 0
Flammability....................0
Reactivity...........................0

E.2 Hazardous Ingredients

This material does not contain any ingredients having known health hazards 
in concentrations greater than 1%.

This material does not contain any known or suspected carcinogens.
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E.3 Physical Data (nominal)

Boiling Point: >220°F
Freezing Point: <20°F
Vapor Pressure: N/A
Evaporation Rate: N/A
Solubility in Water: complete
Appearance and Odor: water white, opaque gel; bland odor
pH: 7.35 - 7.9
Acoustic Imp.: 1.726 X 106

Vapor Density: N/A
Specific Gravity: 1.05

E.4 Fire and Explosion Hazard Data

Flash Point: none
Upper Exposure Limit: none
Lower Exposure Limit: none
Special Fire Fighting Procedures: N/A
Extinguishing media: N/A
Unusual Fire and Explosion Hazards: none

E.5 Reactivity Data

Stability: stable
Conditions to Avoid: none
Incompatibility (Materials to Avoid): none known
Hazardous Polymerization: will not occur
Hazardous decomposition or Byproducts: none known
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E.6 Health Hazard and First Aid Data

Routes of Entry: 1
Skin: not likely
Eyes: not normally
Ingestion: not normally
Inhalation: no

1SOUNDSAFE® contains only food grade and cosmetic grade ingredients.

Effects of Overexposure:
Acute: May cause temporary eye irritation.
Chronic: None expected.

First Aid Procedures: 
Skin: Remove with water if desired.
Eyes: Flush with water for 15 minutes.
Ingestion: For large quantities, induce vomiting and call a physician.
Inhalation: N/A

E.7 Storage and Handling Information

Precaution to be taken in handling and storage: 
Store between 20°F and 120°F. Spills are slippery and should be cleaned up 
immediately. 

Steps to be taken in case material is released or spilled: Pick up excess for 
disposal. Clean with water.

Waste disposal method: Dispose of in accordance with federal, state, and 
local regulations.
Transport® Model PT878 Portable Liquid Flowmeter User’s Manual 255



Appendix E. Material Safety Data Sheet for Couplant
E.8 Control Measures

Respiratory Protection: not required
Ventilation: not required
Protective Gloves: on individuals demonstrating sensitivity to 
SOUNDSAFE®
Eye Protection: as required by working conditions
Other Protective Equipment: not required
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Appendix F. Establishing IR Communications

As discussed in Chapter 2, the PT878 includes an infrared transceiver for 
communication with IR products that comply with the IrDA protocol. 
However, you must also be sure that the operating system of your personal 
computer offers IrDA compatibility and either a built-in IR port (available 
on most laptops) or an IR dongle (IR to RS232 adapter for PCs without a 
built-in IR port). Be sure to position the interface in a way that permits 
transmission between the interface and the infrared sensor on the PT878, 
shown in Figure 2 on page 6.

Note: The dongle connection is RS232. The configuration options are either 
RS232 or IRDa. Selecting the RS232 does not link the meter to the 
dongle. IrDa must be selected for the link to work.

Table 10 below lists IrDA compatibility for various past and current 
Microsoft Windows operating systems. IrCOMM is an infrared standard 
supported by Microsoft, while OBEX is a newer infrared standard which 
allows more straightforward use and faster file transfers, while tolerating IR 
interruptions better.

Table 10: IrDA Compatibility of Windows Operating Systems
Operating System IrCOMM OBEX

Windows XP No Yes
Windows 2000 No Yes

Windows NT 4.0 QuickBeam* QuickBeam*
Windows Me* Yes Yes

Windows 98 SE* Yes Yes
Windows 98* Yes Yes
Windows 95* Yes Yes
Windows 3.1 No No

DOS 6.22 No No
*May require QuickBeam installation under some circumstances when 
Windows built-in support fails. QuickBeam is a recommended infrared 
file software transfer utility from Extended Systems, Inc. Since Windows 
NT4.0 does not provide built-in support for IR file transfer, QuickBeam is 
necessary with this operating system.
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Windows 2000/XP

Both Windows 2000 and XP include infrared drivers in their operating 
systems. From the Control Panel, click on Add New Hardware and select 
the appropriate IR port, whether built-in or using an external dongle.

Windows NT4.0

For IR use, Windows NT4.0 requires installation of QuickBeam software 
from Extended Systems (www.extendedsystems.com). Desktop PCs and 
laptops without built-in IR ports also require adding an IR dongle. While 
laptops with a built-in IR port normally do not require a dongle, its addition 
might be necessary in some cases.

Windows Me/98SE/98/95

The Windows 98SE and Me operating systems include IR drivers. 
However, in most cases, the IR port has not been installed or configured. 
From the Control Panel, click on Add New Hardware and select Choose 
Device From List. Select Infrared from the list and then select the 
appropriate infrared port, whether built-in or external.

Note: In some instances, the infrared port must be enabled in the BIOS of 
your PC. Consult your computer documentation, manufacturer or 
MIS department. Assistance is also available from the Microsoft 
Support Knowledge Base at http://support.microsoft.com.
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AGC — Automatic gain control, which sets the receive amplifier based on 
measured signal strength. This electronic circuit automatically adjusts the 
gain of the receive amplifier to maintain the correct receive signal 
amplitude.

Calibration Factor — Correction factor used as a reference for the 
flowmeter electronics to ensure accurate readings, and available either as a 
single number or as a table.

Delta-T Offset — A programmed value of which half is added to the 
upstream transit time and half is subtracted from the downstream transit 
time. It can be used to offset the flow velocity reading, and is normally set 
to zero.

Detection Threshold — Percent of peak the PT878 thickness gauge uses to 
make measurements

Energy Option — Option that enables flow measurement in a heating or 
cooling system. The option calculates the energy of a system based on the 
temperature at a supply point, the temperature at a return point, and the flow 
of fluid through the system. 

Errors Allowed — Parameter that specifies the number of errors the meter 
can record before displaying an error message. The number of errors is N 
out of 16 where N equals the number of errors allowed.

Flowcell — The part of the flowmeter system, consisting of the flowcell 
pipe and the transducers, that uses ultrasonic pulses to interrogate the flow.

Flowcell Pipe — A section of piping that acts as part of the flowcell; it is 
either a section of existing piping with the transducers or inserted as a 
substitute pipe section (spoolpiece).

Form — Software window that opens when a user enters a given menu.
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Impulse Response — Option in the Service Menu that enables you to force 
the meter to transmit in one direction only, without changing the amplifier 
gain setting.

Locale — Format for displaying the time and date.

Peak Detection — A method for identifying the ultrasonic signature in the 
received signal. In the “Peak” method, the peak is identified by testing a 
derivative of the signal. In the “Threshold” method, the peak is identified as 
the point where the signal crosses a threshold that is a percentage of the 
maximum signal detected.

Receive Window — A window of time during which the PT878 tries to 
detect the ultrasonic signal. It is determined by using the fluid soundspeed 
and the signal path length to estimate when the signal will arrive at the 
receiving transducer.

Reynolds Correction — Correction factor based on the Kinematic 
Viscosity and flow rate of the fluid.

Signal Inversion — Option that enables a thickness gauge user to invert the 
transducer signal. 

Signal Path — Path the ultrasonic signal travels from one transducer to the 
other.

Simulate — Option in the Service Menu that allows users to simulate 
measurements based on a waveform stored in the PT878.

Site — A location on a pipe where measurements are made. The site 
includes the transducers, pipe, fluid type, pipe material and other 
parameters.

Site File — Instrument program that combines all the necessary parameters 
(transducer, pipe, fluid, etc.) for a particular measurement location.

Snapshot — Option in the Meter Menu to take screen captures in bitmap 
format of a given screen display.
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Soundspeed — Speed at which a sound wave travels through a given 
material.

Thickness Gauge — Option that allows the PT878, with an optional 
thickness gauge transducer, to determine the thickness of most standard 
metal and plastic pipe materials over a range from 0.05 to 3 in. (1.3 to 76.2 
mm).

Tw (time in wedge) — Time the transducer signal spends travelling 
through the transducer and cable. This time has to be subtracted from the 
transit time to determine how much time the signal spent in the fluid.

Tracking Windows — A feature which allows the receive window to move 
automatically if the ultrasonic signal is lost. The PT878 will set up the 
window in various positions based on a minimum and maximum 
soundspeed range. In seek mode, the meter will test every position until it 
detects a receive signal that passes the error tests. The first window (highest 
soundspeed setting) that passes the tests is the detected window. The meter 
will then track the receive signal.

Transducer Delay — Time the ultrasonic signal takes to travel from the 
meter to the pipe material surface. It is a similar measurement to Tw, except 
that the delay is subtracted from the transit time to find out how much time 
is spent in the wall.

Transducers — Devices that convert electrical energy into ultrasonic 
pulses when in a transmit cycle, and convert the ultrasonic pulses back to 
electrical energy when in a receive cycle. They can be fixed to the outside 
of the flowcell pipe (clamp-on) or inserted into the pipe to directly measure 
the fluid (wetted).

Transmitter Sample Size —Number of pulses the transmitter emits in one 
direction (upstream or downstream) before transmitting in the other 
direction. It is set to 8 by default.
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Transit-Time — Flow measurement technique based on the principle that 
when ultrasonic pulses are transmitted through a moving liquid, the pulses 
that travel in the same direction as the fluid flow (downstream) travel 
slightly faster than the pulses that travel against the flow (upstream). When 
the liquid in the pipe is not flowing, the transit-time downstream equals the 
transit-time upstream. When the liquid is flowing, the transit-time 
downstream is less than the transit-time upstream. The difference between 
the downstream and upstream transit-times is proportional to the velocity of 
the flowing liquid, and its sign indicates the direction of flow.

Traverses — Number of times the ultrasonic signal crosses the pipe.

User Functions — User-defined mathematical equations for use with any 
measurement.

User Tables — User-defined tables of data for use with user functions.

Velocity Averaging — Parameter that averages a desired number of 
velocity measurements to smooth out or dampen noise in the system.

Watchdog Test — Option in the Service Menu that tests the watchdog 
timer circuit. If a software error causes the meter to stop responding, this 
circuit automatically resets the meter

Wave Snapshot — Option in the Service Menu that enables users to 
capture waveforms for downloading to a PC for analysis, or for simulating a 
flow measurement.

Wedge Angle — Angle of the transducer’s ultrasonic transmission in the 
transducer wedge.

Zero Cutoff — Parameter that causes velocity measurements less than the 
absolute value of the cutoff (either positive or negative values) to be 
reported as zero. 
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Warranty
Warranty

Each instrument manufactured by GE Sensing is warranted to be free from 
defects in material and workmanship. Liability under this warranty is 
limited to restoring the instrument to normal operation or replacing the 
instrument, at the sole discretion of GE Sensing. Fuses and batteries are 
specifically excluded from any liability. This warranty is effective from the 
date of delivery to the original purchaser. If GE Sensing determines that the 
equipment was defective, the warranty period is:

• one year from delivery for electronic or mechanical failures

• one year from delivery for sensor shelf life

If GE Sensing determines that the equipment was damaged by misuse, 
improper installation, the use of unauthorized replacement parts, or 
operating conditions outside the guidelines specified by GE Sensing, the 
repairs are not covered under this warranty.

The warranties set forth herein are exclusive and are in lieu of 
all other warranties whether statutory, express or implied 
(including warranties or merchantability and fitness for a 
particular purpose, and warranties arising from course of 

dealing or usage or trade).
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Warranty
Return Policy

If a GE Sensing instrument malfunctions within the warranty period, the 
following procedure must be completed:

1. Notify GE Sensing, giving full details of the problem, and provide the 
model number and serial number of the instrument. If the nature of the 
problem indicates the need for factory service, GE Sensing will issue a 
RETURN AUTHORIZATION NUMBER (RAN), and shipping 
instructions for the return of the instrument to a service center will be 
provided.

2. If GE Sensing instructs you to send your instrument to a service center, 
it must be shipped prepaid to the authorized repair station indicated in 
the shipping instructions.

3. Upon receipt, GE Sensing will evaluate the instrument to determine the 
cause of the malfunction.

Then, one of the following courses of action will then be taken:

• If the damage is covered under the terms of the warranty, the instrument 
will be repaired at no cost to the owner and returned.

• If GE Sensing determines that the damage is not covered under the terms 
of the warranty, or if the warranty has expired, an estimate for the cost of 
the repairs at standard rates will be provided. Upon receipt of the 
owner’s approval to proceed, the instrument will be repaired and 
returned.
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GE Infrastructure
Sensing DECLARATION

OF
CONFORMITY
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

We, Panametrics Limited
       Shannon Industrial Estate

       Shannon, County Clare
      Ireland

declare under our sole responsibility that the

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter
TransPort™ 2PT868 2-Channel Portable Ultrasonic Flowmeter

TransPort™ PT868 Portable Ultrasonic Flowmeter
TransPort™ PT868-L Portable Ultrasonic Flowmeter

TransPort™ PT868-R Portable Ultrasonic Flowmeter with TransFlection™ Mode

to which this declaration relates, are in conformity with the following standards:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

following the provisions of the 89/336/EEC EMC Directive.

The units listed above and any transducers supplied with them (spoolpieces are addressed 
under a separate declaration of conformity) do not bear CE marking for the Pressure 
Equipment Directive, as they are supplied in accordance with Article 3, Section 3 (sound 
engineering practices and codes of good workmanship) of the Pressure Equipment 
Directive 97/23/EC for DN<25.

Shannon - June 1, 2002
Mr. James Gibson

GENERAL MANAGER



GE Infrastructure
Sensing DECLARATION

DE
CONFORMITE
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

Nous, Panametrics Limited
         Shannon Industrial Estate

         Shannon, County Clare
        Ireland

déclarons sous notre propre responsabilité que les

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter
TransPort™ 2PT868 2-Channel Portable Ultrasonic Flowmeter

TransPort™ PT868 Portable Ultrasonic Flowmeter
TransPort™ PT868-L Portable Ultrasonic Flowmeter

TransPort™ PT868-R Portable Ultrasonic Flowmeter with TransFlection™ Mode

rélatif á cette déclaration, sont en conformité avec les documents suivants:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

suivant les régles de la Directive de Compatibilité Electromagnétique 89/336/EEC.

Les matériels listés ci-dessus ainsi que les transducteurs pouvant être livrés avec (les 
manchettes faisant l'objet d'une déclaration de conformité séparée) ne portent pas le 
marquage CE de la directive des équipements sous pression, car ils sont fournis en accord 
avec la directive 97/23/EC des équipements sous pression pour les DN<25, Article 3, section 
3 qui concerne les pratiques et les codes de bonne fabrication pour l'ingénierie du son.

Shannon - June 1, 2002
Mr. James Gibson

DIRECTEUR GÉNÉRAL



GE Infrastructure
Sensing KONFORMITÄTS-

ERKLÄRUNG
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

Wir, Panametrics Limited
        Shannon Industrial Estate

        Shannon, County Clare
       Ireland

erklären, in alleiniger Verantwortung, daß die Produkte

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter
TransPort™ 2PT868 2-Channel Portable Ultrasonic Flowmeter

TransPort™ PT868 Portable Ultrasonic Flowmeter
TransPort™ PT868-L Portable Ultrasonic Flowmeter

TransPort™ PT868-R Portable Ultrasonic Flowmeter with TransFlection™ Mode

folgende Normen erfüllen:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

gemäß den Europäischen Richtlinien, Niederspannungsrichtlinie EMV-Richtlinie
Nr.: 89/336/EG.

Die oben aufgeführten Geräte und zugehörige, mitgelieferte Schallwandler (Messrohre 
werden in einer separaten Konformitätserklärung behandelt) tragen keine
CE-Kennzeichnung gemäß der Druckgeräte-Richtlinie, da sie in Übereinstimmung mit 
Artikel 3, Absatz 3 (gute Ingenieurpraxis) der Druckgeräte-Richtlinie 97/23/EG für DN<25 
geliefert werden.

Shannon - June 1, 2002
Mr. James Gibson

GENERALDIREKTOR





Customer Support Centers

U.S.A.
The Boston Center
1100 Technology Park Drive
Billerica, MA 01821
U.S.A.
Tel: 800 833 9438 (toll-free)

978 437 1000
E-mail: sensing@ge.com

Ireland
Sensing House
Shannon Free Zone East
Shannon, County Clare
Ireland
Tel: +35 361 470291
E-mail: gesensingsnnservices@ge.com
www.gesensinginspection.com
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